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How to Use This Guide

How to Use This Guide

How to Use the Top Page
• Move to top page, chapter contents pages, contents pages, and indexed pages.
• Move to the previous/next page.
• Return to the previous screen.

• Move to each chapter contents
page.

• Move to the page that describes
how to use this guide.

• Move to frequently used topics.

•  Click either button to browse
each item of the solutions manual for the selected op-
erating system.

Windows Macintosh

How to Use the Chapter Contents Pages
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How to Use This Guide

How to Use the Chapter Contents Pages
• Move to top page, chapter contents pages, contents pages, and indexed pages.
• Move to the previous/next page.
• Return to the previous screen.

• Click the contents page to move to
the topic pages.

• Click on the ❒  checkbox, then click
the Start Print button to print the
pages of the selected topics. The
print job starts immediately after
you click the Start Print button.

• Other
Click on blue text to move to the refer-
enced pages. 

Important
• Clicking the Start Print button begins printing on the printer speci-

fied in Set as Default Printer. We recommend that you specify the
printer you want to print on in Set as Default Printer and print on
A4 size plain paper.

How to Use the Top Page
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Printer Part Names

Printer Main Unit
Front View

a Upper cover
Remove this cover to install the printhead, to load media, 
or to remove sheets of paper jammed in the printer.
(→ P.4-11, P.6-35)

b Cutting groove
When you cut the media manually, the cut is done along 
this groove.

c Output assist guides
Guides the media output and keeps if from floating out of 
position. Pull this guide out before printing.

d Maintenance Cartridge
The cartridge that vacuums and collects excess ink. 
When you see the message prompt that tells you to 
replace the maintenance cartridge, replace the cartridge. 
(→ P.4-16)

e Maintenance cartridge cover
Open this cover to replace the maintenance cartridge. 
(→ P.4-16)

f Operation panel
Provides the display panel and the operation panel but-
tons. For more details, please refer to “Using the Opera-
tion Panel Buttons” (→ P.1-12).

g Right cover
Open to replace ink tanks.

h Stand (optional outside the U.S.A.)
This is a table designed specially for this printer. Casters 
are attached to the legs to make it easy to move.

i Output stacker (provided with optional stand)
A cloth tray that catches print media ejected from the 
printer.

j Stopper
The part that locks the casters of the printer stand.

f

g

h

i

j

a

b

c

d

e
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Back View

a Release lever
The lever that releases the media. Push this lever toward 
the back to release pressure when you load media, when 
you need to shift the paper manually, or when you must 
clean inside the printer.

b Lift handles
Grasp the handles provided on the left and right side to 
lift or move the printer.

c Power connector
Provides a connection point for the printer power cord.

d Roll holder slot
This groove guides the roll holder. (→ P.2-26)

e Holder stopper
The part that fastens the roll media to the roll holder. 
(→ P.2-26)

f Roll holder
The holder where the roll media is loaded. (→ P.2-26)

g Accessory pocket
Holds the printer instructions, tools for assembly, and 
extra ink tanks.

Interface connection point on the back

a Expansion board slot
Provided for network interface or IEEE1394 expansion 
board. Remove the two screws and insert the board. 
(→ Quick Start Guide)

b USB port
This is the communication port for USB 2.0 Hi-Speed. 
Connect the USB cable here to connect the printer to the 
computer via USB. (→ Quick Start Guide)

a

b

d
e
f

g

c

a

b
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Inside the Upper Cover

a Carriage rail
The carriage moves on this rail.

b Paper restraint
An important part for paper feed. The plate keeps the 
paper straight in the paper path.

c Platen
The printhead moves across the platen when it prints. A 
suction port is provided on the front surface to prevent 
the media from floating out of position.

d Borderless print ink groove
Receives ink that drains from the edges of the media 
during borderless printing.

e Media guideline
Media is set so it is parallel to this guideline when roll 
media is loaded. (→ P.2-26)

f Upper cover stopper
This arm prevents the upper cover from falling. To close 
the upper cover, just lift and hold the stopper up then 
close the upper cover.

b

a

c

d

f

e
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Carriage (Inside Upper Cover)

a Carriage cover
This cover protects the carriage. Open this cover to 
replace the printhead. (→ P.4-23)

b Printhead lock cover
This cover locks and holds the printhead in place. Raise 
this cover to release the printhead lock. (→ P.4-26)

c Replaceable Printhead
The major component equipped with the print nozzles. 
The printer is shipped without the printhead installed; 
you must install the printhead after unpacking the printer. 
(→ Quick Start Guide)

d Printhead lock lever
This is the lever that locks the printhead lock cover. 
Open this lever to open the printhead cover. (→ P.4-26)

e Cutter Blade
The cutter unit that cuts print media automatically.
(→ P.4-29)

f Printhead height adjustment lever
Use to adjust the height of the printhead. You will need to 
adjust the height of the printhead for high quality printing, 
or depending on the media you use. (→ P.2-40)

g Carriage
The important part that moves the printhead during print-
ing.

f

gb

a

c

e

d
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Inside the Right Front Cover

a Y Ink Tank Cover

b M Ink Tank Cover
c PM Ink Tank Cover
d C Ink Tank Cover
e PC Ink Tank Cover
f Bk/MBk Ink Tank Covers

These covers lock and protect the ink tanks. Open this 
cover to replace an ink tank.

g Y Ink Tank
h M Ink Tank
i PM Ink Tank
j C Ink Tank
k PC Ink Tank
l Bk/MBk Ink Tanks

These are the ink tanks. The ink tanks are not installed in 
the printer when you unpack it; you must install them 
when you set up the printer.

g
h
i
j
k
l

a
b
c
d
e
f
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Switching the Printer On and Off
Follow the procedure below to switch the printer on and off.

Note
Now we will show you examples of how to use the 
printer for normal operations after it has been set up. If 
you are not finished setting up the printer, first follow 
the instructions in the Quick Start Guide to confirm the 
setup and operation of the printer.
If the printer is connected to a Macintosh computer via 
a USB cable and the computer has been shut down, 
when the printer is switched on the computer may also 
switch on.
If this occurs disconnect the USB cable. (You may be 
able to solve the problem by connecting the printer and 
Macintosh via a USB hub.)

Switching the Printer On
Switch on the printer before you execute a print job from the 
computer.

1 Press the Power button.

Processing to prepare the printer starts after the 
Online lamp and Message lamp start flashing. After 
preparation processing is completed and media is 
loaded, the Online lamp light, and the printer is 
ready to print.

If no print media is loaded in the printer when the 
printer is switched on, Offline is displayed and the 
printer waits for you to load media in the printer.

If the Message lamp is flashing, read the message 
on the printer operation display and take the 
appropriate action. “Responding to Error Messages” 
(→ P.6-2)

If the display or Online lamp do not light, check the 
power cord connections at the printer and the power 
supply and make sure that they are secure. 
(→ Quick Start Guide)

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Online
Bk

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Online
Load Roll Media

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Switching the Printer Off
When you are finished using the printer, follow this 
procedure to switch the printer off.

Important
Never switch the printer off, and never unplug its 
power cord during a print job. This could damage the 
printer.
Remove the roll from the printer if you do not intend to 
print from the roll for a long period. Leaving the roll 
media at the standby position for an extended period 
could cause poor feeding.

1 Look at the display and confirm that a print 
job is not in progress.

If you see an error message displayed, follow the 
procedure to correct the problem, and make sure the 
print job has completed.

If a print job is in progress, wait for the print job to 
complete before switching off the printer.

2 Press and hold down the Power button until 
you see Shut Down.. in the display then 
release the button.

Please Wait.. is displayed for a few seconds, then 
the printer goes off.

Online
Bk

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Online and Offline
When the Printer Is Operating
This printer has three operation modes: online, offline 
and menu mode. Each mode is described below.

Online mode
The printer immediately processes a print job sent 
from the computer.
Offline mode
The printer receives a job from the computer but the 
job is held in the standby status without processing it. 
While the printer is offline, you can load or cut media 
manually, access the carriage, and perform other pro-
cedures.
The printer also goes offline automatically any time the 
printer cannot start processing a print job, such as 
when there is no print media loaded, when an error 
occurs, and so on.
Menu mode
The menu mode displays the function menus on the 
printer display. Press the buttons on the operation 
panel to set or execute the functions in the menus. 
Like the offline line mode, this mode places all jobs in 
standby status.

Note
Use the Use Power Save and Sleep Timer settings 
on the printer operation panel to set the sleep mode 
on/off timing. When Use Power Save is set On, you 
can use the Sleep Timer to set the length of time until 
the printer enters sleep mode. (→ P.1-28)
If the printer remains idle for more than 15 minutes 
with the cover closed (if no print jobs are received or if 
no operation panel buttons are pressed), the printer 
automatically enters the sleep mode to conserve 
energy. Only the Online lamp remains on while the 
printer is in the sleep mode; the display and other 
lamps remain off. The printer awakens from the sleep 
mode as soon as it receives a print job or if you press 
any button on the operation panel. The printer requires 
about 5 seconds to recover from the sleep mode.
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How to Switch Modes
Press the Online button to switch the operation mode.

1 Press the Online button then select the 
operation mode.
Every time you press the Online button, the mode 
selection changes in this order: Online > Offline > 
MAIN MENU.

Online mode

With Online displayed on the operation panel, the 
Online lamp lights.
If no media is loaded, or if a message is displayed on 
the operation panel, the printer will not enter the online 
mode even when you press the Online button. Every 
time you remove the cause of a printer error, the 
printer will automatically enter the online mode.

Offline Mode

With Offline displayed on the operation panel, the 
Online lamp goes off.

Menu mode

While MAIN MENU is displayed on the operation 
panel, you can use the arrow keys ([�] [�] [�] [�]) 
and the OK key to operate the function menus.

Online
Bk

MAIN MENU
Head Cleaning

Online Status Offline Status

When Paper Is Not 
Loaded or Error 
Has Occurred

Paper Loaded

Function Menu Display Mode

Offline
              Feed Paper

Online
Bk

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Data
Information Power

Offline
Menu

Message
Offline
              Feed Paper

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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What’s On the Operation Panel?
The printer operation panel of this printer provides a display 
(a), 10 buttons (b) and 5 lamps (c).

“Viewing the Display” (→ P.1-11)
“Using the Operation Panel Buttons” (→ P.1-12)
“Reading Operation Panel Lamps” (→ P.1-14)

Viewing the Display
The display indicates the current status of the printer.

Standby

Line 1:
The first line of the display indicates the current operat-
ing status of the printer.
Line 2:
The abbreviation for the currently installed black ink 
tank (Bk for Photo Black Ink, MBk for Matte Black Ink) 
is displayed at the left. (→ P.2-2)
The level of the ink supply in each ink tank is displayed 
in the center, and the remaining capacity of the mainte-
nance cartridge is displayed at the right.

Print Job Processing

Line 1:
The first line of the display indicates the current 
processing status of the printer.
Line 2:
Displays the job name and other information.

Function Menu mode

Line 1:
Displays the name of the menu and menu items.
Line 2:
Displays each item for selection on the menu. 
A right arrow at the right end of the line indicates that 
there are more items.
A down arrow at the right end of the line indicates that 
there are more sublevels. When both cases exist, you 
will see a down arrow and right arrow displaying alter-
nately.

Note
For more details about the function menus, please 
refer to “How to Perform Function Menu Settings” 
(→ P.1-17)

Online
Bk                           J J J J J J

Data
Information Power

Offline
Menu

Message

a

b

c
Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Printing...

MAIN MENU
Media Type ↓
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Current Selection

Line 1:
Displays the items on the menu.
Line 2:
Displays the item or value of the setting.
A setting prefixed with an equals sign (=) indicates the 
current selection.

Note
For more details about the function menus, please 
refer to “How to Perform Function Menu Settings” 
(→ P.1-17)

Message Display

Printing stops and the Message lamp starts flashing 
when the printer requires servicing. Perform the appro-
priate procedure when this occurs.
In some cases you can continue printing once a mes-
sage notifies you that the printer needs servicing. When 
the Message lamp lights, press any button to extinguish 
the lamp and the message.

Note
For more details about what to do when an error 
message appears, see Chapter 6 “Responding to 
Error Messages” (→ P.6-2).

Using the Operation Panel Buttons
The buttons on the operation panel are used for the 
functions described below.

a Power button
Press this button to switch the printer on and off.

Printer off:
Press to switch the printer on.
Printer on:
Press for at least 1 second to display Shut Down.. and 
switch the printer off.

b Online button
Press this button to switch printer offline and online and 
the menu display.

Printer online:
Press to switch the printer to offline.
Printer offline:
Press to switch the menu display.
Menu display:
Cancels the menu operation mode and switches to the 
online mode. Also temporarily suspends a maintenance 
cartridge error so you can switch the printer to online 
mode after a maintenance cartridge error displays. How-
ever, you cannot switch to the online mode when other 
messages are displayed or when paper is not set.
Job processing:
Puts the printer in the pause mode. The current print 
job pauses temporarily.

Media Type
=     Plain Paper

ERROR                      E02501
Rep. Y Ink Tank

Data
Information Power

Offline
Menu

Message

b

a

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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c Paper Source button
Online, Offline, Menu Display Status:
Press and hold for 1 second or more to switch 
between Roll Media and Cut Sheet as the feed source. 
However, this switching cannot be performed if the 
upper cover, right cover, or release lever is open.

d OK button
Setting value display:
Selects the value or setting, or executes the function, 
currently displayed on the operation panel.

e Information button
Displays the submenus. The information about ink, the 
maintenance cartridge, media, and printhead height, 
printhead service life, and parts service life displays in a 
prescribed order on a rolling display. Pressing and hold-
ing this button for 3 seconds also starts Head Cleaning 
A. (→ P.4-38)
The length of the media remaining also displays if the 
function that checks the amount of media remaining on 
the roll is switched on.

f Stop/Eject button
Online, Offline, Menu Display Status:
Press and hold for over 1 second to cancel printing, ink 
drying, or eject the media.
Pause Status:
Press and hold for over 1 seconds to cancel a paused 
job and eject the media.

g [�] button
Printer offline:
Press and hold for 1 second to move the carriage to 
the center of the platen.
Menu display:
Operates as a function select button to display the pre-
vious candidate (menu item or value) for selection.

h [�] button
Printer offline:
Does manual feeding from the roll automatically when 
you are using the roll as the feed source.
Menu display:
Press this button to open the next menu level below.

i [�] button
Printer offline:
Manually reverse feeds paper onto the roll.
Menu display:
Press to return one level up and display the previous 
menu item.

j [�] button
Printer offline:
Press and hold for 1 second to move the carriage to 
the center of the platen.
Menu display:
Operates as a scroll button to display the next candi-
date (menu item and value) for selection.

Data
Information Power

Offline
Menu

Message

c

e

f
d

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Data
Information Power

Offline
Menu

Message

j
h

i

g
Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Reading Operation Panel Lamps
The lamps on the operation panel indicate the following 
states.

a Data lamp
Flashing:
The printer is printing, receiving or processing a print 
job.
When the printer is not printing, this indicates that a job 
has been stopped and the printer is in the pause 
mode, the printer is has received data that it cannot 
process, or the firmware is being updated.
Off:
There are no jobs in the printer.

b Message lamp
On:
A warning is displayed on the operation panel.
Flashing:
An error has occurred.
Off:
The printer is operating normally, or the printer is 
switched off.

c Roll Media lamp
On:
Roll media is selected as the paper source.

d Cut Sheet lamp
On:
Cut sheet is selected as the paper source.

e Online lamp
On:
The printer is online or the printer is processing a print 
job or sleeping.
Off:
The printer is offline or in pause mode, in menu display 
mode, is initializing immediately after power on, or has 
been switched off.

Data
Information Power

Offline
Menu

Message

e

a

b

c

d

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Function Menus
You can use the operation panel to access and use all the 
functions built into the printer. You can use the menus to 
perform system settings, set up options, clean the 
printhead, perform test prints and other functions. You can 
press the Information button at any time to view the 
submenus and read information about the ink levels, media, 
and height of the printhead.

Printer Function Priorities
The settings done on the printer operation panel reset all 
the default settings and are applied to all print jobs. How-
ever, if the same settings are done with the printer driver 
then the printer driver settings have priority when print 
jobs are executed.

Function Menu Flow Summaries
The following illustration shows you how the items of the 
function menus are organized. Press [�] or [�] to dis-
play the next item, press [�] to display the next level 
below, or press [�] to return to the previous level. You 
can also press the OK button to enter the settings for 
each menu item.
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*1 *3*2

*7

*2*2*6*5*4 *6 *6 *6 *6

*8

*1 Displayed only when media is loaded.
*2 Not displayed during maintenance cartridge warning.
*3 Displayed only during printing.
*4 Displayed only when Band Joint is selected as the Feed Priority.
*5 Displayed only when Print Length is selected as the Feed Priority.

*6 Displayed only when Network board is installed.
*7 Displayed only when Automatic is selected as the IP Mode.
*8 Displayed only when Manual is selected as the IP Mode.

Information SUB MENU

Width : (Paper Width)
(Media Type)

Remaining : (Paper Remaining) m
## Printable

Head Height  (L/M/H)
Best Head Hght  (L/M/H)
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How to Perform Function Menu Set-
tings
When you do the function menu settings, press Online to 
display the menus, then use the [�], [�], [�], [�], and 
OK buttons to operate the menus.

Making Settings
Here we will show you how set the sleep timer as an 
example of how to use the operation panel buttons.

Note
Confirm that Use Power Save is switched on. The 
sleep timer cannot be set while Use Power Save is 
switched off.

1 If the printer is off, press the Power button to 
switch the printer on.
After a few seconds Online is displayed in the 
operation panel and the Online lamp lights.

2 Press the Online button then select MAIN 
MENU.

3 Press the [�] or [�] button to select 
System Setup then press [�].

The next level of the menu is displayed.

4 Press [�] or [�] to select Sleep Timer 
then press [�].

The setting value for the selected item appears.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Main Menu
System Setup

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

System Setup
Sleep Timer

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press the [�] or [�] button to select the 
desired setting then press the OK button.

The selected value is prefixed with an equals sign 
(=).

6 Press the Online button to display Online.

The Online lamp lights and the printer is ready to 
print.

Sleep Timer
  10 min.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Online
Bk

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Menu Settings Summary Tables
Each menu has the functions described below. A setting value marked with an asterisk (*) is the initial setting for that menu 
item.

MAIN MENU

Menu Item Setting Values Function

Head Cleaning Head Cleaning A Cleans the printhead.
Head Cleaning B Performs stronger cleaning than Head 

Cleaning A.
Force Cutting No, Yes Executes a roll cut at the current position. 

However, if the media is cut within 10 cm 
from the leading edge the media still feeds 
the prescribed distance before the cut is 
performed. This menu item is displayed only 
while Roll Media is selected for printing.
If the feed distance is very small, the cut is 
not performed.

Chng Head Hght  No, Yes Adjusts the height of the Printhead. (→ P.2-
40)

Media Type Plain Paper*, CAD Plain Paper, Plain 
Paper HQ, Recycled Coated, Coated 
Paper, HW Coated, Premium Matte, 
Ex HW Coated, Glossy Photo, Semi-
Gl Photo, HW Glossy Photo, HW 
SemiGl Photo, Syn. Paper, Adh. Syn. 
Paper, Backlit Film, Flame-Res. 
Cloth, Proofing Paper, News Proof 1, 
News Proof 2, News Proof 3, FineArt 
Photo, FneArt HW Photo, FineArt 
Txtr, Canvas Semi-Gl, JPN Paper 
Washi, Colored Coated, CAD Trace 
Paper, CAD Matte Film, Special 1-5

Selects the type setting for media. Only the 
names of the types of media that can be 
used with the set Bk ink are displayed.
(→ P.2-4)
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Med. Detail Set
Media Type Plain Paper*, CAD Plain Paper, Plain 

Paper HQ, Recycled Coated, Coated 
Paper, HW Coated, Premium Matte, 
Ex HW Coated, Glossy Photo, Semi-
Gl Photo, HW Glossy Photo, HW 
SemiGl Photo, Syn. Paper, Adh. Syn. 
Paper, Backlight Film, Flame-Res. 
Cloth, Proofing Paper, News Proof 1, 
News Proof 2, News Proof 3, FineArt 
Photo, FneArt HW Photo, FineArt 
Txtr, Canvas Semi-Gl, JPN Paper 
Washi, Colored Coated, CAD Trace 
Paper, CAD Matte Film, Special 1-5

These are the names of media that you can 
select. Only the names of the types of media 
that can be used with the set ink tank are 
displayed.

Drying Time Off, 30 sec., 1 min., 3 min., 5 min, 10 
min., 30 min., 60 min.

An ink drying time interval for each media is 
set to allow enough time for a printout to dry 
before the next sheet prints.

Scan Wait Time Off, 1 sec., 3 sec., 5 sec., 7 sec., 9 
sec.

The printhead can be set to pause after one 
pass (a scan) and wait for the ink to dry (this 
allows for the absorption properties of 
different media). However, the printing time 
will be much longer.

NearEnd RllMrgn 20mm, 5mm This sets the amount of white space to 
ensure the quality of printing at the leading 
edge.

Important
If set to 5 mm, the print quality at the 
leading edge, or the accuracy of feeding, 
may deteriorate, or the surface of the print 
may be scratched. Also, ink may stick to 
the leading edge.

Menu Item Setting Values Function



1- 21

Function Menus
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Far End RollMrgn 10mm, 5mm Sets the amount of white space to ensure 
the quality of printing at the trailing edge.

Important
If set to 5 mm, the print quality at the 
leading edge, or the accuracy of feeding, 
may deteriorate, or the surface of the print 
may be scratched. Also, ink may stick to 
the leading edge.

Media Thickness Thick, Standard, Thin Selects the ideal thickness for the media 
type. The printhead alert will display based 
on the value of this setting.

VacuumStrngth Weak, Standard, Strong, Strongest Sets the amount of suction on the media on 
the platen.

Standard Cutter Enable, Disable Determines whether the standard, flat blade 
cutter is enabled.

Cut speed Standard, Fast Sets the speed of the cutter cutting the 
media. Selecting Fast for film and other 
media that easily generates cutting dust will 
reduce the amount of dust.

CutDustReduct Off*, On When printing on film or other media that 
creates a large amount of dust during 
cutting, a line is printed at cutting position to 
reduce the amount of scattered dust.

Correct Smear Off*, On Select for media when the printing results is 
easily scratched.

Menu Item Setting Values Function
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Skew Check Lv. Standard*, Loose, Off When you are printing on Japanese washi 
paper or other media of non-standard width, 
you can lower the amount of skew detected 
or switch this function off. However, if you 
switch this function Off, you could cause a 
paper jam if the sheet is not loaded perfectly 
straight.

Important
If media is set at a skewed angle while Off, 
this could cause jams or fouling the platen.

Width Detection On*, Off, Media Size? The Width Detection function can be 
switched to Off only when printing on cut  
sheets. You can switch width detection off for 
Japanese washi or other media of non-
standard widths. If you switch this function 
Off, then Media Size? is displayed and you 
can enter the width of the media.

Return Defaults No, Yes This function restores the media type 
settings to their default values.

ChangeBkInkType No, Yes You can switch the black ink tanks based on 
the requirements of the print job for different 
types of black ink.

Rep. Ink Tank No, Yes When you must change an ink tank during a 
print job, the required processing is done so 
you can change the ink tank. This menu is 
displayed during printing only.

Adjust Printer
Auto Head Adj. Adjusts the printhead. (→ P.4-40)

Advanced Adj. No, Yes Prints the pattern used to adjust nozzle 
gaps, print direction, and color gaps; the 
printer reads the printed pattern and does 
the adjustments automatically based on the 
results of the printout.

Menu Item Setting Values Function
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Standard Adj. No, Yes Prints the adjustment pattern used to adjust 
the position of the printhead, reads the 
results of the pattern, and then automatically 
adjusts the values for printhead positioning.

Auto Print On*, Off You can set Advanced Adj. to print 
automatically immediately after the printhead 
is replaced.

Feed Priority Band Joint*, Print Length Sets the priority for the precision of media 
feed. Select Print Length when you want 
the media to feed accurately. When Print 
Length is selected, color may blur slightly in 
the direction of carriage scanning.

Adjust Band Adjusts the amount of line feed for each type 
of media. (→ P.4-42)

Standard Adj. No, Yes The printer prints this pattern and uses it to 
adjust the amount of feed; it scans the 
printout and automatically adjusts the values 
for each type of media.

Advanced Adj. No, Yes Use with media other than Canon media or 
media not approved for output with the 
printer. The adjustment value is set 
automatically when the printer reads the 
printed pattern. However, this requires more 
time than Standard Adj. and consumes 
more ink.

Fine Tuning -3 ~ 0* ~ +3 Allows manual entry of a value to fine adjust 
the band adjustment of the media selected 
for printing.

Adjust Length -0.70 ~ 0.00* ~ 0.70% Adjusts the amount of stretching and 
shrinking for each media type. To set a 
longer feed for a media that stretches easily, 
adjust the value to the plus (+) side, or adjust 
it to the minus (-) side to set a shorter feed 
for a media that shrinks easily. This menu is 
displayed only when Print Length is 
selected for Feed Priority.

Menu Item Setting Values Function



1- 24

Function Menus
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Color Adj.
Return Defaults Off*, On This restores all color settings at once to 2, 

the factory default setting.
Color Adj. PM 1, 2*, 3 You can adjust the density of PM 1, 2*, 3 Y, 

M, C, K, PM, PC one by one and perform the 
corrections.
The settings can be performed in the range 1 
to 3 (the standard factory default setting is 
2). Set to 1 for a light adjustment or set to 3 
for a dark adjustment.

Color Adj. PC 1, 2*, 3
Color Adj. Y 1, 2*, 3
Color Adj. M 1, 2*, 3
Color Adj. C 1, 2*, 3
Color Adj. K 1, 2*, 3

Interface Setup
EOP Timer 10 sec., 30 sec., 1 min., 2 min., 

5 min., 10 min.*, 30 min., 60 min.
Sets the job timeout setting for the printer.

TCP/IP Sets the TCP/IP protocol for the network 
interface. After setting each TCP/IP item, 
select Store Setting to save the settings and 
enable them. This menu is displayed only 
when the network interface is installed.
(→ P.5-12)

TCP/IP On The setting for TCP/IP protocol is locked On. 
This setting cannot be changed.

IP Mode Manual*, Automatic This setting determines whether the IP 
address is set automatically or entered 
manually.

Protocol Sets the type of server when the printer is 
set for automatic entry of the IP address.DHCP

BOOTP
RARP

Off*, On

IP Setting Sets the printer network information if a fixed 
IP address has been set.

IP Address
Subnet Mask
Default G/W

0.0.0.0* ~ 255.255.255.255 Allows entry of the IP address assigned to 
the printer, network subnet mask, and 
default gateway.

Menu Item Setting Values Function
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NetWare Sets the network interface for NetWare 
protocol. After setting each TCP/IP item, 
select Store Setting to save the settings and 
enable them. This menu is displayed only 
when the network interface is installed.
(→ P.5-35)

NetWare Off*, On Determines whether NetWare protocol is 
used.

Frame Type Auto Detect, Ethernet 2, Ethernet 
802.2*, Ethernet 802.3, Ethernet 
SNAP

Selects the frame type to use.

Print Service Bindary Pserver, RPrinter, NDS 
Pserver*, NPrinter

Selects the print service.

AppleTalk On, Off*, Determines whether AppleTalk protocol is 
used. After setting each TCP/IP item, select 
Store Setting to save the settings and enable 
them. This menu is displayed only when the 
network interface is installed. (→ P.5-30)

Ethernet Driver Sets the method of communication for the 
network interface board. After setting each 
TCP/IP item, select Store Setting to save 
the settings and enable them. This menu is 
displayed only when the network interface is 
installed. (→ P.5-6)

Auto Detect On*, Off Automatically recognizes the LAN 
communication protocol. If set to Off, the 
communication method or Ethernet type are 
enabled.

Comm. Mode Half Duplex*, Full Duplex Selects the LAN communication method.
Ethernet Type 10 Base-T*, 100 Base-TX Selects the LAN communication speed.
Spanning Tree Not Use*, Use This selection determines whether the LAN 

spanning tree signal is received.
MAC Address Displays the MAC address of the network 

interface board.

Menu Item Setting Values Function
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Store Setting OK?
Init. Settings OK? Resets all of the Interface Setup settings to 

their factory defaults.
Maintenance
Replace P.head No, Yes Sets the printer in the replace printhead 

mode. This menu is not displayed while the 
maintenance cartridge capacity warning is 
displayed. (→ P.4-23)

Move Printer No, Yes Sets the printer to the mode that enables you 
to carry out the procedures required before 
transporting the printer to another location. 
This menu is not displayed while the 
maintenance cartridge capacity warning is 
displayed. (→ P.4-32)

System Setup
Warning

Buzzer On*, Off Sets the buzzer function. When set to On, 
the buzzer sounds when an error occurs.

Head Ht. Wrning On*, Off, Check Head Hght Determines whether a prompt is issued 
when the printhead is not at the correct 
height for the print media.

Med.type Wrning On*, Off Determines whether a warning is issued 
when the media loaded in the printer does 
not match the media specified for the print 
job.

Change Cutter No, Yes Prepares the printer so the cutter can be 
replaced when replacement is necessary. 
After replacement, you can reset the number 
of cuts.

Menu Item Setting Values Function



1- 27

Function Menus
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Keep Media Size Off*, On When switched to On, the print job executes 
with the media size specified for the data. 
Depending on the size of the margins, some 
of the data may be cut off. 
When set to Off, the job will print without 
cutting off part of the image at the top or 
bottom. However, the printout will be 
extended by the lengths of the top and 
bottom margins.

Important
When On, part of the image may be cut off. 
(→ P.7-5)
When set to Off, the image inside 5 mm 
from the top, bottom, left, and right edges 
will be printed clearly as the recommended 
printing area. However, the printout will be 
extended by the lengths of the top and 
bottom margins.

Chk Remain. Roll Off, On* When On, the bar code prints when the roll 
is removed in order to monitor the amount of 
media remaining on each roll. 
When Off, the bar code is not printed when 
the roll is removed. If this is set to Off, the 
edge will be cut off regardless of the roll 
paper loading position.

Menu Item Setting Values Function
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Roll Length Set ## m (meter selected for Length 
Unit), ## feet (feet/inch selected for 
Length Unit), Manual Setting, 
Unknown

When the roll supply remaining detection 
function is On, the printer sets the media length 
when the roll media loaded has no bar code. 
This is displayed only when Chk Remain. Roll 
is On. Some Length Units are displayed in 
meters, and others in feet depending on the 
setting. Also, if Manual Setting is selected you 
can enter the length directly. 
If Unknown is selected, the roll supply remains 
function is switched Off.

Nozzle Check 1 page, 10 pages*, Nozzle check Allows you to set the number of patterns to 
print when a nozzle clogs during an 
automatic check.

Stop Ink Check Bk Ink Tank
PC Ink Tank
C Ink Tank
PM Ink Tank
M Ink Tank
Y Ink Tank

Switches off the ink level detection function. 
(→ P.4-8)

Sleep Timer 5 min., 10 min., 15 min.*, 20 min., 
30 min., 40 min., 50 min., 60 min.

Sets the amount of time the printer remains 
idle before it enters sleep mode.

Use Power Save On, Off Sets up the printer sleep mode function. If 
set to On the printer enters the Sleep Timer 
mode to reduce its power consumption and 
conserve energy if the covers are closed and 
the printer is neither operated nor receives a 
print job after the prescribed time has 
elapsed. If set to Off, sleep mode is 
disabled. (→ P.1-9)

Length Unit meter*, feet/inch Sets the units used to display the length of 
the roll sheet on the display. The units for the 
roll length display and the roll supply 
remains display are separate.

Menu Item Setting Values Function
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Time Zone 0:London   (GMT)
+1:Paris,Rome
+2:Athens,Cairo
+3:Moscow
+4:Eerevan,Baku
+5:Islamabad
+6:Dacca
+7:Bangkok
+8:Hong Kong
+9:Tokyo,Seoul
+10:Canberra
+11NewCaledonia
+12:Wellington
-12:Eniwetok
-11:Midway is.
-10Hawaii(AHST)
-9:Alaska(AKST)
-8:Oregon (PST)
-7:Arizona(MST)
-6:Texas  (CST)
-5:NewYork(EST)
-4:Santiago
-3:Buenos Aires
-2:
-1:Cape Verde

You can select a representative city in the 
appropriate time zone, along with the 
selection of the GMT time difference. 

Date Format yyyy/mm/dd
dd/mm/yyyy
mm/dd/yyyy

Sets the display format for the date. 

Language English*, Français, Deutsch, Italiano, 
Español

Sets the display format for the date. 

Reset MediaType No, Yes Media Configuration Tool can be used to 
restore the content of changed settings to 
their factory defaults.

Test Print
Status Print Prints the printer information and setting 

values.
Menu Map Prints a list of all the items on the MAIN MENU.
Print Job Log Prints a list of information about printed jobs, 

including media size and type, amount of ink 
consumed, etc.

Nozzle Check Prints the nozzle check pattern.

Menu Item Setting Values Function
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Media Details Prints a list of media type settings.
Information
Version Displays the version numbers for the printer 

unit and the firmware.
RAM Displays the memory capacity of the printer.
Ext. Interface Displays the name of the interface that can 

be used at the expansion slot.
MAC Address Displays the MAC address of the printer in 

the network. This menu is displayed only 
when the network interface is installed.

Error Log Displays the most recent error message.
Job Log Displays at the end information about the 

print job.
Document Name Displays the name of the document in the 

print job.
User Name Displays the job user name.
Page Count Displays the number of pages in the print 

job.
Job Status Displays the result of the print job 

processing.
Print Start Time Displays the time that the print job was 

started.
Print End Time Displays the time that the print jobs ended.
Print Time Displays the time elapsed for the print job.
Print Size Displays the size of the media used in the 

print job.
Media Type Displays name of the media type used in the 

print job.
Interface Displays the name of the job interface.
Coverage Displays the ink density of each color used in 

the job.
Counter

Cut Count Displays the number of cuts by the cutter. 
You can reset this counter after the cutter 
has been replaced.

Menu Item Setting Values Function
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Sub Menus

Menu Item Setting Values Function

Ink: Displays in the center the ink capacity in 7 
steps (100%, 80%, 60%, 40%, 20%, 0%) 
and no ink.

Displays in seven levels the capacity of ink 
that the maintenance cartridge can still 
absorb.

Width:   X
Y

X: Media Width
Y: Media Type

The width of the media is shown on the top 
line, and the type of media is shown on the 
bottom line.

Remaining:   Xm
YY Printable

X: Roll Remains
Y: Sheets printable with remaining 
ink.

When the roll media supply detection is On, 
this displays the length of the media that 
remains on the roll. Also, while the ink 
remains alert is displayed the number of 
sheets that can be printed is also displayed.

Head Height X
Best Head Hght Y

X: Current printhead position (L, M, H) 
Y: Best position for media (L, M, H)

When the Head Ht. Wrning is On, an alert is 
issued if the current height of the printhead is 
lower than the ideal height for the media.

100%
(100~90%)

80%
(90~70%)

60%
(70~50%)

40%
(50~30%)

20%
(30~6.9%)

0%
(6.9~0%)

~700ml
(7dot)

~600ml
(6dot)

~500ml
(5dot)

~400ml
(4dot)

~300ml
(3dot)

~200ml
(2dot)

200ml~0ml
(1dot)



1- 32

Printer Driver
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Printer Driver
The computer uses the printer driver to send the print job to 
the printer. This section describes the functions of the 
printer driver.

Printer Driver Features
The printer driver presents the items that allow you to 
perform the settings for the media type, print quality, page 
size, and other important settings. Also, the printer provides 
a variety of easy-to-use functions which are described 
below. For more details about operation procedures, please 
refer to Chapter 3 “Printing Methods for Different 
Objectives” and the printer online Help.

Borderless 
Printing

The printer can do borderless printing at 
the four edges of the media as shown in 
the photo. (→ P.3-13, P.3-77)

Banner Printing

You can make long printouts up to 15.24 
meters long for vertical or horizontal 
banners for hanging (18 m with Mac OS X 
or later). (→ P.3-30, P.3-94)

Enlarged/
Reduced 
Printing

You can print and have the image 
automatically enlarged or reduced to fit on 
the width of the media on the roll. You can 
make prints easily that fill the entire width 
of the media. (→ P.3-6, P.3-65)
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Multiple Page 
Printing

You can reduce the size of the image and 
print multiple copies on one sheet. Use 
this feature to save paper when you need 
to only confirm the content. 
(→ P.3-24, P.3-89)

Poster Printing

You enlarge an image and have it print in 
sections on several sheets. This is 
convenient when you need to paste 
together sheets to form one large poster. 
(→ P.3-26, P.3-92)

Printing with 
Watermarks

You can stamp your printouts with 
watermarks or transparent overlays.
(→ P.3-28)

Preview Display

Displays a graphic representation of what 
the printout will look like by showing the 
effects of the printer driver settings. This 
allows you to confirm what the print job 
will look like before you print it. 
(→ P.3-5, P.3-64)

Color 
Adjustment

You can use the printer driver to adjust the 
tones of the colors in your printed 
materials. (→ P.3-42, P.3-107)

Custom Sizes

You an register custom sizes for paper 
and other media. (→ P.3-51, P.3-121)
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Print 
Preferences Settings that match the purpose of the 

document are registered. You can easily 
perform print jobs that meet the purpose 
of the job. Also, you can register the 
content of the settings under a name that 
you give it. (→ P.3-2, P.3-59)

Maintenance

Nozzle check pattern prints, printhead 
cleanings, printhead adjustment, and feed 
adjustments can all be performed on the 
computer screen.
(→ P.4-36, P.4-38, P.4-40, P.4-42)

Default
Settings

POP Ad Poster Photo
(from digital

camera)

Photo
(from

scanner)

Long
Format

(Banner)

CAD

Printhead
Cleaning

Printhead
Adjustment

Adjusting�
Line Feed

Photo Black Matte Black
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Main Sheet
The Main sheet provides the following settings.

Print 
Preferences

Standard:
These settings are best for printing 
documents that contain text, images, 
and graphics mixed together.
POP Ad:
Best selection for printing sharp, bright 
posters for store advertising.
Poster:
Best selection for printing a photograph 
centered in a poster. 
Photograph 
(captured with digital camera):
Best for printing photographs taken with 
a digital camera.
Photographs (captured with a scanner):
Best selection when you need faithful 
reproduction of color photos captured 
with a scanner.
Long Format (Banner): 
Best for long print jobs with mixed text 
and illustrations in hanging vertical or 
horizontal banners. 
CAD:
Best choice when you want to print fine, 
sharp lines in architectural or 
engineering plans.

Media Type

Use this setting to set the paper or 
media type. A print job is performed to 
match the special characteristics of the 
media. If this setting does not match the 
type of media loaded in the printer, this 
will cause poor print quality.
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Print Quality

High: 
This print mode places priority on 
quality. 
Standard:
Prints the printout with normal quality. 
Draft: 
This print mode places priority on 
speed.
Custom Settings: 
The job is printed with the processing 
method selected by the user. The 
Highest selection prints with the best 
possible quality.

Set

With Print Quality selected under 
Custom Settings, the processing 
methods for Print Quality, Resolution, 
Enhance Text With Photos, and 
Halftones can be set. The items that 
can be selected and their settings are 
different, depending on the media type 
and ink type.

Color Mode

Color: 
Uses all the inks to print the job in color.
Monochrome (Photo):
Provides stable monochrome photo 
printing with minimal tone change and 
enables detailed adjustment of gray 
scale gradations and color tones. 
Monochrome: 
Converts all print data to grayscale and 
prints using only the black ink.
Solid Color:
Solid colors are printed differently so 
they stand out, light color lines print 
sharp. 
Black Only:
All areas other than white are printed in 
black.

Manual 
Color 
Settings

Allows manual adjustment of color 
balance, saturation, brightness, and 
contrast.

Open Preview 
When Print Job 
Starts

After executing the print job, check the 
image of the on the screen and then 
execute the print.

Status Monitor Follow the procedure below to start the 
Status Monitor.

Version Info. Displays the version number of the 
printer driver.

Defaults Returns the settings on the sheets to 
their initial (default) settings.
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Page Setup Sheet 
The Page Setup sheet provides the following settings.

Page Size Sets the size of the page for the print 
data.

Borderless 
Printing

Prints the image with no margin at the 
four edges of the sheet. There are 
limitations on the width and type of 
media. (→ P.2-4, P.3-13, P.3-77)

Enlarged/
Reduced 
Printing

Allows you to enlarge or reduce printing. 
You can select one of the following 
methods to do this.

Fit Media 
Size

Automatically sets the enlargement/
reduction proportionally to match the 
size selected for the Media Size.

Fit Roll 
Paper Width

Automatically sets the enlargement/
reduction proportionally to match the 
size selected for the Roll Paper Width.

Scaling Allows you to scale the size of the image 
manually in the range 5% to 600%.

Media Size Allows you to specify the actual size of 
the media where the job will print.

Orientation Allows you to select either portrait or 
landscape printing.

Rotate Page 90 
degrees 
(Conserve 
Paper)

Automatically rotates the image 90 
degrees when print job would result in a 
printout with the length smaller than the 
width. This saves paper.

Media Source Specifies whether roll media, roll media 
(banner), or cut sheets will be used.

Roll Paper 
Width

Specifies the width of the roll paper to be 
used.

Auto Cut... Specifies whether the sheet is cut after 
printing.

Size Options
Allows you to define free sizes other 
than the standard sizes so you can print 
do long prints.
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Layout Sheet
The Print Layout sheet provides the following settings.

Page Layout
This feature allows you to print several 
pages up on the same sheet or break up 
an enlarged image by printing it over 
several sheets for a large poster.

Watermark

Overlays a watermark on the printed 
image. You can freely make your own 
watermarks (text, text enclosed in 
boxes, transparent text) positioned 
freely on the page, give them a name, 
and register them.

Print Centered
When the image to be printed is smaller 
than the sheet, you can print the image 
centered so the margins are even.

Rotate 180 
degrees

This feature rotates the image 180 
degrees.

No Spaces at 
Top or Bottom 
(Conserve 
Paper)

When the image to be printed is smaller 
than the media, you can set the printer it 
does not feed and there is no margin at 
the top or bottom. This conserves roll 
paper.

Copies Specifies the number of copies to print.

Special Settings
If the print results are not what you 
expect, you can change how the print 
job is processed.
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Maintenance Sheet
The Maintenance sheet provides the following settings.

Utility

Open the Status Monitor and display the 
Utility sheet. This allows you to perform 
nozzle check pattern prints, printhead 
cleaning, printhead position adjustment, 
and feed adjustment.
The Status Print item is on the 
Information tab of the Status Monitor.

Update Ink 
Information

Use this setting to set the type of black 
ink. Click the Acquire Status button to 
set the printer to operate with the black 
ink tank mounted in the printer.
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Printing
Follow the procedure below to start a print job.

Printing From Windows
To print a job from a Windows software application, use the 
Print command in the File menu.

Important
The Windows printer driver for this printer can be used 
with Windows Server 2003, Windows XP, Windows 
2000, Windows Me, Windows 98, and Windows NT 
4.0. The printer driver is not compatible with Windows 
95. (→ Quick Start Guide)
Before you start a print job on the computer, close any 
software applications running in the background. 
Another program running in the background could 
break the flow of print data and temporarily stop the 
printer or cause poor print quality.

Note
For more details about how to use the printer driver, 
please refer to Chapter 3 “Printing Methods for 
Different Objectives”.

Operating the Printer

1 In the software application, select Print from 
the File menu.

The Print window opens.

2 Make sure the name of the printer is 
displayed in the Select Printer box, perform 
the settings for the Page Range and 
Number of Copies, then click the Print 
button.
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On the Main and Page Setup sheets, select the 
Media Type, Media Source, Print Quality, Color 
Settings, and Scaling settings for the print job.

The print job starts.

Important
As soon as each sheet prints, remove it from the 
output stacker.

Note
If the printer estimates that there is not enough ink 
available to perform a very long print or print several 
copies of the same document, it will issue the “Not 
Enough Ink” alert on the operation panel. In this case, 
replace the ink tank where the ink supply is low and 
print again. However, if you reinstall and use an ink 
tank that is nearly empty this could cause print quality 
to deteriorate. Never try to reinstall an ink tank once 
you see the mark  in the ink level display.
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Printing from a Macintosh
To print a job from a Macintosh software application, first 
select the printer then use the Print command in the File 
menu.

Important
Before you start a print job on the computer, close any 
software applications running in the background. 
Another program running in the background could 
break the flow of print data and temporarily stop the 
printer or cause poor print quality.

Note
For more details about how to use the printer driver, 
please refer to the online Help of the printer driver.

Selecting the Printer
For Mac OS 8.6/9.x
If you are using Mac OS 8.6 or Mac OS 9.x, select the 
printer with the Chooser. This printer will not be dis-
played in the list if it is not switched on, or if the printer 
cable is disconnected. Start the print job after you con-
firm that the printer is in working order.

Note
You may not be able to share the printer with a USB 
connection. In such a case, connect the printer directly 
to the computer through its USB or IEEE1394 port 
(option). If you want to share the printer, perform the 
print job from a Windows computer.

1 From the Apple menu, select Chooser.

2 Click the GARO Printer Driver icon in the 
list on the left, then in the right list under 
Destination select the name of the 
connected printer.
Select the appropriate setting for the output 
destination: USB for a USB connection, IEEE1394 
for a FireWire connection, AppleTalk for a network 
connection, or IP Print or IP Print (Auto).
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Important
If the printer is connected to a network, make sure that 
Active is selected for AppleTalk.
The network interface card used with this printer is not 
set before shipping for use with AppleTalk. On the 
printer operation panel, select Interface Setup > 
AppleTalk > On. (→ P.5-30)
For an IP print connection, register the IP address 
under Registering IP Address and then select the 
name of the printer under IP Print.

3 Close the Chooser window and click the OK 
button in the message window.

This completes the selection of the printer.

For Mac OS X
If you are using Mac OS X, user the printer setting utility 
to select the printer from the Print Center. This printer will 
not be displayed in the list if it is not switched on, or if the 
printer cable is disconnected. Start the print job after you 
confirm that the printer is in working order.
The example here describes Mac OS X Ver. 10.3. The 
icon name and graphic may be different for other ver-
sions.

1 Select Finder, then select Utility or 
Applications from the Go menu.

2 Open the Utilities folder then open Printer 
Setup Utility (Print Center).
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3 If the name of the printer is not in the Printer 
List, click the Add icon.
If the printer is already displayed, go to Step 4.

4 In the connection menu select the 
connection destination for the printer, select 
the name of the printer from the list, then 
click the Add button.
Select the appropriate setting for the connection 
destination: USB for a USB connection, Canon 
FireWire (GARO) for a IEEE1394 connection, or 
Canon IP (GARO), Zeroconf or AppleTalk for a 
network connection.

Important
For the AppleTalk connection, confirm these settings: 
System Preferences > Network > AppleTalk > Make 
AppleTalk Active.
The network interface card used with this printer is not 
set before shipping for use with AppleTalk. On the 
printer operation panel, select Interface Settings > 
AppleTalk > On. (→ P.5-30)

Note
This printer can be connected and operated with 
Zeroconf of Mac OS X. If you are using Mac OS X Ver. 
10.2.5 or later with a network connection using 
Zeroconf functions selected on the Connection menu, 
then you can select the name of this printer. 
If you are using Mac OS 8.6, 9.x with the Canon 
imagePROGRAF printer driver for Macintosh installed, 
you can also use the Zeroconf function to connect the 
printer.
This printer can be connected and operated with 
Canon IP (GARO). Select Canon IP (GARO) on the 
Connection menu then enter the IP address and 
printer name of this printer 
If the name of the printer is not displayed, check the 
printer connection cable, and make sure that the 
printer and network device are both switched on.
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Operating the Printer

1 In the software application select Print from 
the File menu.

The Print window appears.

2 Check the Printer box and make sure that 
the name of the printer is displayed. On the 
Main panel select the settings for the Page, 
Copies, Media Type, Media Source, Print 
Quality, and other settings.

If you are using Mac OS X, set the Copies&Pages 
panel and the Main panel.

3 Click the Print button.
The print job starts.

Important
As soon as each sheet prints, remove it from the 
output stacker.

Note
Before you start printing a long sheet or multiple 
copies, you should always check the ink supply levels 
of the ink tanks. To confirm the ink supply level of the 
ink tanks, on the Main panel click the Printer 
information button to display the levels. However, if 
you reinstall an ink tank that is nearly out of ink and 
use it this could cause the print quality to deteriorate. 
Do not re-install the ink tank marked  in the ink supply 
level display.
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Canceling a Print Job
Follow this procedure to cancel a print job.

Canceling a Print Job from Windows

1 In the Printers folder, double-click the icon 
for the printer.

2 Click the name of the job that you want to 
cancel, click Printer in the menu bar and 
select Cancel All Documents.
The print job is deleted.

3 If the print in progress display on the printer 
does not go off and online lamp is flashing, 
press and hold the Stop button for 1 sec.

The print job in progress is canceled.

4 If the Data lamp is off and you cannot cancel 
the print job, click the GARO Status Monitor 
icon on the right end of the taskbar to open, 
and then on the Printer Status sheet select 
the print job that you want to cancel, then 
press the Cancel Job button.

Note
You can also cancel a print job in progress, or a job 
waiting to be printed, by selecting and canceling each 
job on the on the Job sheet.

5 If the GARO Status Monitor is not installed, 
hold down the Power button for 1 second or 
more until the Shut Down.. is displayed, 
then switch the printer power off and on.
All of the print data currently processing in the printer 
is lost after the printer is switched off. Any print job 
required must be restarted.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Canceling a Print Job from Macintosh
The procedure to cancel a print job is different, depending 
on whether the job is printing in the background or the 
foreground.

Note
On Mac OS X all jobs print in the background. Printing 
cannot be performed in the foreground.

Canceling a Background Print Job
During background printing you can check the status of 
print jobs and cancel them. Follow this procedure to can-
cel a print job.

For Mac OS 8.6/9.x

1 In the GARO Printer Extra folder installed 
on the hard disk, click the GARO 
Printmonitor icon.

2 Select the print job to cancel, then click the 
Printing Paused button.

The print queue (print processing) is suspended and 
the Sending status display switches to Send. While 
the print queue is paused, a red dot is displayed on 
the right.

Once the printer enters the Ready to Send mode, 
select the Job icon is marked with the Q icon, and 
then press the Printing Paused button to delete the 
job. Continue from Step 4.
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3 With the job selected for deletion, click the 
Printing Paused button again.

The print job is deleted.

4 Select Resume Printing from the File menu.

The printer re-enters print mode and is ready for 
operation.

Important
After you have paused printing, you must select 
Resume Printing. Printing cannot be done while the 
print queue is paused (with the red dot displayed).

5 If the print in progress display on the printer 
does not go off and online lamp is flashing, 
press and hold the Stop button for 1 sec.

The print job in progress is canceled.

6 If the Data lamp goes off and you cannot 
cancel the print job, hold down the Power 
button for at least 1 second, release it after 
the Shut down.. message appears, then 
after the printer switches off, switch it on 
again.
All of the print data currently processing in the printer 
is lost after the printer is switched off. Any print job 
required must be restarted.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Mac OS X
The example here describes Mac OS X Ver. 10.3. The 
icon name and graphic may be different for other ver-
sions.

1 Select Finder, then select Utilities or 
Applications from the Go menu.

2 Open the Utilities folder then open Printer 
Setup Utility (Print Center).

3 Select the name of the printer from the 
Printer List, then select Show Jobs from 
the Printers menu.

The queue list for the printer is displayed.

4 Select the print job to cancel, then select 
Delete Job from the Jobs menu.

The print job in progress is canceled.

Important
A print job that has already been sent to the printer 
cannot be canceled. If you want to cancel other 
remaining jobs, cancel them with the GARO 
Printmonitor.
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Select the name of the printer in the Printer Setup 
Utility (Print Center), select the name of the printer, 
click the Set icon, then open GARO Printmonitor for a 
USB, FireWire, AppleTalk or Canon IP (GARO) 
connection, connection, or open the Remote UI for a 
Zeroconf connection.
Select the print job to delete, then click the Print 
Cancel button to cancel the job.

5 If the print in progress display on the printer 
does not go off and online lamp is flashing, 
press and hold the Stop button for 1 sec.

The print job in progress is canceled.

6 If the Data lamp goes off and you cannot 
cancel the print job, hold down the Power 
button for at least 1 second to display Shut 
Down..., then after the printer switches off, 
switch it on again.
All of the print data currently processing in the printer 
is lost after the printer is switched off. Any print job 
required must be restarted.

Canceling a Foreground Print Job
If you are printing in the foreground with Mac OS 8.6/9.x, 
a print processing dialog box remains open while the job 
prints. Follow this procedure to cancel a print job.

1 When the print-in-progress dialog box opens, 
press and hold down the Command key and 
press the period (.) key.

The print job is canceled.

2 If the print in progress display on the printer 
does not go off and online lamp is flashing, 
press and hold the Stop button for 1 sec.

The print job in progress is canceled.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Data
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Menu
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3 If the Data lamp goes off and you cannot 
cancel the print job, hold down the Power 
button for at least 1 second to display Shut 
Down.., then after the printer switches off, 
switch it on again.

All of the print data currently processing in the printer 
is lost after the printer is switched off. Any print job 
required must be restarted.

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Options
The following options are provided for this printer.

Stand
(Provided with the printer in the U.S.A.)
This stand is designed to support the W6400 Printer. The 
output stacker designed for this printer is provided.

Print Stand ST-23

Network Interface Board
The interface board that allows you add a LAN port.

Canon Network Interface Board NB-15FB

IEEE1394 Expansion Board
This board provides the IEEE1394 (FireWire) interface.

IEEE1394 Expansion Board EB-04

Roll Holder Sets
This set contains the roll holder and stoppers. To make 
proper use of rolls of different media types and widths, it 
is convenient to have several stoppers and holders on 
hand. Two types are available: 2-inch (provided on the 
printer) and 3-inch.

Roll Holder Set (For 2” Tubes) RH2-23 

Roll Holder Set (For 3” Tubes) RH3-23 
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Consumables
The following consumables are available for this printer.

You should have consumables on hand before they run out. 
Purchase consumables at the dealer where you purchased 
the printer.

Print Media
The following types of media can be used with this 
printer.

Type
Roll Media Sizes

Cut Sheets
Size Photo: 203.2 x 254.0 mm to ARCH D 609.6 x 914.4 
mm

Photo:

Glossy Photo Paper
SemiGlos Photo Paper
Heavyweight Glossy Photo Paper
Heavyweight SemiGlos Photo 
Paper

Art:

Premium Matte Paper
Fine Art Photo
Fine Art Heavyweight Photo
Fine Art Textured
Canvas SemiGlos
Japanese Paper Washi

Signs:

Synthetic Paper
Adhesive Synthetic Paper
Backlit Film
Flame-Registrant cloth

CAD:
CAD Plain Paper
CAD Tracing Paper
CAD Translucent Matte Film

Proof: Newsprint for Proofing
Proofing Paper

Generic:

Plain paper
Plain Paper (High Quality)
Recycled Coated Paper
Coated paper
Heavyweight coated paper
Extra Heavyweight Coated Paper 
Colored Coated Paper

Width:
24” (609.6mm), ISO A1 (594.0mm), JIS 
B2 (515.0mm), ISO A2 (420.0mm), 16” 
(406.4mm), 14” (355.6mm), ISO A3 
(297.0mm), 10” (254.0mm)

Roll diameter: Less than 150 mm (5.1 in.)

Media core 
inside 
diameter:

2”, 3”

Print surface: Front side
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Note
For more details about media sizes, please refer to 
Chapter 2 “Media You Can Use” (→ P.2-2).
The quality of media varies with the manufacturer. To 
purchase print media, contact the dealer where you 
purchased the printer.

Replaceable Ink Tanks
The following six types of replaceable ink tanks are used 
in this printer.

Ink Tanks for the W6400 

Note
For more details about how to replace the ink tanks, 
see Chapter 4 “Replacing Ink Tanks” (→ P.4-2)
Hereafter, “Photo Black Ink” is used to distinguish 
“Black Ink BCI-1431 BK” from the matte black ink.

Maintenance Cartridge
The maintenance cartridge (number listed below) is 
replaceable.

Maintenance cartridge MC-01

Note
For more details about how to replace the 
maintenance cartridge, see Chapter 4 “Replacing the 
Maintenance Cartridge” (→ P.4-16)

Replaceable Printhead
The product number of the printhead that can be used on 
the printer is:

Printhead BC-1350

Note
For more details about how to replace the printhead, 
see Chapter 4 “Replacing the Printhead” 
(→ P.4-23)

Yellow Ink
Magenta Ink
Photo Magenta Ink
Cyan Ink
Photo Cyan Ink
Black Ink
Matte Black Ink

BCI-1451Y
BCI-1431M
BCI-1431PM
BCI-1431C
BCI-1431PC
BCI-1431BK
BCI-1451MBK
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Cutter Blade
The product number of the cutter blade that can be used 
on the printer is:

Cutter Blade CT-02

Note
For more details about how to replace the cutter blade, 
see Chapter 4 “Replacing the Cutter Blade” (→ P.4-29)
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Specifications

W6400
Print Features
Print Method Serial Bubble Jet
Print Modes Highest (Custom Settings)  High, Standard, Draft
Max. Resolution 2400 x 1200 dpi
Interface

USB Interface
(USB 2.0 Standard)

1
(If the computer port, operating system, or USB cable does not support USB 2.0 High Speed 
Mode, you will not be able to use High Speed Mode.) *1

Network Interface 
(10base-T/100base-TX) Option*2

IEEE1394 Interface 
(IEEE1394.a standard) Option*2

Interface Connector

USB Interface: USB Standard Series B Receptacle
USB Interface Recommended Printer Cable:

Material: AWG28 or above
Type: Twisted-pair sealed cable (high speed mode compliant)
Length: max. 5.0 m (4.9 yd.)
Connector: USB Standard Series B Plug

IEEE1394 Interface (option): IEEE1394-1995 Standard 6-pin (without feed)
IEEE1394 Interface Recommended Printer Cable

Material: AWG28 (signal) AWG22 (power)
Type: Dual twisted pair shielded cable (100, 200, 400 Mbps mode compliant)
Length: max. 4.5 m (4.9 yd.)
Connector: IEEE1394-1995 Compliant 6-pin

Printhead Replaceable Printhead BC-1350
Nozzle gaps 1200 dpi (600 dpi x 2 lines)
Number of nozzles 1280 nozzles x 6 colors
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Replaceable Ink Tanks
Yellow Ink
Magenta Ink
Photo Magenta Ink
Cyan Ink
Photo Cyan Ink
Photo Black Ink*3

Matte Black Ink*3

Replaceable BCI-1451Y
Replaceable BCI-1431M
Replaceable BCI-1431PM
Replaceable BCI-1431C
Replaceable BCI-1431PC
Replaceable BCI-1431BK
Replaceable BCI-1451MBK

Ink type Pigment ink
Ink tank capacity 130 ml (each color)
Print Media
Media Width Range: 203.2 to 609.6 mm (min. to max.) 

Maximum length Roll: 18 m
Cut sheet: 1400 mm

Thickness 70 ~ 800 µm

Type

Plain Paper, CAD Plain Paper, Plain Paper (High Quality), Recycled Coated Paper, Coated Paper, 
Heavyweight Coated Paper, Premium Matte Paper, Extra Heavyweight Coated Paper, Glossy Photo Paper, 
SemiGlos Photo Paper, Heavyweight Glossy Photo Paper, Heavyweight SemiGlos Photo Paper, Synthetic 
Paper, Adhesive Synthetic Paper, Backlit Film, Flame-Resistant Cloth, Proofing Paper 2, Newsprint for 
Proofing*4 , Fine Art Photo, Fine Art Heavyweight Photo, Fine Art Textured, Canvas SemiGlos, Japanese 
Paper Washi, Colored Coated Paper, CAD Tracing Paper, CAD Translucent Matte Film, Special 1 to 5

Media Size and Print 
Area*5

Normal Size: Printable Area  Roll Paper: Top 5 mm, Bottom 5 mm, Left/Right: 5 mm
                                              Cut Sheet: Top 5 mm, Bottom 23 mm, Left/Right: 5 mm
        Guaranteed Print Area  Roll Paper:, Cut Sheet: Top 20 mm, Bottom 23 mm, Left/Right: 5 mm
Borderless Size:  Printable Area     Roll Paper: Top 0 mm, Bottom 0 mm, Left/Right: 0 mm
Oversize*6 :  Printable Area     Roll Paper:, Cut Sheet: Top 0 mm, Bottom 0 mm, Left/Right: 0 mm

Compatible Media 
Widths for Borderless 254.0mm, 355.6mm, 406.4mm, 515.0mm, 594.0mm, 609.6mm

Output Stacker Capacity 1 sheet
Main Unit
Power source AC100V ~ 240V 1.3A 50/60 Hz

Power Consumption 
(Operation)

Max. 160 W*7 (same as using Network Interface Board)
Sleep Mode: 100-115V: Less than 6W (same as using Network Interface Board)

220-240V: Less than 9W
Power off : Less than 1 W*8

W6400
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• These specifications are subject to change for improvements.
• The above specifications may vary for different operating environments.

Noise (Operation) Approximately 50 dB (A) or less (less than 6.5 Bels)
Ideal operating environment 15 ~ 30 °C (59 ~ 86 °F), 10 ~ 80 % RH with no condensation
Operating Environment 5 ~ 35 °C (41~ 95 °F), 10~90 % RH with no condensation
Dimensions (w x d x h)
Printer only 1,200 mm x 569 mm x 484 mm (47.3 in x 22.4 in x 19.1 in)
Printer + Stand 1,200 mm x 752 mm x 1,097 mm (47.3 in x 29.6 in x 43.2 in)
Weight (including printhead, ink tanks)
Printer only Approximately 40kg
Printer + Stand Approximately 49kg

*1. The following environment is required to use the High Speed mode of USB 2.0.
• Computer: A computer that supports USB 2.0 High Speed mode.
• OS: Windows Server 2003, Windows XP, or Windows 2000, or MacOS X Ver. 10.3.3 or later.
• USB 2.0 Driver: Microsoft USB 2.0 driver (you can obtain the Microsoft USB 2.0 driver from the Windows Update or

Service Pack).
• USB Cable: A USB cable certified for USB 2.0.
• Canon approved USB 2.0 interfaces (USB drivers confirmed for use with Microsoft operating systems):

• Adaptec USB 2.0 expansion card USB2CONNECT3100
• Adaptec USB 2.0 expansion card USB2CONNECT5100
• Adaptec USB 2.0 expansion card USB2CONNECT2000L
• Intel 845G chip set
• SiS SiS740 chip set
If you have any questions about a chip set listed above, please contact the manufacturer.

*2. One card can be installed, either the network interface board or the IEEE1394 board.
*3. Either Photo Black Ink or Matte Black Ink can be installed.
*4. Use the RIP software application (sold separately) to print on Newsprint for Proofing.
*5. Cannot use the Borderless Size or Oversize items to print on some media types and sizes.
*6. With Oversize selected, load roll media larger than the selected Media Size: roll media 10 mm wider and 10 mm taller,

a cut sheet 10 mm wider and 20 mm taller.
*7. This may differ with some optional boards installed.
*8. The printer consumes a small amount of electrical power, even while it is switched off. Unplug the printer from its pow-

er source to cut off power consumption completely.

W6400
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Basic Environmental Performance

W6400
Printer
Power Consumption (Operation)

Energy Save mode (Sleep Mode) 100-115V: Less than 6W (same as using Network Interface Board)
220-240V: Less than 9W

Power switch off (with power plug 
connected) Less than 1 W

Power Source Efficiency
Printer Weight Approximately 40.0kg
Dimensions (w x d x h) 1,200mm x 569mm x 484mm (47.3 in x 22.4 in x 19.1 in)
Recycling Exterior covers are technically certified as fully recyclable.
Product Safety

Content of Harmful Materials
Total Configuration: No special unburnable bromide materials (PBB, PBDE) used.
External Cover Plastic: No heavy metals (Pb, Hg, Cr (VI), Cd) or Halogen 
unburnable materials used.

Noise (Operation) Approximately 50 dB (A) or less (less than 6.5 Bels)
External Cover Material
Content of Heavy Metals (Pb, Hg, 
Cr (VI), Cd) Not Used (Packing Material)

Recycling All containers, packing material recyclable (from April, 2004)
Applicable Standards International Energy Star Program, VCCI (class B)
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Media You Can Use
A variety of media types and sizes can be used with this 
printer. The following media can be used with this printer. 

Important
Some media require more time for the ink to dry after 
printing. After printing please allow the ink to dry 
sufficiently before you handle it.
With some print media, the hue of some colors may 
change slightly when the ink on the surface of the 
media has dried completely.

Note
For details about how to handle and store print media, 
please refer to the instructions provided with the 
packet. 

The Suitable Black Ink for Media
Either one of two types of black ink can be used with this 
printer, Photo Black Ink or Matte Black Ink. The 
characteristics of these two types of ink are different and 
best suited for different types of media. Carefully select the 
type of black ink you want to use, based on the type of 
media you use and how often you use it.

Caution
If you print with the black ink that is not suited to the 
type of media, it may result in unsatisfactory printing 
and foul the media or printer with ink.

Important
To switch the type of black ink, execute Change Bk 
Ink Type on the printer operation panel and follow the 
instructions displayed. You can switch between the 
types of black ink, but please remember that every 
time you switch the black ink tanks the printer 
consumes about 45 ml of black ink and about 15 ml of 
the colored inks in total. (→ P.4-47)

Black Ink Types and Characteristics
Photo Black Ink (BIC-1431 Bk)
This ink is best for media like glossy and proof media 
with high-density black on a glossy surface. This ink 
can be used to print on most types of media including 
glossy paper.
Matte Black Ink (BIC-1451 MBk) 
This ink is best for black density on matte or fine art 
media, and even plain paper. Do not use matte black 
ink on media with a glossy surface. 
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Black Ink Characteristics

:Recommended ink, :Usable ink, :Unusable

Print
Application Media Type

Usable Ink Types
Photo 

Black Ink
Matte 

Black Ink

Photo

Glossy Photo Paper
SemiGlos Photo Paper
Heavyweight Glossy Photo Paper
Heavyweight SemiGlos Photo Paper 

Proof
Proofing Paper
Newsprint for Proofing

Generic

Plain Paper
Plain Paper (High Quality)
Recycled Coated Paper
Coated Paper
Heavyweight Coated Paper
Extra Heavyweight Coated Paper 
Colored Coated Paper

Art

Premium Matte Paper
Fine Art Photo
Fine Art Heavyweight Photo
Fine Art Textured
Canvas SemiGlos
Japanese Paper Washi 

Signs

Synthetic Paper
Adhesive Synthetic Paper
Backlit Film
Flame-Resistant Cloth

CAD
CAD Plain Paper
CAD Tracing Paper
CAD Translucent Matte Film 
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Paper Type
This section describes the types of media that you can use 
with this printer. To obtain the most recent information about 
usable media, contact the dealer where you purchased the 
printer or Canon service center.

The following items are described in the tables.

Note
For information about media, be sure to read the 
instructions provided with the media packet and 
contact the manufacturer of each media.

Media Type

Characteristics Describes the characteristics of each 
media.

Print 
Application Describes print jobs best suited for media.

Display

Indoors  : Indoors OK
 : Indoors NG

Outdoors

 : Outdoors OK
 : Outdoors NG

* Perform laminate 
processing before displaying 
outdoors.

Black Ink 
Suitability

Photo Black
 : Recommended
 : Possible
 : Not possible

Matte Black
 : Recommended
 : Possible
 : Not possible

Printer Driver 
Settings

Media Type Describes the Media Type 
setting in the printer driver.

Roll Paper 
Width

Width commercially available 
media

Borderless

 : Borderless Printing 
Possible

 : Left and Right 2-Edge 
Borderless Printing

 : Borderless Printing Not 
Possible

Auto Cut

 : Auto Cut Possible
*Borderless printing possible 
to all 4 edges.

 : Auto Cut Not Possible
*Borderless printing possible, 
only left to right edge.

Operation 
Panel Settings Media Type

Name of the media type to 
appear on the operation 
panel display

Printhead 
Optimum 
Height

L : Low position
M : Center position (Standard)
H : High position
* Press the Information button to display 
the appropriate height of the print head.

Comments Special notes and precautions are 
described here.
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Plain paper CAD Plain Paper

Characteristics

Superior yet economical ink-jet paper. Use 
for color prints in schools for research 
presentation, or monochrome prints for 
ceremonies, rallies, etc. It is low cost, so 
you can use it for test prints.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Plain paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Plain Paper

Printhead 
Optimum 
Height

M

Comments
You can use standard copy machine cut 
sheets (64~105 g/m2) in place of plain 
paper for the printer.

Characteristics Superior yet economical ink-jet paper.

Print 
Application CAD

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type CAD Plain Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type CAD Plain Paper

Printhead 
Optimum 
Height

L

Comments
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Plain Paper (High Quality) Recycled Coated Paper

Characteristics High white content makes this plain paper 
comparatively thick.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Plain Paper
(High Quality)

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Plain Paper HQ

Printhead 
Optimum 
Height

M

Comments

Characteristics Thin coated paper Ideal for line drawings, 
maps, presentation materials.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Recycled Coated 
Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Recycled Coated

Printhead 
Optimum 
Height

M

Comments
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Coated Paper Heavyweight Coated Paper

Characteristics Thin coated paper Ideal for line drawings, 
maps, presentation materials.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Coated Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Coated Paper

Printhead 
Optimum 
Height

M

Comments

Characteristics

Coated paper with a thick paper base. Use 
to print full-color images mainly consist of 
graphic images. Ideal for store POP, 
presentation materials, many other 
applications.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Heavyweight Coated 
Paper

Roll Paper Width 24”, A1, B2

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type HW Coated

Printhead 
Optimum 
Height

M

Comments
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Premium Matte Paper Extra Heavyweight Coated Paper

Characteristics

High-quality ultraheavyweight matte coated 
paper, the thickest of all Canon's genuine 
Matte Papers, which supports the widest 
range of color reproduction, This paper offers 
a soft texture free of reflective glare for a 
tranquil feel. Suitable for wide-ranging 
applications from Photo/Fine Art to Materials 
for Display such as High-Quality Poster/POP.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Premium Matte 
Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Premium Matte

Printhead 
Optimum 
Height

M

Comments

The standard cutter cannot be used to 
perform automatic cutting. After printing, 
cut the media manually. (→ P.2-34)
The borderless printing is performed on the 
left and right edges.

Characteristics
A heavy coating is added to this thick 
paper, making it ideal for handling as art 
material and a variety of textures.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Extra Heavyweight 
Coated Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Ex HW Coated

Printhead 
Optimum 
Height

M

Comments
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Glossy Photo Paper SemiGlos Photo Paper

Characteristics

A glossy photo paper, like that used to 
develop silver-halide photos. Ideal when 
you want high-quality finish for 
photographs. Processed with resin coat 
processing to prevent rippling and ensure 
a flat finish.

Print 
Application Photo

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Glossy Photo Paper

Roll Paper Width 24”, 14”, 10”, A1, B2

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Glossy Photo

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.

Characteristics

Subdues light reflected from its white 
surface to create a softer effect in its finish. 
The surface reflects little bright light, 
making it ideal for show panels, 
presentation materials, POPs, etc.

Print 
Application Photo

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type SemiGlos Photo 
Paper

Roll Paper Width 24”, 14”, 10”, A1, B2

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Sem-Gl Photo

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.
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Heavyweight Glossy Photo Paper Heavyweight SemiGlos Photo Paper

Characteristics

A glossy photo paper, like that used to 
develop silver-halide photos. Processed 
with resin coat processing to prevent 
rippling and ensure a flat finish. This thick 
paper is similar to the quality of silver 
halide photographs.

Print 
Application Photo

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Heavyweight Glossy 
Photo Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type HW Glossy Photo

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.

Characteristics

Subdues light reflected from its white 
surface to create a softer effect in its finish. 
The surface reflects little bright light, 
making it ideal for show panels, 
presentation materials, POPs, etc. This 
thick paper is similar to the quality of silver 
halide photographs.

Print 
Application Photo

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type
Heavyweight 

SemiGlos Photo 
Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type HW SemiGl Photo

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.
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Synthetic Paper Adhesive Synthetic Paper

Characteristics

A superior synthetic paper of 
polypropylene film for display posters. Can 
be used to display outdoors after 
laminating.

Print 
Application Signs

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Synthetic Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Syn. Paper

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.

Characteristics

An economical superior synthetic paper of 
polypropylene film for display posters. Can 
be used to display outdoors after 
laminating.

Print 
Application Signs

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Adhesive Synthetic 
Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Adh. Syn. Paper

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.
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Backlit Film Flame-Resistant Cloth

Characteristics

Printing is performed on the glossy, semi-
transparent surface of this film, then a 
projector light mounted behind the film 
makes the print surface more beautiful. 
Use indoors, outdoors as an electrical 
decoration or beautiful display 
applications.

Print 
Application Signs

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Backlit Film

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Backlit Film

Printhead 
Optimum 
Height

M

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.

Characteristics

This is indoor cloth that has superior 
durability and is flame resistant. Suitable 
for horizontal banners, tapestries, to create 
a good mood, or atmosphere.

Print 
Application Signs

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Flame-Resistant 
Cloth

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Flame-Res.Cloth

Printhead 
Optimum 
Height

M

Comments

The standard cutter cannot be used to 
perform automatic cutting. After printing, 
cut the media manually. (→ P.2-34)
The borderless printing is performed on the 
left and right edges.
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Proofing Paper Newsprint for Proofing

Characteristics

Can cover the color reproduction of offset 
printing for proofreading, thus achieving 
color tones close to those of the final print. 
Ideal for printers who need color output for 
proofing.

Print 
Application Proof

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Proofing Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Proofing Paper

Printhead 
Optimum 
Height

M

Comments

Characteristics

Best for Newsprint for Proofing. Texture 
almost the same as newsprint, and 
available in a wide variety of colors. Three 
main types of Newsprint Proof that are 
used in Japan are provided.

Print 
Application Proof

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Newsprint for 
Proofing 1~3

Roll Paper Width A1

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type

News Proof 1
News Proof 2
News Proof 3

Printhead 
Optimum 
Height

M

Comments Optional RIP software sold separately is 
required.
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Fine Art Photo Fine Art Heavyweight Photo

Characteristics
From portraits and landscapes to digital 
art, this media produces exceedingly high, 
composed quality.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Fine Art Photo

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Fine Art Photo

Printhead 
Optimum 
Height

M

Comments

The standard cutter cannot be used to 
perform automatic cutting. After printing, 
cut the media manually. (→ P.2-34)
The borderless printing is performed on the 
left and right edges.

Characteristics
From portraits and landscapes to digital 
art, this media produces exceedingly high, 
composed quality.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Fine Art
Heavyweight Photo

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type FneArt HW Photo

Printhead 
Optimum 
Height

M

Comments

The standard cutter cannot be used to 
perform automatic cutting. After printing, 
cut the media manually. (→ P.2-34)
The borderless printing is performed on the 
left and right edges.
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Fine Art Textured Canvas SemiGlos

Characteristics
For landscapes, watercolors, etc. this 
media reproduces exceedingly high, 
composed quality.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Fine Art Textured

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type FineArt Txtr

Printhead 
Optimum 
Height

M

Comments

The standard cutter cannot be used to 
perform automatic cutting. After printing, 
cut the media manually. (→ P.2-34)
The borderless printing is performed on the 
left and right edges.

Characteristics

Using polyester cloth as its base, this 
media creates a bold, unique feeling.
Ideal for output of artworks such as digital 
paintings, copies of oil paintings, etc.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Canvas SemiGlos

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Canvas Semi-Gl

Printhead 
Optimum 
Height

H

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.
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Japanese Paper Washi Colored Coated Paper

Characteristics

Ink jet printing and texture of traditional 
Japanese washi paper combine well.
This media is ideal for any type of artwork 
for a warm, calm presentation, including 
watercolors, ink drawings, Japanese 
paintings, Japanese style POPs, etc.

Print 
Application Art

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Japanese Paper 
Washi

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type JPN Paper Washi

Printhead 
Optimum 
Height

M

Comments

Characteristics
Ideal for price POPs at drugstores and 
other retail outlets. Covered on both sides 
with high-impact yellow.

Print 
Application Generic

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type Colored Coated 
Paper

Roll Paper Width 24”

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type Colored Coated

Printhead 
Optimum 
Height

M

Comments
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CAD Tracing Paper CAD Translucent Matte Film

Characteristics
Tracing paper that can be used for color 
printing, and ideal for CAD plans and 
drawings.

Print 
Application CAD

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type CAD Tracing Paper

Roll Paper Width 24”, A1

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type CAD Trace Paper

Printhead 
Optimum 
Height

L

Comments

Characteristics
A translucent film for CAD designs (line 
drawings). Superior, stable dimensions, for 
master plans and other high-quality output.

Print 
Application CAD

Display Indoors
Outdoors

Black Ink 
Suitability

Photo Black
Matte Black

Printer Driver 
Settings

Media Type CAD Translucent
Matte Film

Roll Paper Width A1

Borderless Printing
Auto Cut

Operation 
Panel Settings Media Type CAD Matte Film

Printhead 
Optimum 
Height

L

Comments
After cutting trimming paper, pre-cut paper, 
or other such media, remove the sheet 
manually.
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Media Size
The table below lists the media sizes and feeding methods that can be used with this printer.

Roll Media
This table lists roll media with maximum diameters of 150 mm (5.1 in.), media core inside diameter of 2 or 3 inches.

Width Size Name in Printer Driver*1 BorderlessPrinting*2

Non-category 24”
609.6 mm (24 in.) ARCH D, ARCH C, 20” x 24”

ISO A1
594.0 mm (24 in.) ISO A1, ISO A2

JIS B2
515.0 mm (20.28 in.) JIS B2, JIS B3

ISO A2
16.54-in. Roll (420.0 mm) ISO A2, ISO A3

Non-category 16”
406.4 mm (16 in.) US Photo

Non-category 14”
355.6 mm (14 in.) ANSI Legal

ISO A3
297.0 mm (11.69 in.) ISO A3, ISO A4

Non-category 10”
254.0 mm (10 in.) 10” x 15”, 10” x 12”, 8” x 10”

*1. Borderless printing is possible with Custom Settings using the widths of the media
above.

*2. Media Types that can be used for borderless printing are: Heavy Coated Paper, Pre-
mium Matte Paper, Extra Heavyweight Coated Paper, Glossy Photo Paper, SemiG-
los Photo Paper, Heavyweight SemiGlos Photo Paper, Fine Art Photo, Fine Art
Heavyweight Photo, Fine Art Textured, Flame-Resistant Cloth, Special 1 to 5. How-
ever, Premium Matte Paper, Flame-Resistant Cloth and Fine Art cannot be cut auto-
matically. After printing, cut the media manually. (→ P.2-34)



2- 19

Media You Can Use
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Cut Sheet
Cut sheets up to 606.9 mm wide (listed below) can be 
used.

Size (Width) Dimensions

ISO A1 594.0 x 841.0 m (23.39 x 33.11 in.)

ISO A2 420.0 x 594.0 mm (16.54 x 23.39 in.)

ISO A3+ 329.0 x 483.0 mm (12.95 x 19.02 in.)

ISO A3 297.0 x 420.0 mm (11.69 x 16.54 in.)

ISO A4 210.0 x 297.0 mm (8.27 x 11.69 in.)

ISO B2 500.0 x 707.0 mm (19.69 x 27.83 in.)

ISO B3 353.0 x 500.0 mm (13.90 x 19.69 in.)

ISO B4 250.0 x 353.0 mm (9.84 x 13.90 in.)

JIS B2 515.0 x 728.0 mm (20.28 x 28.66 in.)

JIS B3 364.0 x 515.0 mm (14.33 x 20.28 in.)

JIS B4 257.0 x 364.0 mm (10.12 x 14.33 in.)

ANSI D 558.8 x 863.6 mm (22 x 34 in.)

ANSI C 431.8 x 558.8 mm (17 x 22 in.)

ANSI B 279.4 x 431.8 mm (11 x 17 in.)

ANSI B Super 330.2 x 482.6 mm (13 x 19 in.)

ANSI Letter 215.9 x 279.4 mm (8.5 x 11 in.)

ANSI Legal 215.9 x 355.6 mm (8.5 x 14 in.)

ARCH D 609.6 x 914.4 mm (24 x 36 in.)

ARCH C 457.2 x 609.6 mm (18 x 24 in.)

ARCH B 304.8 x 457.2 mm (12 x 18 in.)

ARCH A 228.6 x 304.8 mm (9 x 12 in.)

DIN C2 458.0 x 648.0 mm (18.03 x 25.51 in.)

DIN C3 324.0 x 458.0 mm (12.76 x 18.03 in.)

DIN C4 229.0 x 324.0 mm (9.02 x 12.76 in.)
Poster 
20” x 30” 508.0 x 762.0 mm (20 x 30 in.)

20” x 24” 508.0 x 609.6 mm (20 x 24 in.)

18” x 22” 457.2 x 558.8 mm (18 x 22 in.)

14” x 17” 355.6 x 431.8 mm (14 x 17 in.)

10” x 15” 254.0 x 381.0 mm (10 x 15 in.)

10” x 12” 254.0 x 304.8 mm (10 x 12 in.)

8” x 10” 203.2 x 254.0 mm (8 x 10 in.)

US Photo 406.4 x 508.0 mm (16 x 20 in.)

Size (Width) Dimensions
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Original data the same as the media
In addition to the normal media sizes, there are borderless 
sizes and oversizes. The size of the printable areas, actual 
settings, and actual printing areas are different for these 
sizes. Select a size that matches your needs.

Note
To display Oversize, click the Size Options button on 
the Page Setup sheet, then under Display Series 
select Oversize. 

Normal Size:
Achieves a printout that is the same size as the media. 
This can be used with all media sizes and media types. 
The printout has top, bottom, left, and right margins, and 
images with margins can be trimmed.

Roll Media

Printable 
Paper Size

Standard sizes from 24”, ISO A1, JIS B2, 
ISO A2, 16”, 14”, 10”, and Custom Sizes of 
the above widths.

Printable 
Media Types All media types 

Printable Area

Printing possible inside the area 5 mm in 
from the top, bottom, left and right margins.

Media to Load

Same size as the Media Size or wide roll 
paper.

Print Data and 
Results

Data created the same size as Media Size.

5 mm5 mm

5 mm

5 mm
Print Area

 Media Size

Media Size
Roll Media
Size to
Load

Original data the
same as the media Print Results
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Cut Sheets
Important
The print quality or the precision of line feed may 
deteriorate at the top margin of the media, or the 
surface of the print may appear scratchy. Also, ink may 
stick to the top and bottom edges. If the printhead is 
scratching the surface of the media, raise the 
printhead to a higher position. (→ P.2-40)
When loading cut sheets that are longer than 914 mm 
(36”), the trailing edge of the sheet will touch the floor 
and may become dirty. Before such a long cut sheet, 
before you start the print job remove the roll holder and 
spread a cloth or some paper on the floor, or when the 
cut sheet starts to feed tuck the trailing edge into the 
output stacker. (→ P.2-39)

Printable 
Media Size

ARCH D to 8 x 10 Standard Sizes, and 
203.2 x 203.2 mm to 609.6 x 1400 mm 
Custom Sizes

Printable Type All media types

Printable Area

Printing possible inside the area 5 mm in from the top, left and 
right area margins, and 23 mm in from the bottom margin.

Media to Load

Data created the same size as cut sheet.

Print Data and 
Results

Data created the same size as Media Size.

5 mm5 mm

5 mm

23 mm
Print Area

Media Size

Media Size

Cut Sheet
Size to
Load

Original data the
same as the media Print Results
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Borderless Printing
With borderless printing sizes, printing is done from edge 
to edge without leaving any margins. Borderless printing 
is limited to roll media, and there are limitations on the 
roll width and type of media that can be used. Also, the 
range of images that can be printed is different for some 
printing methods. For more details about borderless 
printing, please refer to Chapter 3 “Printing Photos and 
Illustrations without Borders (Borderless Printing)” 
(→ P.3-13) (→ P.3-77).

Roll Media

Printable 
Paper Size

24”, ISO A1, JIS B2,16”,14”, 10” Standard 
Sizes and Custom Sizes of the same 
width.

Printable Type

Heavy Coated Paper, Extra Heavyweight 
Coated Paper, Glossy Photo Paper, 
SemiGlos Photo Paper, Heavyweight 
Glossy Photo Paper, Heavyweight 
SemiGlos Photo Paper, Fine Art Photo, 
Fine Art Heavyweight Photo, Fine Art 
Textured, Flame Resistant Cloth, Special 1 
to 5

Printable Area

Allowed Printing Area of Media Size

Media to Load

Data created the same width as roll paper.

0 mm0 mm

0 mm

0 mm
Print Area

Media Size

Media Size

Roll Media
Size to
Load
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Oversize
With Oversize you can print over the entire surface of the 
media. This is possible with all media types. When you 
use Oversize to print, you must load media that is larger 
than the Media Size. Also, the margins are attached 
beyond the media size.

Note
To display Oversize click the Size Options button on 
the Page Setup sheet, then under Display Series 
select Oversize. 

Roll Media

P
rin

t D
at

a 
an

d 
R

es
ul

ts

Scale to fit 
the Page 
Size 
(Example)

Data created the same size as Media Size.

Scale to fit 
Roll Paper 
Width 
(Example)

Create data of any size.

Print 
Image with 
Actual Size 
(Example)

Create data larger by 3 mm at the top, 
bottom, left, and right margins.

Original data the
same as the media

Printed slightly
enlarged
automatically

Print Results

Original data
of desired size

Enlarge/Reduce
 to Fit Roll Paper

 Width 

Print Results

Original data 3 mm larger
than the media size at the

top, bottom, left, right margins.
Print Results

Print
actual size

Printable 
Paper Size

ISO A1 to Photo 8 x 10 Standard Sizes
Width 100.0 to 599.6 mm Custom Size

Printable Type All media types

Printable Area

Allowed printing surface area of media size

0 mm0 mm

0 mm

0 mm
Print Area

Media Size
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Important
The end edge of the roll media can disrupt a print job 
as it comes off the roll. Try to avoid printing in the area 
near the end edge of a roll.

Cut Sheets

Media to Load

Roll Media more than 10 mm wider than 
the media size.

Print Data and 
Results

Data created the same size as media size.

Media Size

Roll Media
Size to
Load

Original data the
same as the media Print Results

Actual
size full

coverage
print

Printable 
Paper Size

Standard ISO A1 to Photo sizes, and 203.2 
x 203.2 mm to 599.6 x 1400 mm Custom 
Sizes

Printable 
Media Types All media types

Printable Area

Allowed printing surface area of media size

Media to Load

Cut sheets more than 10 mm wider and 29 
mm more than longer than the media size.

0 mm0 mm

0 mm

0 mm
Print Area

Media Size

Media Size

Size of
loaded
cut sheet
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Important
You cannot use ARCH D and other sizes wider than 
599.6 mm to print for Oversize.

Handling Paper and Other Print Media
For details about how to handle and store print media, 
please refer to the instructions provided with the media.

Print Data and 
Results

Data created the same size as media size.

Original data the
same as the media Print Results

Actual
size full

coverage
print
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Printing with Rolls

Loading Roll Media
This is the general procedure for loading roll media.

�After printing, remove the completed printout and any 
media loaded on the platen. (→ P.2-33, P.2-39)

�On the operation panel, select the roll media source.
 (→ P.2-26)

�Load the roll media in the roll holder slot. (→ P.2-27)

�Load the roll media on the platen. (→ P.2-30)

�On the printer operation panel, select the media type.
 (→ P.2-30)

�Adjust the amount of media feed. (→ P.4-42)

�Start the print job from the computer. (→ P.1-40)

Important
Make sure that the printer is switched on before you 
load roll media. If the loaded media does not match the 
media type, this can affect the quality of printing.

Selecting the Paper Source
When printing on roll media, select roll media as the 
paper source on the operation panel.

1 Press and hold the Paper Source button for 
1 second or more to light the Roll Media 
lamp.
Pressing the Paper Source button alternates the 
selection between Roll Media and Cut Sheet.

When a cut sheet is loaded, the printer will display 
Remove CutSheet?.

When another roll media is loaded, hold down the 
Stop button for more than 1 sec., to display Remove 
RllMedia?.

2 If either a cut sheet or roll media is loaded in 
the printer, press the OK button. 

Remove either the cut sheet or the roll media.
 (→ P.2-33, P.2-39)

Remove RllMedia?
Press OK/Stop

Data
Information Power

Offline
Menu

Message
Offline
               Feed Papre

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Loading the Roll Media
Follow this procedure to set a roll in the roll holder. First, 
if there is a cut sheet or an ejected printed sheet on the 
platen, remove it.

Important
When you are printing a banner or other long printout, 
the printed media may touch the floor and become 
dirty. Before starting the print job, cover the floor with a 
clean cloth or some paper.

Note
Since the platen may be fouled with ink, clean inside 
the upper cover before you switch to printing on a 
large size. (→ P.4-11)
For more details about media that can be set in the roll 
holder, please refer to “Media You Can Use” (→ P.2-2).

1 If there is roll media remaining in the printer, 
push the release lever to the rear to open, 
rotate the roll holder toward the rear to take 
up the remaining paper, then remove the roll.

2 Lower the holder stopper release lever (a) to 
release the lock, remove the holder stopper, 
then remove the roll from the holder.

Important
Store unused roll media in its original package. Store 
the package in a cool, dry location that is not exposed 
to direct sunlight.

a
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3 With the edge of the roll media up and 
pointing in, insert the shaft of the roll holder 
into the roll from the left side until it is all the 
way in and stops.

Caution
Lay the roll holder horizontally onto a table or desk. 
Roll media are heavy and can cause personal injury if 
they drop.

Important
If the edge of the roll paper is not straight, take up the 
roll paper until the edge is straight then set it. This 
could cause poor paper feed.

Press the roll holder onto the end of the roll until it is 
completely inserted. Make sure there is no gap (a gap 
can cause poor feeding).

4 Attach the holder stopper to the right side of 
the roll holder and insert it until it contacts the 
core of the roll, then push the holder stopper 
lever (a) over toward the shaft to lock it.

The roll media is locked in place by the roll holder.

Important
If the leading edge of the roll media is not straight, or if 
it is marked by dirt or tape, this could cause poor 
feeding and lead to poor print quality. In such a case, 
cut the leading edge of the roll media in a straight line 
before setting the roll holder in the printer. 
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5 Hold the ends of the roll media with the roll facing 
the printer (as shown in the illustration), then align 
and set the ends of the roll holder (b) into the 
guide grooves (c) of the roll holder slots.
If the roll paper is slack and its edge is not straight, 
take up the roll slack until the edges are straight then 
set it.

6 Push the release lever toward the rear to 
open it, then pull out the roll media evenly 
and insert it into the feed slot (d) and feed it 
in until you hear the suction sound of the 
vacuum.

As soon as you insert the edge as far as the top of 
the platen, you will hear the printer start the vacuum 
automatically.

Important
When you pull out the sheet, be careful to avoid 
touching the printing surface of the paper. Touching 
the print surface could cause poor print quality.
If you see the media is wrinkled or curled, remove the 
wrinkles or curls before loading the media.
If media does not feed easily through the feed slot (d) 
insert the edge skewed to the left or right corner, then 
and then feed it in until it is parallel.

Note
The strength of the vacuum suction can be adjusted 
while the release lever is open. If the media is difficult 
to load, on the printer operation panel press [�] 
(stronger) or [�] (weaker) to adjust the strength of the 
suction.

7 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.

d
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8 While gently pulling out the center of the 
leading edge (e) of the roll media, align the 
right edge of the media so it is parallel to 
guideline (f), then pull the release lever to the 
front to close it.

Important
Do not pull strongly the roll media when you align it 
with the guideline. The roll media may not feed out 
straight in some cases.

9 Raise the upper cover stopper to release the 
lock then close the upper cover.

Media Type is displayed.

10 Press [�] or [�] to select the loaded media 
type, then press OK.

The (=) mark to the left of a setting indicates that roll 
media type is currently selected, then the 
preparation for the select media begins.

The table below lists the settings for the media 
types. Only the types of media that can be used with 
the black ink tank installed in the printer are 
displayed.f

e

Media Type
HW Coated

Media Name Media Type Setting
Plain Paper Plain Paper
CAD Plain Paper CAD Plain Paper
Plain Paper (High Quality) Plain Paper HQ
Recycled Coated Paper Recycled Coated
Coated Paper Coated Paper
Heavyweight Coated Paper HW Coated
Premium Matte Paper Premium Matte
Extra Heavyweight Coated 
Paper Ex HW Coated

Glossy Photo Paper Glossy Photo
SemiGlos Photo Paper Semi-Gl Photo
Heavyweight Glossy Photo 
Paper HW Glossy Photo

Heavyweight SemiGlos 
Photo Paper HW SemiGl Photo

Synthetic Paper Syn. Paper
Adhesive Synthetic Paper Adh. Syn. Paper
Backlit Film Backlit Film
Flame-Registrant cloth Flame-Res.Cloth
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Important
Make sure that you have selected the correct setting 
for the media type. If you have selected an incorrect 
setting for the media type, do the procedure in 
“Selecting the Media Type” (→ P.2-32).
As soon as each sheet is printed, remove it from the 
output stacker.

Note
If a message appears in the display after loading roll 
paper, the operation panel lamp flashes. 
Before shipping a printer, the Media Type is set for 
Plain Paper. Or, when the release lever is opened and 
closed, the media type setting is reset automatically to 
Plain Paper.
The media size is detected automatically, therefore no 
setting for the size is required.

In order to align the leading edge correctly when the 
roll media is replaced with a new one, the media is fed 
and then cut the correct amount for the type of media. 
Also, if a barcode is printed on the media, the portion 
where the barcode is will be cut off after the barcode is 
read.

11 If a new roll without barcodes is loaded in the 
printer while the paper remains function is 
enabled, press [�] or [�] to select the 
length of roll then press the OK button.
If you have set a roll with media remaining barcodes 
printed, the amount of media remaining is detected 
automatically so you do not have to select it.

After a few seconds, Online appears on the display 
and the printer is ready to print.

12 If the output assist guides are not extended, 
pull it out.

Important
The output assists guides should always be extended 
for printing. If they are not extended, this could lead to 
poor print quality.

Proofing Paper Proofing Paper 2
Newsprint for Proofing News Proof/1/2/3
Fine Art Photo FineArt Photo
Fine Art Heavyweight Photo FneArt HW Photo
Fine Art Textured FineArt Txtr
Canvas SemiGlos Canvas Semi-Gl
Japanese Paper Washi JPN Paper Washi
Colored Coated Paper Colored Coated
CAD Tracing Paper CAD Trace Paper
CAD Translucent Matte Film CAD Matte Film
Special 1~5 Special 1~5

Media Name Media Type Setting

Media Length
 30.00 m
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Selecting the Media Type
When you are using the printer with media loaded, you 
must use the printer operation panel to select the type of 
media loaded. If the type of print media is not suitable, 
you may not be able to achieve the desired results. Fol-
low the procedure below if the media type selection does 
not match the type of media loaded in the printer.

1 Press the Online button to display MAIN 
MENU.

2 Press [�] or [�] to select Media Type, 
then press [�].

3 Press [�] or [�] to select the name of the 
media type then press OK.

An equals sign (=) displays on the left to indicate the 
media type is set.

Important
In order to achieve the best printing results with this 
printer, the amount of feed is fine adjusted for each 
type of media. For this reason, the image size, 
margins, and other settings change for each media 
type.
When you select another media type, you should also 
adjust the feed amount (→ P.4-42) and “Adjusting the 
Height of the Printhead” (→ P.2-40).

MAIN MENU
Media Type ↓

Media Type
 HW Coated

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Removing a Roll
Follow the procedure below to remove a loaded roll or when 
the media cannot be cut automatically. Or, if you are 
printing on a media with the Eject Cut item of Media 
Configuration Tool (→ P.3-58) (→ P.3-127) set to Required, 
perform the same procedure when you see Cut by Stop 
Key after printing finishes.

Important
When the roll media remaining detection function is 
on, you must follow a strict procedure to remove a roll. 
If you open the release lever and remove the roll 
before the media remaining bar code prints, the printer 
will lose its ability to monitor the amount of media 
remaining on the roll.
After removing a roll from the printer, store it in its 
original vinyl bag. When you print on roll media that 
has not been properly stored, the surface of the media 
may chafe or the print quality may be poor.

1 Hold down the Stop/Eject button for at least 
1 second.

2 Press the OK button.

For the media when the Standard Cutter 
operation is set to Enable:

1. If the paper remains function is switched on for 
the roll media, a barcode is printed on the 
leading edge of the roll.

2. The roll is ejected at the back of the printer.

Important
Even if the roll paper remains function is on, if you 
open the release lever without pressing the Stop/Eject 
button the barcode does not print. In such a case, the 
roll remains function cannot be done with that roll.

Remove RllMedia?
Press OK/Stop

Online
Bk

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

P l a i n  P a p e r X Xｍ
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If the printer cannot perform automatic cutting with 
the media:

1. Press the Online button to set the printer 
offline.

2. Press the [�] button (not longer than 0.8 sec) 
to feed the media 330 mm.

3. Cut along the cutting-line with a pair of scissors.

4. Hold down the [�] button on the printer 
operation panel for more than 1 sec. until you 
see Feed Limit.. on the display. The roll media 
reverse feeds 300 mm and stops automatically.

5. Press the Online button to set the printer 
offline.

Important
If the printer receives new print data before this 
operation is performed, printing will continue.
Cut exactly along the cut-line. The printer may not be 
able to perform continuous printing if you cut at a 
position more than 30 mm away from the cut-line.

For Heavyweight Glossy Photo Paper, 
Heavyweight SemiGlossy Photo Paper, Backlit 
Film, CAD Translucent Matte Film:

The printer stops after printing to protect the 
printing surface. To prevent the printouts from 
falling into the output stacker, support the printout 
with your hand and press the Stop/Eject button to 
perform the cut.

Important
If the ink drying time has been set, you will not be able 
to perform cutting with the Stop/Eject button until the 
prescribed drying time has elapsed.

3 Rotate the roll holder backward to take up 
excess media and remove it.
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Printing with Cut Sheets

Loading Cut Sheets
To print on the cut sheet, follow the procedure below.

� If there is a cut sheet in the printer, remove it. 
(→ P.2-33, P.2-39)

�On the printer operation panel, select cut sheet as the 
paper feed source. (→ P.2-35)

�Place the cut sheet on the platen. (→ P.2-36)

�On the printer operation panel, select the media type.
(→ P.2-38)

�Adjust the amount of media feed. (→ P.4-42)

�Start the print job from the computer. (→ P.1-40)

Important
You must make sure that the printer is switched on 
before loading a cut sheet. Also, if the loaded sheet 
does not match the media type selected on the 
operation panel, this could cause a media loading 
error or lead to poor print quality.

Note
Store unused cut sheets in the original package. Store 
the package in a cool, dry location that is not exposed 
to direct sunlight.

Selecting the Paper Source
When printing on the cut sheet, with the operation panel 
select cut sheet as the media source.

1 Press and hold the Paper Source button for 
1 second or more to light the Cut Sheet 
lamp.
Pressing Paper Source alternates the selection 
between Roll Media and Cut Sheet.

When a roll is loaded, the printer will display 
Remove RllMedia?
When another cut sheet is loaded, hold down the 
Stop button for more than 1 sec., to display Remove 
CutSheet?.

2 If either a cut sheet or roll media is loaded in 
the printer, press the OK button.

Remove either the cut sheet or the roll media.
 (→ P.2-33, P.2-39)

Remove RllMedia?
Press OK/Stop

Data
Information Power

Offline
Menu

Message
Offline
               Feed Papre

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Loading Cut Sheets
Follow this procedure to set a cut sheet on the platen. 
First, if there is a cut sheet on the platen, remove it.

Important
When loading cut sheets that are longer than 914 mm 
(36”), the trailing edge of the sheet will touch the floor 
and may become dirty. When you set such a long cut 
sheet, before you start the print job remove the roll 
holder and spread a cloth or some paper on the floor, 
or when the cut sheet starts to feed, tuck the trailing 
edge into the output stacker.

Note
The platen may be fouled with ink so clean inside the 
upper cover before you switch to printing on a large 
size. (→ P.4-11)
For more details about cut sheets that can be set on 
the platen, please refer to “Media You Can Use” (→ 
P.2-2).
The printhead may rub the surface of the curled media, 
so try to correct the curl.

1 Open the upper cover and push the release 
lever toward the rear.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.
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2 With the print side of the cut sheet facing up, 
insert and press down parallel on the sheet 
holder, making sure it is aligned with the line 
(a) on the right and the orange line (b) at the 
back.

When the cut sheet is inserted, the printer grabs it 
and holds it on the platen.

Important
Set a cut sheet parallel with the guideline on the right 
side of the platen. If the cut sheet is skewed, this will 
cause a skew error. If the error occurs, set the cut 
sheet once again so it is aligned correctly.

Note
The strength of the vacuum suction can be adjusted 
while the release lever is open. If the media is difficult 
to load, on the printer operation panel press [�] 
(stronger) or [�] (weaker) to adjust the strength of the 
suction.

The platen of this printer is provided with holes through 
which air is sucked to create the vacuum that holds the 
paper on the platen. You may hear a sound from the 
location where the paper is set; this is normal and 
does not mean any problem.
If you are concerned about the noise, shift the position 
of the paper about 1mm to the left or right (but not 
more than 1 mm).

3 Pull the release lever forward to close, raise 
the upper cover stopper and release the 
lock, then close the upper cover.

Media Type is displayed.

b a
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4 Press [�] or [�] to select the name of the 
media type then press OK.

The (=) mark to the left of a setting indicates that cut 
sheet type is currently selected, then the preparation 
for the select media begins.

The printer detects no skew and if there is no 
problem, then the printer enters the print standby 
mode.

The table below lists the possible settings for the cut 
sheet type. Only the settings of the type of media 
that can be used with the type of black ink tank 
mounted in the printer are displayed.

Important
If the cut sheet is skewed, this will cause a skew error. 
If a skew error occurs, start at Step 1 and set the cut 
sheet again.
Make sure that you have selected the correct setting 
for the media type. If you have selected an incorrect 
setting for the media type, perform the procedure in 
“Selecting the Media Type” (→ P.2-32) 
As soon as each sheet prints, remove it from the 
output stacker.

Note
Before shipping a printer, the Media Type is set for 
Plain Paper. Also, when the release lever is opened 
and closed, the media type setting is reset 
automatically to Plain Paper.
The media size is detected automatically, therefore no 
setting for the size is required.

Media Type
 HW Coated →

Media Name Media Type Setting
Plain Paper Plain Paper
CAD Plain Paper CAD Plain Paper
Plain Paper (High Quality) Plain Paper HQ
Recycled Coated Paper Recycled Coated
Coated Paper Coated Paper
Heavyweight Coated Paper HW Coated
Premium Matte Paper Premium Matte
Extra Heavyweight Coated 
Paper Ex HW Coated

Glossy Photo Paper Glossy Photo
SemiGlos Photo Paper Semi-Gl Photo
Heavyweight Glossy Photo 
Paper HW Glossy Photo

Heavyweight SemiGlos 
Photo Paper HW SemiGl Photo

Synthetic Paper Syn. Paper

Adhesive Synthetic Paper Adh. Syn. Paper
Backlit Film Backlit Film
Flame-Resistant cloth Flame-Res.Cloth
Proofing Paper Proofing Paper 2
Newsprint for Proofing News Proof 1/2/3
Fine Art Photo FineArt Photo
Fine Art Heavyweight Photo FneArt HW Photo,
Fine Art Textured FineArt Txtr
Canvas SemiGlos Canvas Semi-Gl
Japanese Paper Washi JPN Paper Washi
Colored Coated Paper Colored Coated 
CAD Tracing Paper CAD Trace Paper
CAD Translucent Matte Film CAD Matte Film
Special 1~5 Special 1~5
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5 If the output assist guides are not extended, 
pull it out.

Important
The output assists guides should always be extended 
for printing. If they are not extended, this could lead to 
poor print quality.

Removing a Cut Sheet
Follow the procedure below to remove a cut sheet from the 
printer.

1 Hold down the Stop/Eject button for at least 
1 second.

2 Press the OK button.

The loaded cut sheet is ejected at the front and then 
rests on the platen.

3 While holding the media, push the release 
lever back to open then remove the media.

4 Pull the release lever forward to close it.

Remove RllMedia?
Press OK/Stop

Online
Bk

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Adjusting the Height of the Printhead
It is possible to achieve the higher print quality by adjusting 
the height of the printhead. Follow the procedure below to 
operate.

�Adjust the height of the printhead. (→ P.2-40)

�Set a cut sheet of the type you intend to use.
 (→ P.2-26, P.2-35)

�Adjust the position of the printhead. (→ P.4-40)

�Start the print job from the computer. (→ P.1-40)

�After completing the special print job, return the 
printhead height to its original setting and re-align the 
printhead. (→ P.2-42)

Important
After changing the height of the printhead, always 
adjust the print mode. If you do not perform the 
adjustments, you cannot achieve the best print results.
When printing on paper-base media (ex: Coated 
Paper, Plain Paper) or any type of media that wrinkles 
easily, never print with the printhead lower than the 
best height for each media. This could also damage 
the printer.

Note
Press the Information button to display Head Height 
and the current printhead height to confirm that the 
setting correct for the media in use.

Adjusting Printhead Height

1 Press the Online button to display MAIN 
MENU.

2 Press [�] (or [�]) to select Chng Head 
Hght then press [�].

3 Press [�] or [�] to select Yes, then press 
OK button.

The carriage moves to the center when you see 
Carriage Moving.

Chng Head Hght
= Yes

Data
Information Power

Offline
Menu

Message
Offline
              Feed Paper

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Data
Information Power

Offline
Menu

Message
MAIN MENU
Chng Head Hght

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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4 Open the upper cover when you see Open 
UpperCover, then Chng Head Hght is 
displayed.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.
If the printhead height adjustment lever is dirty, before 
continuing with this procedure, wring out a damp cloth 
and use it to clean the printhead height adjustment 
lever. (→ P.4-11)

5 Adjust the height of the printhead with the 
printhead height adjustment lever. 
When printing on CAD Plain Paper, CAD Tracing 
Paper, CAD Translucent Matte Film, set the lever to 
the low position (a), when printing on Canvas 
SemiGlos set the lever to the high position (c), and 
for all other media set the lever to the middle (b) 
(standard). If the printhead is scratching the surface 
of media that ripples or wrinkles easily, rather than 
use the recommended printhead height for that 
media, set the lever one step higher.

6 Raise the upper cover stopper to release the 
lock then close the upper cover.

The carriage returns to the home when you see 
Carriage Moving. The printer returns to the print 
ready status.

c

b

a
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Aligning the Printhead
After the printhead height has been adjusted, on the printer 
operation panel adjust select Auto Head Adj. > Standard 
Adj. to adjust the printhead.“Aligning the Printhead”
(→ P.4-40)

Re-adjusting Printhead Height
After the print job is finished, especially before starting the 
next print with another type of media, you must do the 
procedure to reset the printhead height adjustment lever to 
the optimum position for the next media.
 “Adjusting Printhead Height” (→ P.2-40)

After re-adjusting the printhead height position, you should 
once again use the operation panel to align the printhead. 
“Aligning the Printhead” (→ P.4-40)
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Printing from Windows
This printer driver provides a variety of printer functions to 
meet your printing needs. In this chapter we will introduce 
these functions. 

Before You Begin
There are some functions you should remember and use 
when you use this printer. Before you use the printer for 
different printing tasks, please read this section. 

Basic Settings to Meet Your Needs (Type 
of Printing) 
To achieve the best printing, you must adjust the color and 
other settings for the objective of the document. This printer 
driver provides superior settings frequently used to produce 
posters, POP ads, digital camera prints, CAD designs, and 
other prints. Just select from the list the type of document 
you need and perform the basic procedure for the print job. 
The following applications are provided for the types of 
prints shown below. 

Type of Printing Content
Setting Values

Paper Type Print 
Quality

Matching
Method Color Adjustment

Default
Settings

Best for printing normal 
documents, with text, images, 
graphics, etc. mixed together.

Plain Paper Standard Auto Default

POP Ad
Best for printing mixed text 
and illustrations with bright 
and forceful eyecatching such 
as store posters.

Heavyweight Coated 
Paper Standard Saturation Contrast: +5

Poster Best for printing posters with 
centered photographs.

Proofing Paper *1
Heavyweight Coated 

Paper *2
Standard Auto Contrast: +10 

Brightness: +5

Photo 
(from digital 
camera)

Best for printing photos 
captured with a digital 
camera.

Glossy Photo Paper *1
Heavyweight Coated 

Paper *2
Standard

Perceptual 
(Photo

graphic)
Contrast: +10 
Brightness: +5

Photo (from 
scanner)

Best for reproduction of scanned 
photographs with color faithful to 
the quality of the original.

Glossy Photo Paper *1
Heavyweight Coated 

Paper *2
Standard Colorimetric Default
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Note
For more details about print quality, please refer to 
“Custom Print Quality” in “Customizing Print Quality”. 
(→ P.3-39)
For more details about color mode matching and color 
adjustments, please refer to “Fine Adjusting Color for 
Printing” in “Adjusting Color” (→ P.3-42) see “Color 
Matching” (→ P.3-46).

To perform the settings for a print, first open the Main 
sheet of the printer driver and then from Print Prefer-
ences select the type of printing that you want to per-
form. 

Long Formats 
(Banner) 

Best for long banner formats 
(vertical and horizontal) with 
mixed illustrations and text.

Heavyweight Coated 
Paper Standard Saturation Contrast: +10 

Brightness: +5

CAD Best for plans and design 
drawings with fine lines. CAD Plain Paper Standard Saturation Default

*1. Photo Black Ink (BK) is the black ink tank type mounted in the printer.
*2. Matte Black Ink (MBK) is the black ink tank type mounted in the printer.

Type of Printing Content
Setting Values

Paper Type Print 
Quality

Matching
Method Color Adjustment
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Note
The item in the list marked by the red ball contains the 
settings that the printer is already set up to execute. 
You can use the Add and Edit buttons to add and edit 
the printing types. For more details, refer to Using a 
Print Preference > Adding a Print Preference, or 
Editing a Print Preference in the online Help.

Printer Driver Settings at a Glance 
(Settings Preview) 
The Preview illustrates the content of the current printer 
driver settings. If you change the page size and orienta-
tion, feed method, etc., you can confirm their immediate 
effect easily by viewing the effect of the new settings in 
the Preview image. 

The Preview reflects changes in the settings described 
below. 

A

B

C

Setting Preview Description

A
The following settings are shown in the Preview 
image. 
:Borderless Printing, Color Mode, Orientation, 
Layout, Watermark

B

This displays the sizes of the Page Size and Media 
Size settings. Also, when the Enlarged/Reduced 
Printing and Borderless Printing items are 
selected, the mode and magnification are also 
displayed.

C

The following settings are shown in the Preview 
image. 
:Media Source, Borderless Printing, Enlarged/
Reduced Printing, Automatic Cutting Settings, 
Print Centered, No Spaces at Top or Bottom 
(Conserve Paper), Rotate Page 90 degrees 
(Conserve Paper), Orientation, Rotate 180 
degrees, Mirror
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Confirming the Print Image (Print Preview)
There is one more function that displays the print image 
of the document in the Preview. This other image is 
called the Print Preview. If you set the Print Preview to 
display in the printer driver before the print job, the Pre-
view will display at the start of every print job for you to 
check and prevent failed print jobs. 
To have the Print Preview display, open the Main tab of 
the printer driver and select Open Preview When Print 
Job Starts. 

When you execute a print job an edit screen (Page Com-
poser) opens. Double-click the name of the document 
that is ready to print and display its Preview for confirma-
tion. 
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Once you have confirmed that the image layout on the 
media is correct, you can close the Preview. After select-
ing the document name with PageComposer and con-
firming its appearance, start the print job from the File 
menu. 

Note
One the document name (print data) is selected in the 
PageComposer, you can edit the document as needed 
with the items in the Edit menu. For more details about 
these editing features, please refer to the 
PageComposer online Help. 

Enlarging and Reducing the Original
The original can be printed at a larger or smaller size.
There are three methods for enlargement and reduction.

Enlarging or reducing printing to fit the size of 
the media (→  P.3-7)

Enlarging or reducing fit the roll paper width
(→  P.3-9)

Setting the desired scaling rate and printing. 
(→  P.3-11)

Note
When you need to enlarge TIFF image data or JPEG 
images captured with a digital camera, in Adobe 
Photoshop or a similar software application set the 
resolution setting above 150 dpi to achieve better 
printing results. 
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Enlarging or Reducing Printing to Fit the 
Size of the Media
By setting the size of the media actually loaded for print-
ing, you can automatically enlarge or reduce the print 
automatically to match the size of the loaded media. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Page Setup sheet.

3 For Page Size on the Page Setup sheet 
select the size of the original created in the 
software application.

4 Select Enlarged/Reduced Printing. 
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Note
If you do not see the checkbox for Enlarged/Reduced 
Printing, then cancel the Borderless Printing 
selection. The Enlarged/Reduced Printing checkbox 
will appear. 

5 Confirm that Fit Media Size is selected 
under Enlarged/Reduced Printing. 

6 From Media Size select the size of the 
media that will be used for printing. 

7 Check the Preview and confirm that the 
media size selection has changed, then click 
the OK button. 

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

8 Click the Print button in the Print dialog box.
The print job starts.
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Enlarge/Reduce to Fit Roll Paper Width
You can enlarge or reduce the entire size of the original 
so it fits the width of the roll.

1 Open the printer driver dialog box from the 
Printer dialog box of the application. 

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Page Setup sheet.

3 For Page Size on the Page Setup sheet 
select the size of the original created in the 
software application.

4 Select Enlarged/Reduced Printing.
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Note
If you do not see the checkbox for Enlarged/Reduced 
Printing, then cancel the Borderless Printing 
selection. The Enlarged/Reduced Printing checkbox 
will appear.

5 Under Enlarged/Reduced Printing select 
Fit Roll Paper Width.

Note
Under Enlarged/Reduced Printing select Fit Roll 
Paper Width to open the dialog box below. From the 
Roll Paper Width list select the width of the roll 
loaded in the printer, then click the OK button.

6 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

7 Click the Print button in the Print dialog box.
The print job starts.

Note
Before you start the print job, confirm that the width of 
the roll selected in the printer driver is the same as the 
width of the roll loaded in the printer. If the printer 
driver setting does not match the width of the loaded 
roll, the print job will halt temporarily.
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Selecting the Magnification Rate for 
Printing 
You can enter the rate of magnification directly if you 
need to scale the enlargement or reduction for a desired 
effect. 

1 Open the printer driver dialog box from the 
Printer dialog box of the application. 

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Page Setup sheet.

3 For Page Size on the Page Setup sheet 
select the size of the original created in the 
software application.

4 Select Enlarged/Reduced Printing.
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Note
If you do not see the checkbox for Enlarged/Reduced 
Printing, then cancel the Borderless Printing selection. 
The Enlarged/Reduced Printing checkbox will appear.

5 Under Enlarged/Reduced Printing select 
Scaling then specify the desired setting.

Important
You can enter a setting for the rate of magnification 
manually from the keyboard or use the arrow button on 
the right to scroll the number settings up or down. The 
rate can be changed in increments of 1%. The size 
can be scaled in the range limited by the size of the 
Scaling entry column displayed on the right. 
You can perform a setting that is larger than the size of 
the media loaded in the printer, but some portions of 
the will be cut off and not printed. 

Reduction is performed starting from the upper left 
corner of the image, but if you select Print Centered 
on the Layout sheet, the image will print in the center 
of the media.
When Scaling is selected, the maximum possible rate 
of magnification is displayed to the right of the 
magnification entry box.

6 Select the Media Size setting that you want.

7 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

8 Click the Print button in the Print dialog box.
The print job starts.
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Printing Photos and Illustrations without 
Borders (Borderless Printing)
Normally a printed document has white space around its 
edges (margins), but a borderless print for a photograph or 
created image has no white space at its borders; its entire 
surface is covered by printing.

Settings Required for Borderless Printing
Before performing the print job, make sure that a media 
that can be used for borderless printing is loaded. Only 
media fed from the roll can be used for borderless print-
ing on this printer.
Here is a list of the types of roll media and their widths 
that can be used for borderless printing.

Important
Paper of types and roll widths other than those listed 
above cannot be used for borderless printing. 
The following types of media cannot be Auto cut, so 
borderless printing can only be performed on the left 
and right edges.
Premium Matte Paper, Flame Resistant Cloth, Fine Art 
Photo, Fine Art Heavyweight Photo, Fine Art Textured, 
Canvas SemiGlos

Basic Procedure for Borderless Printing
This section introduces the basic procedure for borderless 
printing by using media of the same size as the original.

1 Create the original in the software application 
so it matches the size of the media used for 
printing.

Important
The following page size settings can be used for 
borderless printing. Refer to the table below when you 
create the original image and set the page for a size 
that can be used for borderless printing.
If the media size was pre-selected in the software 
application, the selected size must support 
Borderless Printing.

There are limitations on the selection of page sizes 
that can be used with the Borderless Printing 
Method. If any page size other than those listed above 
is selected, the Borderless Printing Method feature 
is automatically set for Scale to fit Roll Width.
For more details about Scale to fit Roll Width and 
Print Image with Actual Size, please refer to “More 
About Borderless Printing Methods” (→ P.3-17)

Paper Type Corresponding Roll Width
Glossy Photo Paper, SemiGlos 
Photo Paper, Heavyweight Glossy 
Photo Paper, Heavyweight 
SemiGlos Photo Paper, 
Heavyweight Coated Paper, 
Premium Matte Paper, Extra 
Heavyweight Coated Paper, Matte 
Film, Flame Resistant-Cloth, Fine 
Art Photo, Fine Art Heavyweight 
Photo, Fine Art Textured, Canvas 
SemiGlos, Special 1-5

10-in. Roll (254.0mm) 
14-in. Roll (355.6mm) 
16-in. Roll (355.6 mm) 
JIS B2/B3 Roll 
(515.0 mm)
ISO A1/A2 Roll 
(594.0 mm)

24-in. Roll (609.6mm) 

Borderless printing 
on media the same 
size as the original 
document

ISO A1, ISO A2, JIS B2, JIS 
B3, ARCH D (24”), ARCH C, 
20”x24”, 14”x17”, 10”x12”, 
10”x15”, 8”x10”, US Photo 
(16”x20”)

Borderless printing 
with enlargement and 
reduction

All page sizes
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Note
Make sure the image created for borderless printing covers the entire original page. 
If you are using Microsoft Word or any other software application that allows margin settings, set all the margins to “0”. 
For more details about how to perform these settings, please refer to the software application instructions. 

2 Open the printer driver dialog box from the Printer dialog box of the application. 

Note
For more details about how to open the printer driver dialog box, please refer to “Printing” in Chapter 1 “Basic 
Procedures”. (→ P.1-40)

3 Display the Main sheet and perform the settings for borderless printing. 

1. Select the media compatible with borderless printing.

2. If you check the checkbox for Open Preview When 
Print Job Starts, you can confirm the appearance of 
the print image in the Print Preview before printing.
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4 Display the Page Setup sheet and perform the settings for borderless printing. 

Note
If you change the page size to any other size that allows borderless printing, the setting for the width of the roll changes 
automatically to a roll width that matches the original width. 
If you change the page width setting to a size that does not allow borderless printing, the dialog box below opens. 
Specify a setting in the Roll Paper Width list, then click the OK button so you can continue with the borderless print (in 
this case the width of the original will be enlarged or reduced to fit the width of the roll media). The print cannot be 
performed with the same width as the original. 

1. For Page Size select the size of the original created in the 
software application.

2. Select Borderless Printing.

* If you select the paper for a size that can be used for 
borderless printing, Scale to fit the Page Size is set for 
Borderless Printing Method.

3. Confirm that the width of the roll paper matches the roll 
paper or the page size for Media Source.

* The Preview reflects changes in the contents of the settings.
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5 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

6 Click the Print button in the Print dialog box.
The print job starts.

Note
If Scale to fit the Page Size is selected for 
Borderless Printing Method, the printer driver 
automatically enlarges the original up to every edge of 
the page to a margin of 3 mm. The result is the printer 
fills the entire page up to the edges with borderless 
printing. The top, bottom, left and right margins of the 
original are set to 3 mm so no part of the image will 
extend beyond a margin. 

To enlarge or reduce while performing borderless 
printing, under Enlarged/Reduced Printing select Fit 
Roll Paper Width.

To do a borderless print of an image with a top and 
bottom margin, on the Layout sheet you can select No 
Spaces at Top or Bottom (Conserve Paper). This an 
easy way to do a borderless print by setting these 
margins to zero. For more details, please refer to 
“Printing without Top and Bottom Margins (Conserve 
Paper)”. (→ P.3-38)
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More About Borderless Printing Methods
There are two ways to create a document for borderless 
printing in addition to the methods described above 
(Scale to fit the Page Size). 
<To perform borderless document printing with a 
size not allowed for borderless printing>

Enlarge/Reduce to Fit Roll Paper Width
This features enlarges or reduces the size of the origi-
nal so it fits the width of the roll. You can print a page 
size not compatible with borderless printing (A4, A3, 
Custom Size, etc.) on roll media of a width that is com-
patible with enlargement/reduction printing. 

1 Create the original in the software application 
so it matches the size of the media used for 
printing. 

2 Open the printer driver dialog box from the 
Print dialog box of the application. 

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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3 Display the Main sheet and perform the settings for borderless printing.

4 Display the Page Setup sheet and perform the settings for borderless printing.

1. Select the media compatible with borderless printing.

2. If you check the checkbox for Open Preview When 
Print Job Starts, you can confirm the appearance of 
the print image in the Print Preview before printing.

1. For Page Size select the size of the original created in 
the software application.

2. Select Borderless Printing.

* For Borderless Printing Method, Scale to fit Roll 
Paper Width will be selected.

3. To change the setting of the roll paper width, select the 
width for the Roll Paper Width list.

* The Preview reflects changes in the contents of the settings.

* The example shows A4 size that cannot be used for 
borderless printing is selected.
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Note
If the size of the selected original cannot be used with 
borderless printing, select Borderless Printing to 
open the dialog box below. Select the width of the roll 
loaded in the printer, and then click OK. Borderless 
Printing Method will be set to Scale to fit Roll Paper 
Width.

To do a borderless print of an image with a top and 
bottom margin, on the Layout sheet you can select No 
Spaces at Top or Bottom (Conserve Paper). This an 
easy way to do a borderless print by setting these 
margins to zero. For more details, please refer to 
“Printing without Top and Bottom Margins (Conserve 
Paper)”. (→ P.3-38)

5 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

6 Click the Print button in the Print dialog box.
The print job starts.

Note
After the Scale to fit Roll Paper Width feature 
automatically sizes to original to fit the width of the roll, 
the printer driver automatically enlarges the image so 
that each margin, that is, the top, bottom, left, and right 
margin, is 3 mm each. The result is the printer fills the 
entire page up to the edges with borderless printing. 
Portions of the image that protrude over the 3 mm top, 
bottom, right, and left margins of the original document 
cannot be printed. 
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<To print a high-precision image with borderless 
printing>

Print Image with Actual Size
This takes an image that would otherwise overlap the 
margins and sizes it to 3 mm margins and then prints it 
with borderless printing on a media size that is the 
same as the sized original. Use this method when you 
want to avoid a deterioration in the quality of the image 
caused by enlargement or reduction. 

Note
If you perform the print job with Borderless Printing 
Method set for either Scale to fit the Page Size or 
Scale to fit Roll Paper Width, some slight 
deterioration in the quality of the image may occur 
because the printer driver automatically sizes the 
portions of the image that would otherwise overlap the 
margins. If you select Print Image with Actual Size 
for the Borderless Printing Method, however, you 
can perform print high-precision images with 
borderless printing just as they are. Select this setting 
when you need to print fine lines, photographs, or with 
any image where the priority is on accuracy and 
quality. 

1 In the software application create an image 
with borders (top, bottom, right, left) 3 mm 
larger than the original document. 

Note
Example: If the media size is JIS B2 (515 x 728 mm), 
set the dimensions for the original as 521 x 734 mm. 
If you are using MS-Word or another application, 
before you create the original select Page Setup from 
the File menu and select the page size and 
orientation.

2 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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3 Display the Main sheet and perform the settings for borderless printing.

4 Display the Page Setup sheet and perform the settings for borderless printing.

1. Select the media compatible with borderless printing.

2. If you check the checkbox for Open Preview When 
Print Job Starts, you can confirm the appearance of 
the print image in the Print Preview before printing.

1. For Page Size select the size of the original created in 
the software application.

2. Select Boderless Printing.

3. For Borderless Printing Method select Print Image 
with Actual Size.

4. Confirm that the width of the roll paper matches the roll 
paper or the page size for Media Source.

* The Preview reflects changes in the contents of the settings.
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5 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

6 Click the Print button in the Print dialog box.
The print job starts.

Rotating the Page 90 Degrees for Print-
ing (Conserve Paper)
In order to maximize the use of the paper width a vertical-
tall image can be rotated 90 degrees horizontally across the 
width of the media. By rotating the image you can maximize 
the use of the media and reduce waste. 
If you perform this setting in the printer to rotate the page 
image, then the page is rotated automatically for the print 
job. The image will not be rotated if it would not fit after 
rotation. 

Important
Confirm that the Roll Paper Width setting is correct 
for the media loaded in the printer.
If the selection for the Media Source is not Roll Paper, 
or if Borderless Printing is selected, this function 
cannot be used. 
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1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Page Setup sheet.

3 For Page Size on the Page Setup sheet 
select the size of the original created in the 
software application.

4 Select Rotate Page 90 degrees (Conserve 
Paper). 

5 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

6 Click the Print button in the Print dialog box.
The print job starts.
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Printing Several Pages on One Sheet 
(Page Layout)
You can print from 2 to 16 pages with reduced sizes on one 
sheet. For example, if you have a document with a large 
number of pages you can print two pages per sheet and the 
number of pages will be one-half. Also, in the Page Layout 
Printing dialog box you can perform more detailed settings, 
such as selecting the arrangement of the pages on the 
sheet and specifying whether to print each page with a 
border line. 

Important
This function is not supported with Windows NT 4.0. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Layout sheet.

3 Select Page Layout.

The Preview shows you want the printed page will 
look like with the number of pages selected for one 
sheet, then click the Set button in the lower right 
corner of the Page Layout group.
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4 From the Page Layout list, select the page 
layout that you want to print. 

5 If you want to change the arrangement of the 
pages on the sheet or specify each page to 
print with a border line, click the Set button to 
open the Page Layout Printing dialog box. 

6 To change the arrangement of the pages on 
the sheet, select the page order from the 
Page Order list. 

7 If you want each page on the sheet to print 
with a border line, from the Page Border list 
click the type of border. 

Note
If you select a border line to print, the image is sized 
down by 5% to allow for the border line. 
As soon as you select a border line, you will see this 
reflected in the Preview. 
If you select None then the size of the page is not 
reduced. 

8 Click the OK button to close the Page 
Layout Printing dialog box. 
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9 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

10 Click the Print button in the Print dialog box.
The print job starts.

Printing Posters (Page Layout)
After the image is enlarged and divided into several 
sections, you can print the print the sections and paste 
them together to assemble one large poster. 

Important
This function is not supported with Windows NT 4.0. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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2 Select the Layout sheet.

3 Select Page Layout.

4 Select Poster 2x2 from the Layout list. 
Confirm the appearance of the selected layout in the 
Preview. 

5 If you do not want to print any panel (a section 
of the divided image), click the Set button in the 
lower right corner of the Page Layout section 
to open the Pages to Print dialog box.
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6 Click and select either the panel or the 
appropriate checkbox to deselect the panel 
for printing.

Note
If you click the Invert button, the current selections of 
the checkmarks are reversed. In the Preview area you 
will see graphic images displayed for the sections to 
be printed and white blanks for the sections that will 
not be printed.

7 Click the OK button to close the Pages to 
Print dialog box. 

8 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

9 Click the Print button in the Print dialog box.
The print job starts.

Using Watermarks
You can print watermarks on printouts to mark them for 
special handling. Several standard watermarks 
(CONFIDENTIAL, DO NOT COPY, etc.) have been 
prepared. 

Important
This function is not supported with Windows NT 4.0. 
The Watermark function cannot be used if the print job 
is set up with a poster page layout. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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2 Select the Layout sheet.

3 Select Watermark. 

4 From the Watermark list, select the 
watermark that you want to print. 
The watermark that you selected will appear in the 
Preview on the left. 

Note
The following watermarks can be selected from the list.
CONFIDENTIAL, COPY, DRAFT, FILE COPY, FINAL, 
PRELIMINARY, PROOF, TOP SECRET.
Click the Edit Watermark button to open the Edit 
Watermark dialog box. In this dialog box you can 
create, edit, and register your own watermarks, in 
addition to the pre-made watermarks provided with the 
printer driver. For more details, please refer to Printing 
Watermarks > Creating an Original Watermark, or 
Editing and Deleting an Original Watermark.

5 Confirm the content of the settings Preview, 
then click the OK button.
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Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

6 Click the Print button in the Print dialog box.
The print job starts.

Vertical and Horizontal Banner Printing 
(Long Prints) 

Matching the Width of the Roll
Once you become familiar with fitting images to the full 
width of the roll with your software application, it is very 
easy to print vertical and horizontal banners. 
Here we will describe as an example how to take a 3.94 
in. x 19.67 in. original and enlarge to fit a 24” roll (approx-
imately 610 mm wide), and then print it as a banner 
(24.00 in. x 128.90 in.).

Note
This printer can print a sheet up to 15, 250 mm (600in.) 
long.



3- 31

Printing from Windows
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

1 Start the software application.

2 From the File menu select Print to open the 
Print dialog box.

3 Confirm that the printer name Canon 
W6400PG is displayed. 
The sample of the Print dialog box below is from 
Microsoft Word. 

Note
If the above printer name is not displayed, then select 
Canon W6400PG from the Name list. 

4 Click the Properties button to open the 
printer driver dialog box. 

5 Select the Page Setup sheet.

6 Click the Size Options button to open the 
Media Size Options dialog box. 
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7 Define the size in the Media Size Options dialog box.

Note
After you register a size in the Media Size Options dialog box, then the name and dimensions that you set for new size 
will appear in the Media Size List. For more details about the Media Size Options dialog box, please refer to “About 
Media Size Options”. (→ P.3-51)
In addition to the method above for setting the media size, you can also use the Custom Size Settings dialog box. To 
open the Custom Size Settings dialog box, click Page Size on the Page Setup sheet. 

1. Input the desired Custom Media Size Name.

2. For Media Size set the Width and the Height.

3. Click the Add button.

4. Click the OK button to close the Media Size Options 
dialog box.

* This example shows 3.94 in for the Width and 19.67 in 
for the Height.
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A custom size sets a temporary user-defined page size 
between the software application and the printer driver. 
For this reason, when the software application is 
closed the size defined in the Custom Size Settings 
dialog box is disabled. If you want the custom size 
setting to remain in effect, then you should register the 
custom size in the Media Size Options dialog box. 
Some software applications may not display a custom 
size item. In such a case, please register the custom 
size in the Media Size Options dialog box. 

8 Click the OK button to close the printer driver 
dialog box.

9 Click the Close button to close the Page 
Layout Printing dialog box. 

10 In the software application select Page 
Setup from the File menu to open the Page 
Setup dialog box. 

<If you are using Microsoft Word...>
a Select the Paper Size sheet, then for the size select 

the size you defined and registered in the Media 
Size Options dialog box. 

b Select Landscape for the Orientation, then click 
the OK button to close the Page Setup dialog box.

Note
This sets the Orientation to Landscape for the 
banner. 
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<If you are using Microsoft Excel...>
a Select the Page sheet, then for the Paper Size 

select the size you defined and registered in the 
Medial Size Options dialog box. 

b Select Landscape for the Orientation, then click 
the OK button to close the Page Setup dialog box. 

Note
This sets the Orientation to Landscape for the banner.

c Click the OK button to close the Page Setup dialog 
box. 

Note
For Display click Zoom to adjust the size of the 
display.

<If you are using Microsoft PowerPoint...>
a In the Page Setup dialog enter the dimensions for 

the custom size settings in the Width and Height 
boxes. This example shows 3.94 inches for the 
Width and 19.67 inches for the Height. 
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b Click the OK button to close the Page Setup dialog 
box. 

Note
Also when printing the original from PowerPoint if you 
select Scale to fit Paper in the Print dialog box the 
driver will size the page to fit the media loaded in the 
printer. 

11 Create the original in the software 
application. 

Note
The example below shows the original created in 
Microsoft Word. Select Insert > Picture > WordArt, 
select the appropriate style, then enter the text. 
For more details about how to create the original, 
please refer to the operating instructions for each 
software application. 

12 After the original is created, from the File 
menu select Print to open the Print dialog 
box. 

13 Click the Properties button to open the 
printer driver dialog box. 
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14 Select the Main sheet and perform the settings for a long print. 

15 Select the Page Setup sheet and perform the settings for a long print.

1. For Print Preferences select Long Format (Banner).

2. For Media Type select the type of media.

1. For Page Size select the media name registered in 
Media Size Options.

2. Select Enlarged/Reduced Printing and click Fit Roll 
Paper Width.

3. For Media Source select the Roll Paper and for Paper 
Roll Width select 24-in. Roll (609.6 mm).



3- 37

Printing from Windows
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

If you do not see the checkbox for Enlarged/Reduced 
Printing, then cancel the Borderless Printing 
selection. The Enlarged/Reduced Printing checkbox 
will appear.
Under Enlarged/Reduced Printing select Fit Roll 
Paper Width to open the dialog box below. Select the 
width of the roll loaded in the printer, and then click 
OK. 

16 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

17 Click the Print button in the Print dialog box.
The print job starts.

Note
If the print job does not execute properly on you 
operating system (Windows Server 2003, Windows 
XP, Windows 2000, Windows Me, Windows 98), click 
Special Settings on the Layout sheet to open the 
Special Settings dialog box. You may be able to 
enable printing by clicking the Fine Zoom list and then 
selecting On. 
If you cannot perform the print job with Windows NT 
4.0, you may be able to enable printing by selecting 
Standard or Draft under Print Quality on the Main 
sheet.
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Printing without Top and Bottom Mar-
gins (Conserve Paper)
The white space in the top and bottom margins can be 
eliminated for printing to save paper. The printer does not 
feed the white space in the margins to save paper. This 
function can be used only when Roll Paper is selected as 
the Media Source. 

Note
You use this method during borderless printing as 
shown in the illustration below.

Important
This function cannot be used when Cut Sheet is 
selected as the Media Source. 
With this feature cannot be selected with Poster (2 x 
2) set for the page layout. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

2 Select the Layout sheet.
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3 Select No Spaces at Top or Bottom 
(Conserve Paper). 

4 Confirm the content of the settings Preview, 
then click the OK button.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the print preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-5)

5 Click the Print button in the Print dialog box.
The print job starts.

Custom Print Quality
Customizing Print Quality
When you need to frequently perform combined settings 
for print quality and print speed, you can select Custom 
Settings under Print Quality and then do the print qual-
ity and resolution settings in the Custom Settings dialog 
box according to the requirements of your requirements. 
For example, if you need to set up printing text mixed 
with photos or graphics, or some other such job, you can 
raise the text resolution and lower the photo or graphic 
resolution. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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2 Confirm that the Main sheet is displayed. 3 From the Print Quality list, select Custom 
Settings. 

A Settings button appears in the lower right corner 
of the Print Quality group. 

4 Click the Settings button in the Print 
Quality group to open the Custom Settings 
dialog box. 
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5 From the Print Quality list, select the quality 
settings.

Note
The print quality settings that you can select for the 
custom settings are described below.

The items that are available for selection under Print 
Quality may differ depending on which print media are 
used. Here is a list of the media where Highest under 
Print Quality is available. 
Heavyweight Glossy Photo Paper, Heavyweight Semi-
Glossy Photo Paper, Japanese Paper Washi, CAD 
Translucent Matte Film

If one of the types of media below is selected, Draft 
cannot be selected under Print Quality. 
Premium Matte Paper, Glossy Photo, SemiGlos Photo 
Paper, Heavyweight Glossy Photo Paper, Heavyweight 
SemiGlos Photo Paper, Synthetic Paper, Adhesive 
Synthetic Paper, Backlit Film, Flame Resistant Cloth, 
Japanese Paper Washi, CAD Translucent Matte Film

6 Confirm the resolution.

Important
The resolution is set automatically depending on which 
print quality item is selected as shown below. If you 
need to change the resolution you can perform so with 
the setting under Print Quality.

Print Quality Content

Highest Prioritizes attaining the highest image 
quality for printing.

High Prioritizes attaining high image quality 
for printing.

Standard Attains a stable image at an average 
printing speed.

Draft
Prioritizes high printing speed but you 
should check layout and other aspects 
of the image after printing. Print Quality Resolution Content

Highest, 
High, 
Standard

Fine 
(600 dpi)

Print speed is slower due to 
the higher resolution 
setting. Achieves the best 
printing results, but printing 
time is longer and a large 
amount of computer 
memory is required.

Standard, 
Draft

Quick 
(300 dpi)

Print speed is faster due to 
the lower resolution setting. 
Printing time is shorter and 
not as much computer 
memory is required.
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Even with Print Quality set to Standard, the 
Resolution is fixed at Fine (600 dpi) if one of the 
settings below is selected for Media Type. If any other 
media is selected, the Resolution is fixed at Quick 
(300 dpi).
Premium Matte Paper, Backlit Film, Fine Art Photo, 
Fine Art Heavyweight Photo, Fine Art Textured, Can-
vas SemiGlos, CAD Plain Paper, CAD Tracing Paper, 
CAD Translucent Matte Film

7 Click the OK button to close the Custom 
Settings dialog box. 

Note
If you select Enhance Text with Photos in the 
Custom Settings dialog box then when you have text 
mixed with photos or graphic data, the resolution of the 
text will be raised and the resolution of the photos or 
graphics will be lowered.
Only the Halftone and Error Diffusion custom 
settings can be set. Error diffusion arranges non-
standard pixels and displays them as gradations 
(halftones). This setting is ideal for photographs or 
graphic images that require printing with fine 
gradations. 

Fine Adjusting Color for Printing
Adjusting Color
Basically the color settings of the software application 
have priority, but if the results of a print job are not what 
you want you can also adjust color in the printer driver. 
You can also take color photos captured with a scanner 
or a digital camera, or any other color image, and print 
them in monochrome.
We will introduce color adjustment.

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)
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2 Confirm that the Main sheet is displayed. 

3 On the Main sheet select Color Mode then 
Color.

Note
Color Mode presents these following items for 
selection.

Important
Monochrome (Photo) can be selected for Color Mode 
only if one of the following types of paper is selected:
Glossy Photo Paper/Semi-Glossy Photo Paper/
Heavyweight Glossy Photo Paper/Heavyweight 
SemiGlos Photo Paper/Fine Art Photo/Fine Art 
Heavyweight Photo/Fine Art Textured/Japanese Paper 
Washi

Color Mode Content
Color Prints in color.

Monochrome 
(Photo):

Provides stable monochrome photo 
printing with minimal tone change 
and enables detailed adjustment of 
gray scale gradations and color 
tones.

Monochrome Prints in monochrome.

Solid Color
Prints with only a limited number of 
colors. Use this setting when you 
need fine lines with light colors in a 
sharp image.

Black Only All colors other than white are 
printed black.
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4 Select Manual Color Settings then click the 
Color Settings button. 

Note
Manual Color Settings are enabled when Color, 
Monochrome (Photo), or Monochrome is selected for 
Color Mode.

The Color Settings dialog box opens.
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5 Confirm that the Color Adjustment sheet is 
displayed, then click the Object Adjustment 
button. 
The Object Adjustment dialog box opens. 

6 Select the item that you want to adjust: 
Image, Graphics, or Text. 

Note
Note that for this printer driver all the items (Image, 
Graphics, Text) are selected as the default settings. 

7 Click the OK button to close the Object 
Adjustment dialog box. 

8 Drag the slide bar to the left or right for the 
item that you want to adjust. You can also 
enter the value direction or use the arrows of 
the spinbox to rapidly raise or lower the 
value. 
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Note
Color Adjustment presents the following items for 
selection.

Important
As you change each item, the image of the Preview 
on the left changes to reflect the adjustment. The 
Original shows the appearance of the initial settings, 
and the Preview reflects the current settings. 
Even after performing the settings on the Color 
Adjustment sheet if you remove the selections of the 
Manual Color Settings the Color Adjustment 
settings are disabled. Remove the Color Adjustment 
selection if you do not want to perform color 
adjustments. 

9 Click the OK button to close the Color 
Settings dialog box. 

Color Matching
When you print an image captured with a scanner or a 
digital camera, sometimes the appearance of the printout 
does not match what you see on the screen.
This is caused by differences between the display color 
and the printed color. In the Color Settings dialog box 
you can use the items on the Matching sheet, that is, 
select a color profile ICC (International Color Consor-
tium), or ICM (Image Color Management), or select a 
matching mode, input profile, or printer profile, to have 
the hues of the colors on the screen more closely resem-
ble the colors in the printout. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

Color Adjustment Content
Cyan

You can calibrate the hues for Cyan, 
Magenta, Yellow.Magenta

Yellow

Contrast Adjusts the relative contrast from 
brightest to darkest colors.

Vivid Adjusts the relative contrast from 
brightest to darkest colors.

Brightness
Adjusts brightness from the darkest to 
brightest colors so none are lost in the 
brightness of the printed image.

Gray Tone 
Adjustment

Adjusts grayscale from cool colors 
(blue tones) to warm colors (red 
tones).



3- 47

Printing from Windows
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

2 Confirm that the Main sheet is displayed. 

3 On the Main sheet select Color for Color 
Mode. 

Note
Color Mode presents these following items for selection. 

Important
Monochrome (Photo) can be selected for Color Mode 
only if one of the following types of paper is selected:
Glossy Photo Paper/Semi-Glossy Photo Paper/
Heavyweight Glossy Photo Paper/Heavyweight 
SemiGlos Photo Paper/Fine Art Photo/Fine Art 
Heavyweight Photo/Fine Art Textured/Japanese Paper 
Washi

Color Mode Content
Color Prints in color.

Monochrome 
(Photo):

Provides stable monochrome photo 
printing with minimal tone change 
and enables detailed adjustment of 
gray scale gradations and color 
tones.

Monochrome Prints in monochrome.

Solid Color
Prints with only a limited number of 
colors. Use this setting when you 
need fine lines with light colors in a 
sharp image.

Black Only All colors other than white are 
printed black.



3- 48

Printing from Windows
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

4 Select Manual Color Settings then click the 
Color Settings button. 

Note
Manual Color Settings are enabled when Color, 
Monochrome (Photo), or Monochrome is selected for 
Color Mode.

The Color Settings dialog box opens. 

5 In the Color Settings dialog box, select the 
Matching sheet. 
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6 From the Matching Mode list, select the 
matching mode. 

Note
Here is a list of the available Matching Modes.

Important
The mode you select for the Matching Mode affects 
what items are available for selection. 
The warning message below is displayed for Driver 
ICM Mode, and Host ICM Mode. If you do not want to 
disable the color adjustments, click the No button. 
After you click No, the Driver ICM Mode and Host 
ICM Mode cannot be selected.

Matching Mode Content

Driver Matching 
Mode

Calibrates color using the original 
color profile of the printer driver.

ICC Matching 
Mode

Calibrates the color in the printer 
driver using the standards of ICC 
color profiles.

Driver ICM 
Mode

Calibrates color in the printer driver 
using the Windows ICM function for 
color calibration.
*This mode is displayed only for 
Windows Server 2003, Windows 
XP, and Windows 2000.

Host ICM Mode

Calibrates color in the printer driver 
using the Windows ICM function for 
color calibration at the host 
computer.
* This mode is displayed only for 
Windows Server 2003, Windows 
XP, and Windows 2000.

Off

Does not execute color matching. 
The color matching is performed in 
the software application or 
performed by and independent 
color profile; select when you want 
the color matching of the printer 
driver is ignored.

Matching Mode Content
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7 When ICC Matching Mode is selected for 
the Matching Mode, at Image under Input 
Profile Settings select a profile from the 
Input Profile list. 

Note
If you want to perform different settings for Graphics 
and Text, then you must cancel the selection of Use 
the Same Profile for All Objects. 

8 Select a matching method from the input 
profile Matching Method list. 

Note
Matching Method presents the following items for selection.
Matching Method Content

Automatic
Makes the best selections for the 
Image, Graphics, and Text items.
*This item is available only when 
Driver Matching Mode is selected.

Perceptual 
(Photographic)

This is the best mode for photographs. 
Achieves the best color results 
matching the hues of the colors on the 
screen with those in the printout, also 
provides smooth gradation.

Colorimetric
Faithfully reproduces the input data. 
Performs white color calibration, so there 
is no color when white data is output.
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9 From the Printer Profile Settings list, select 
a printer profile. 

Note
A print profile can be selected only when ICC 
Matching Mode is selected under the Matching 
Mode. 

10 Click the OK button to close the Color 
Settings dialog box. 

About Media Size Options
Creating Custom Sizes
On the Page Setup sheet of the printer driver click the 
Size Options... button to open the Media Size Options 
dialog box. In this dialog box you can create definitions 
of original media sizes and register them. Once a custom 
size has been defined, it will be listed along with the 
standard sizes and be available for selection. 

1 Open the printer driver dialog box from the 
Print dialog box of the application.

Note
For more details about how to open the printer driver 
dialog box, please refer to “Printing” in Chapter 1 
“Basic Procedures”. (→ P.1-40)

Colorimetric 
(No White Point 
Correction)

Faithfully reproduces the input data. 
No white point correction is 
performed.

Saturation
This is the best mode for graphics. 
Achieves the best results with priority 
on color saturation.

Matching Method Content
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2 Select the Page Setup sheet. 3 Click the Size Options... button to open the 
Media Size Options dialog box. 
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4 Define the size in the Media Size Options dialog box.

After you click the Add button, the user-defined media name registered in the Media Size List of the Media Size 
Options dialog box and the media size are displayed. 

1. Input the media size you create for Custom Media Size 
Name.

2. Select the unit for the size and click.

4. Click the Add button.

3. Enter Width and Height you want in Media Size.
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Note
As soon as you select the name of a media size from 
the Media Size List, the Width and Height settings of 
the selected size are automatically entered. 
If Borderless Printing Size is selected, the selection 
for Width changes automatically to a roll width that 
supports borderless printing. Select a Width setting for 
the width of the desired roller, then enter the Height 
that you want. 
If you want to fix the ratio between the width and 
height, select Fix the Ratio of the Width to Height. If 
you change the Height then the Width will adjust 
automatically so the ratio of the width to height 
remains the same as the original ration; similarly, if you 
change the Width the Height setting will also adjust 
automatically at the same ratio. 

Important
The Fix the Ratio of the Width to Height is not 
available when Borderless Printing Size is selected. 

5 Click the OK button to close the dialog box.

Note
You can define up to 50 custom sizes for media. 
The settings in the Media Size Options dialog box 
remain in effect even after the software application is 
closed. 
To delete a registered custom size, from the Media 
Size List select the name of the custom size to delete, 
then click the Delete button. 
To edit a registered custom size, from the Media Size 
List, select the name of the custom size, then change 
the Width and Height settings, then click the Register 
button.
The standard sizes (marked with a red dot on the left), 
or sizes that you defined with another printer driver 
(marked with a white dot on the left), can be neither 
edited nor deleted. 
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Selecting a Media Display Series
You can select a size series for Display Series that will 
display for the Media Size and Page Size on the Page 
Setup sheet in the Media Size Options dialog box.
To select a display series to display for the Page Size 
and Media Size in the Page Setup sheet, in the Media 
Size Options dialog box select the Display Series that 
you want to use. Also, if you want to cancel a size series 
selected for display, just click and cancel the Display 
Series selection. 

Note
If you select an oversize for the Display Series then 
Oversize will display in front of the media name as 
shown below. For example, if the page size selection is 
ISO A4 then Oversize - ISO A4 is displayed. 

When you see Oversize - prefixed to a page size, you 
can print documents and images with the specified 
sizes as shown below. However, when you apply this 
function to print you must set a media size large 
enough to accommodate the page size plus the extra 
white space. You cannot perform oversize printing 
using a custom size document, an media size selected 
for borderless printing, or media size that is too large 
to feed with this printer.

Original Data
to Print

Original Size
Data

Original Size
Data

Size of Media to
Load in the Printer

Original Size
+

Size
of Margins

Print Results

Original
Size



3- 56

Printing from Windows
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

When the Printout Quality Is Not Clean
How to Set the Media Type
You can use the printer operation panel to perform suit-
able settings for ink drying time of each media and other 
features. These settings can also adjusted with the items 
in the Media Detailed Settings dialog box in the printer 
driver. If the printouts are not clear, you may be able to 
correct the problem by adjusting the settings in this dia-
log box. 
To open the Media Detailed Settings dialog box, in the 
printer driver open the Main sheet and then in the lower 
right corner of the Media Type group box click the Set-
tings... button. 
For more details about the Media Detailed Settings dia-
log box, please refer to the online Help. 

Software Provided for Windows
The following software applications are provided for use 
with Windows. 
The function of each software application is described 
below. 

Basic Software for Printing
imagePROGRAF Printer Driver 2005

This is a software application that required for the 
printer to print. This must be installed on every 
computer that will use the printer. The printer driver not 
only allows the printer to print, the driver also provides 
many other important functions such as enlargement/
reduction, borderless printing, color adjustment, 
multiple copy printing, and others. This can be used 
with Windows Server 2003, Windows XP, Windows 
2000, Windows NT 4.0, Windows Me, and Windows 
98.
The printer driver is on the provided User W6400 
Software CD-ROM. (→  Quick Start Guide)

Displaying the Printer Status
GARO Status Monitor

This utility software is used with Windows to display 
the details about printer errors on the computer 
screen. This can be used with Windows Server 2003, 
Windows XP, Windows 2000, Windows NT 4.0, 
Windows Me, and Windows 98.
This is provided on the W6400 User Software CD-
ROM and it is installed automatically with the printer 
driver.
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Using the Printer on a Network
LPR Port

This software must be installed on Windows Me or 
Windows 98 so the computer can use the printer on a 
network with TCP/IP. 
To install this software, use the Setup Menu of the 
W6400 User Software CD-ROM to start the dynamic 
installation for both the printer and this software. 

GARO Device Setup Utility
The software application for Windows that allows you 
to use the computer to set up the network information 
for the printer.
(→ Chapter 5 “Using the Printer in a Network 
Environment”)

Remote UI
The function that allows you to use a Web browser on 
a networked computer to display the status of the 
printer and to set up and delete print jobs. This utility is 
built into the network interface of this printer.
(→ Chapter 5 “Using the Printer in a Network 
Environment”)

NetSpot Console
This software allows you to use a Web browser on a 
computer connected to a network to display the status 
of the printer and perform printer and network settings 
for a server running with Windows Server 2003, 
Windows XP, Windows 2000, Windows NT 4.0, 
Windows Me, and Windows 98. You can download 
NetSpot Console free of charge from the Canon home 
page (http://canon.jp/). Install as required on the 
server computer. 

Device Status Extension
If printer sharing is performed where IIS is installed on 
Windows XP or Windows 2000 you can use your Web 
Browser to display information about shared printers 
and manage print jobs. By installing Device Status 
Extension on Windows Server 2003, Windows XP, or 
Windows 2000, the screens that display printer 
information for printers that support Device Status 
Extension can be replaced with the screens provided 
by Canon. Further, if you use NetSpot Console, you 
can start NetSpot Console from the Device Status 
Extension screen to perform printer and other settings. 
Device Status Extension is stored on the provided 
W6400 User Software CD-ROM. For more details 
about how to install and use this software, please refer 
to the Readme.txt file in the DSE folder.

Creating Posters Easily
PosterArtist

The software provides a wizard that helps you create 
posters simply, and guides you from creation through 
printing. Original image for a poster can be created 
freely in a software application regardless of the print 
settings performed in the printer driver. Also, 
borderless printing and banner size posters can be 
created easily. Posters created with PosterArtist can 
be printed only on this printer. 
It can be used with Japanese Windows XP, Windows 
2000, Windows Me, and Windows 98 SE.
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Printing Beautiful Photographs
Digital Photo Print Pro

This software allows you to easily take a photo image 
captured with a digital camera, enlarge it, and then 
print it without borders. You can also easily adjust 
color brightness and contrast, eliminate the effects of 
red-eye and moiré in photo images, and correct 
subject back light. Also, you can use one of the 
templates provided to easily print and original calendar 
or create a list of images with text entered. This 
software application requires Windows XP or 
Windows 2000.

Printing Beautiful Digital Camera Images 
(for the Professional)
imagePROGRAF Print Plug-In for Photoshop

imagePROGRAF Print Plug-In for Photoshop 
(hereafter "Print Plug-In) makes it possible to 
reproduce and print the vivid RGB color of Adobe 
created in PhotoShop. This software is intended for 
professionals and high-end users who want to obtain 
the best finished color hues. 
After installation of Print Plug-In, you can view a 
Preview within PhotoShop that allows you to confirm 
how faithful the colors are reproduced and then adjust 
them. Because you can process RGB 16-bit data just 
as it is with PhotoShop, you can print without losing 
the high color gradations of the originals. Also, you 
can save the used settings so when you want to print 
with the same settings you only have to open and read 
that information to print again. 
(→ Print Plug-In for Photoshop Guide)

Printing Images Created with CAD 
Systems 
Canon imagePROGRAF HDI Printer Driver

The Canon imagePROGRAF HDI printer driver is 
dedicated to printing accurate, clean images created 
with AutoCAD CAD software. Normal print jobs sent 
through the Windows printer driver may show some 
loss of precision in printing fine lines, but the Canon 
imagePROFGRAF HDI driver communicates with the 
printer directly from the computer, processes data with 
its own internal commands and delivers superior 
reproduction of lines in printing that preserves the 
accuracy of the originals. 
(→ HDI Driver Guide)

Select the Media Type
Media Configuration Tool

Media Configuration Tool is the software used to 
register information about print media (paper, film, 
etc.) that can be used with the printer as it becomes 
available. The functions of this software are provided 
for users who have an in-depth knowledge of printers 
and print media. 
You an use this software to upload and download 
media information to and from the printer about media 
names, thickness, printhead height, suction fan 
strength, default margins, and other information. A 
function is also provided that allows the user to 
acquire the most recent information about media for 
printing when using the printer connected to a 
network. 
(→ Media Configuration Tool Guide)
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Printing from Macintosh
This printer driver provides a variety of printer functions to meet your printing needs. In this chapter we will introduce these 
functions. 

Before You Begin 
There are some functions you should remember and use when you use this printer. Before you use the printer for different 
printing tasks, please read this section. 

Basic Settings to Meet Your Needs (Original Type)
To achieve the best printing, you must adjust the color and other settings for the objective of the document. This printer 
driver provides superior settings frequently used to produce posters, POP ads, digital camera prints, CAD designs, and 
other prints. Just select from the list the type of document you need and perform the basic procedure for the print job. 
The following applications are provided for the types of prints shown below.

Types of Documents Content
Setting Values

Paper Type Print 
Quality

Matching 
Method

Color 
Adjustment

Standard
Best for printing normal 
documents, with text, images, 
graphics, etc. mixed together.

Plain Paper Standard
Perceptual 

(OS X)
Auto (OS 8/9)

Default

POP
Best for printing mixed text 
and illustrations with bright 
and forceful eyecatching such 
as store posters.

Heavyweight Coated 
Paper Standard Saturation Contrast: +5

Poster Best for printing posters with 
centered photographs.

Proofing Paper *1
Heavyweight Coated 

Paper *2
Standard Automatic Contrast: +10

Brightness: +5

Photo 
(from digital 
camera)

Best for printing photos 
captured with a digital camera.

Glossy Photo Paper *1
Heavyweight Coated 

Paper *2
Standard Perceptual Contrast: +10

Brightness: +5
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Note
For more details about print quality, please refer to “Custom Print Quality” in “Customizing Print Quality”. (→ P.3-103)
For more details about color mode matching and color adjustments, please refer to “Fine Adjusting Color for Printing” in 
“Adjusting Color” (→ P.3-107) see “Color Matching”. (→ P.3-113)

Photo (from 
scanner)

Best for reproduction of 
scanned photographs with 
color faithful to the quality of 
the original.

Glossy Photo Paper *1
Heavyweight Coated 

Paper *2
Standard Colorimetric Default

Long Format 
(Banner)

Best for long banner formats 
(vertical and horizontal) with 
mixed illustrations and text.

Heavyweight Coated 
Paper Standard Saturation Contrast: +10

Saturation: +5

CAD Best for plans and design 
drawings with fine lines. CAD Plain Paper Standard Saturation Default

No color 
correction

Prints giving priority to and 
using the software application 
setting for color matching

Plain Paper Standard
Matching 

Mode
No Correction

Default

*1. Photo Black Ink (BK) is the black ink tank type mounted in the printer.
*2. Matte Black Ink (MBK) is the black ink tank type mounted in the printer.

Types of Documents Content
Setting Values

Paper Type Print 
Quality

Matching 
Method

Color 
Adjustment
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To perform the settings for a print, first open the Main panel of the printer driver and then from Print Preferences select 
the type of printing that you want to perform. 

Note
The Profiles function is also provided with OS 8/9 so you can register your own frequently used print settings. You can 
use Add Profile and Edit Profile to further simply printer settings.
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Printer Driver Settings at a Glance (Media Preview)
The preview illustrates the content of the current printer driver settings. If you change the page size and orientation, feed 
method, etc., you can confirm their immediate effect easily by viewing the effect of the new settings in the Preview image.
You can confirm the following items in the Preview.
When you select the Images tab, the contents of the media size and layout are displayed.

Setting Preview Description

A
The following settings are shown in the Preview image. 
(OS X) :Page Size, Orientation, Scaling, Page Layout, Color Mode, Borderless Printing
(OS 8/9) :Page Size, Media Size, Orientation, Scaling, Page Layout, Poster Printing, Color Mode, Mirror, 
Rotate 180 degrees, Borderless Printing

B This displays the sizes of the Page Size and Media Size settings. Also, when the Enlarged/Reduced Printing 
and Borderless Printing items are selected, the mode and magnification are also displayed.

C
The following settings are shown in the Preview image. 
:Media Source, Automatic Cutting, Print Centered, Banner Printing, Media Source, Fit Roll Paper Width, No 
Spaces at Top or Bottom, Rotate Paper 90 degrees, Orientation, Borderless Printing, Rotate 180 degrees, 
Mirror.

A

B

C

A

B

C



3- 63

Printing from Macintosh
トップ

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

TOP

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

When you select the Size tab, the details about the media size are displayed. 
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Confirming the Print Image (Print Preview)
There is one more function that can be displayed for the print image of the document in the Preview. This other image is 
called the Print Preview. Open the Preview before you print, so you can avoid failed print jobs beforehand. 
To display the Print Preview, click the Preview button in the printer driver. 

When the Viewer starts you can visually check the Preview display. 
Once you have confirmed that the image layout on the media is correct, you can print from the Preview screen. 
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Enlarging and Reducing the Original
The original can be printed at a larger or smaller size. 
There are three methods for enlargement and reduction. 

Enlarging or Reducing Printing to Fit the Size of the Media. (→ P.3-65)

Enlarging or reducing fit the roll paper width. (→ P.3-69)

Setting the desired Scaling rate and printing. (→ P.3-73)

Enlarging or Reducing Printing to Fit the Size of the Media
By setting the size of the media actually loaded for printing, you can automatically enlarge or reduce the print automati-
cally to match the size of the loaded media. 

1 In the software application select Page Setup from the File menu to open the Page Setup dialog 
box.

2 For Media Size (Page Size for OS 8/9), select the size of the media.

3 Click the OK button to close the Page Setup dialog box.

4 From the File menu of the software application select Print to display the Print dialog box.
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5 Select the Finishing panel (Page Setup for OS 8/9). 

6 Confirm that the size of the original created in the software application is selected under Page Size.
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7 Select Enlarged/Reduced Printing.
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8 Confirm that Fit Media Size is selected under Enlarged/Reduced Printing.

9 For Media Size select the size of the media that will be used for printing.

Note
Match Page Size is selected as the default.

Important
If the landscape or portrait orientation of the original page size and the print media are different, part of the image may 
not print on the media.

10 Confirm the content of the Preview, then click the Print button.
The print job starts.
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Enlarge/Reduce to Fit Roll Paper Width
You can enlarge or reduce the entire size of the original so it fits the width of the roll.

1 In the software application select Page Setup from the File menu to open the Page Setup dialog 
box.

2 For Media Size (Page Size for OS 8/9), select the size of the media.

3 Click the OK button to close the Page Setup dialog box.

4 From the File menu of the software application select Print to display the Print dialog box.
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5 Select the Finishing panel (Page Setup for OS 8/9).

6 Confirm that the size of the original created in the software application is selected under Page Size.



3- 71

Printing from Macintosh
トップ

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

TOP

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

7 Select Enlarged/Reduced Printing.

8 Under Enlarged/Reduced Printing select Fit Roll Paper Width (Fit Roll Width Size for OS 8/9).

Important
If Rotate Page 90 degrees (Conserve Paper) is selected on the Finishing panel, this function cannot be used.
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Note
Under Enlarged/Reduced Printing select Fit Roll Paper Width (Fit Roll Width Size for OS 8/9) to change the width 
setting for Media Size. Check the value displayed for Roll Paper Width.

9 Confirm the content of the Preview, then click the Print button. 
The print job starts.
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Selecting the Magnification Rate for Printing
You can enter the rate of magnification directly if you need to scale the enlargement or reduction for a desired effect.

1 In the software application select Page Setup from the File menu to open the Page Setup dialog 
box.

2 For Media Size (Page Size for OS 8/9), select the size of the media.

3 Click the OK button to close the Page Setup dialog box.

4 From the File menu of the software application select Print to display the Print dialog box.
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5 Select the Finishing panel (Page Setup for OS 8/9).

6 Confirm that the size of the original created in the software application is selected under Page Size.
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7 Select Enlarged/Reduced Printing.
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8 Under Enlarged/Reduced Printing select Scaling then specify the desired setting.

Important
This function cannot be used when Borderless Printing is selected. 
You can enter a setting for the rate of magnification manually from the keyboard or use the arrow button on the right to 
scroll the number settings up or down. The rate can be changed in increments of 1%. The size can be scaled in the 
range limited by the size of the scaling entry column displayed on the right. 
You can perform a setting that is larger than the size of the media loaded in the printer, but some portions will be cut off 
and not printed. 
To center an image in the upper left for printing, on the Finishing panel select Print Centered. 

9 Check the value displayed for Media Size. 

10 Confirm the content of the preview, then click the Print button.
The print job starts.
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Printing Photos and Illustrations without 
Borders (Borderless Printing)
Normally a printed document has white space around its 
edges (margins), but a borderless print for a photograph or 
created image has no white space at its borders; its entire 
surface is covered by printing. 

Settings Required for Borderless Printing
Before performing the print job, make sure that a media 
that can be used for borderless printing is loaded. Only 
media fed from the roll can be used for borderless print-
ing on this printer.
Here is a list of the types of roll media and their widths 
that can be used for borderless printing.

Important
Paper of types and roll widths other than those listed 
above cannot be used for borderless printing. 
The following types of media cannot be cut and are 
printed left to right during borderless printing.
Fine Art Photo, Fine Art Heavyweight Photo, Fine Art 
Textured, Canvas Matte

When you perform borderless printing, be sure to select 
Enlarged/Reduced Printing on the Finishing panel 
(Page Setup for OS 8/9). This allows Borderless Print-
ing to be performed.

Important
Borderless Printing cannot be performed under the 
following conditions.

Paper Type Corresponding Roll Width
Heavyweight Coated Paper, 
Premium Matte Paper, Extra 
Heavyweight Coated Paper, 
Glossy Photo Paper, SemiGlos 
Photo Paper, Heavyweight 
Glossy Photo Paper, 
Heavyweight SemiGlos Photo, 
Flame Resistant-Cloth, Fine Art 
Photo, Fine Art Heavyweight 
Photo, Fine Art Textured, 
Canvas SemiGlos, Special 1-5

10-in. Roll (254.0mm)

14-in. Roll (355.6mm)

16-in Roll (355.6 mm)

24-in. Roll (609.6mm)

JIS B2/B3 Roll (515.0 mm)

ISO A1/A2 Roll (594.0 mm)

When Cut Sheet is selected under Media Source on 
the Finishing panel.

When Roll Paper (Banner Printing) is selected 
under Media Source on the Finishing panel.

When Scaling is selected for Enlarged/Reduced 
Printing.

When Rotate Page 90 degrees (Conserve Paper) is 
selected on the Finishing panel.

When several pages are selected for Pages per 
Sheet (Page Layout for OS 8/9) on the Layout 
panel (Page Setup for OS 8/9).

When Print Centered is selected on the Finishing 
panel

When the setting selected for Roll Paper Width does 
not support borderless printing
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Borderless Printing
This section describes the borderless printing procedure. 
<To perform borderless printing on media the same size as the original>

1 Create the original in the software application so it matches the size of the media used for printing.

Important
The following page size settings can be used for borderless printing. Refer to the table below when you create the 
original image and set the page for a size that can be used for borderless printing.
If the media size was pre-selected in the software application, the selected size must support Borderless Printing.

Note
Make sure the image created for borderless printing covers the entire original page.

2 From the File menu of the software application select Print to display the Print dialog box.

Borderless printing on media the 
same size as the original 
document

ISO A1, ISO A2, JIS B2, JIS B3, ANSI Legal, ARCH D, ARCH C, 20”x24”, 
14”x17”, 10”x12”, 10”x15”, 8”x10”, US Photo (16”x20”)

Borderless printing with 
enlargement and reduction All page sizes



3- 79

Printing from Macintosh
トップ

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

TOP

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

3 Open the Main panel and perform the settings for borderless printing.

4 Open the Finishing panel (Page Setup for OS 8/9) and then select Enlarged/Reduced Printing 
and Borderless Printing.

Select the media 
compatible with 
borderless printing.
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Note
When Borderless Printing is selected under the Media Size in the software application, Step 4 to Step 6 are not 
required.
If you select Enlarged/Reduced Printing with Borderless Printing, Fit Roll Paper Width is selected for Enlarged/
Reduced Printing.
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5 Confirm that Fit Media Size is selected under Enlarged/Reduced Printing.

6 Select the Media Size setting that you want.

7 Confirm the content of the preview, then click the Print button.
The print job starts.
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Note
For more about how to enlarge or reduce while 
performing borderless printing, please refer to 
“Enlarge/Reduce to fit Roll Paper Width” under “<To 
perform borderless document printing with a size not 
allowed for borderless printing>”. (→ P.3-83).
If Scale to fit the Page Size is selected for borderless 
printing, the printer driver automatically enlarges the 
original by 3 mm at the top, bottom, left, and right margin.
The result is the printer fills the margins on the entire 
page with borderless printing. 
The top, bottom, left and right margins of the original 
are set to 3 mm so no part of the image will extend 
beyond a margin.
To perform a borderless print of an image with a top and bottom margin, on the Finishing panel you can select No 
Spaces at Top or Bottom (this is an easy way to perform a borderless print by setting these margins to zero). For 
more details, please refer to “Printing without Top and Bottom Margins (Conserve Paper)”. (→ P.3-100)
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<To perform borderless document printing with a 
size not allowed for borderless printing>

Enlarge/Reduce to fit Roll Paper Width
Enlarges or reduces the width of the original for print-
ing so it will fit the width of the roll. You can print a page 
size not compatible with borderless printing (A4, A3, 
Custom Size, etc.) on roll media of a width that is com-
patible with enlargement/reduction printing. 

1 Create the original in the software application so it matches the size of the media used for printing. 

2 From the File menu of the software application select Print to display the Print dialog box.

3 Open the Main panel and perform the settings for borderless printing.

Select the media 
compatible with 
borderless printing.
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4 Open the Finishing (Page Setup for OS 8/9) and then select Enlarged/Reduced Printing and 
Borderless Printing.

Note
If you select Enlarged/Reduced Printing with Borderless Printing, Fit Roll Paper Width is selected for Enlarged/
Reduced Printing.
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5 Under Enlarged/Reduced Printing select Fit Roll Paper Width (Fit Roll Width Size for OS 8/9).

6 Roll Width Size is displayed in Media Size, so check the value for Roll Paper Width.

7 Confirm the content of the Preview, then click the Print button.
The print job starts.

Note
After the Fit Roll Paper Width (Fit Roll Width Size for OS 8/9) feature automatically sizes to original to fit the width of 
the roll, the printer driver automatically enlarges the image so that each margin, that is, the top, bottom, left, and right 
margin, is 3 mm each. The result is the printer fills the entire page up to the edges with borderless printing. Portions of 
the image that protrude over the 3 mm top, bottom, right, and left margins of the original document cannot be printed. 
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Rotating the Page 90 Degrees for Printing (Conserve Paper)
In cases where the length of the print job data is shorter than the width of the media, the printer driver will rotate the image 
90 degrees and the length of the image across the width of the media. By rotating the image you can maximize the use of 
the media and reduce waste.
If you do this setting in the printer to rotate the page image, then the page is rotated automatically for the print job. The 
image will not be rotated if it would not fit after rotation. 

Important
Confirm that the Roll Paper Width setting is correct for the media loaded in the printer. 
If the selection for the media source is not Roll Paper, or if borderless printing is selected, this function cannot be used. 
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1 From the File menu of the software application select Print to display the Print dialog box.

2 Select the Finishing panel. 
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3 Select Rotate Page 90 degrees. 

4 Confirm the content of the preview, then click the Print button.
The print job starts.

Note
To achieve the best print results, you should confirm the appearance of the original in the Print Preview before printing. 
For more details about how to display the Preview, please refer to “Confirming the Print Image (Print Preview)” in 
“Before You Begin”. (→ P.3-64)
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Printing Several Pages on One Sheet 
(Page Layout)
You can print from 2 to 16 pages with reduced sizes on one 
sheet. For example, if you have a document with a large 
number of pages you can print two pages per sheet and the 
number of pages will be one-half. Also, you can perform 
more detailed settings, such as selecting the arrangement 
of the pages on the sheet and specifying whether to print 
each page with a border line. 

1 From the File menu of the software application select Print to display the Print dialog box.

2 Select the Layout panel (Page Setup for OS 8/9). 
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3 From the Pages per Sheet (Page Layout 
for OS 8/9) list, select the Page Layout that 
you want to use for printing.

4 Set the Layout Direction to arrange the 
pages on the media.
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5 Select a borderline from the Page Border 
list. 

6 Confirm the content of the preview, then click 
the Print button.
The print job starts.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the Preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. 
(→ P.3-64)
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Printing Posters (Page Layout) 
After the image is enlarged and divided into several 
sections, you can print the print the sections and paste 
them together to assemble one large poster. 

Note
This function is not provided for OS X. 

1 From the File menu of the software 
application select Print to display the Print 
dialog box.

2 Select the Page Setup panel.
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3 Click the Page Layout checkbox on and 
select Poster (2x2) from the list. 
In the Preview confirm the appearance of the image 
of the selected page layout.

4 If you do not need to print one of the panels 
of the divided image, click the Pages to 
Print checkbox to remove the checkmark for 
the panel that you do not want to print. 

Note
The pages selected for printing are displayed in the 
print image Preview and the pages that have not 
selected for printing are not displayed.
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5 Confirm the content of the Preview, then 
click the Print button.
The print job starts.

Note
To achieve the best print results, you should confirm 
the appearance of the original in the Print Preview 
before printing. For more details about how to display 
the Preview, please refer to “Confirming the Print 
Image (Print Preview)” in “Before You Begin”. (→ P.3-
64)

Vertical and Horizontal Banner Printing 
(Long Prints) 

Matching the Width of the Roll
Once you become familiar with fitting images to the full 
width of the roll with your software application, it is very 
easy to print vertical and horizontal banners. 
Here we will describe as an example how to take a 250 
mm x 600 mm original and enlarge to fit a 24” roll 
(approximately 610 mm wide), and then print it as a ban-
ner (600 mm x 1,440 mm). 

Note
With this printer you can print a banner up to 18,000 
mm maximum length (2,774 mm with OS 8/9). 
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1 Start the software application.

2 From the File menu select Page Setup to 
open the Page Setup dialog box. 

3 Set the Format for (OS 8/9 does not have 
this setting). 



3- 96

Printing from Macintosh
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

4 Select Custom Paper Size (Media Design 
for OS 8/9). 

5 Click the New button then define the media 
name and size (for OS 8/9, define the media 
name and size then click Add button).

Note
Enter Poster here for the name of the media.

6 Click the Save button (this step is not 
required with OS 8/9).
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7 Select the Page Attribute panel.

Note
Once you have registered the size in the Custom 
Paper Size panel (Media Design for OS 8/9), the size 
settings are stored under the specified name and the 
name is displayed in the list. For more details about 
the Custom Paper Size panel (Media Design panel 
for OS 8/9), see “Custom Sizes (User Print Settings)”. 
(→ P.3-121)

8 Select the media defined with custom settings.
a For Page Size on the Custom Paper Size (Media 

Design for OS 8/9) panel, select the name of the 
user defined custom settings.

b For the banner select Orientation, select the 
Landscape icon, click the OK button to close the 
Page Setup dialog box.
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9 Create the original in the software application. 

10 After the original is created, from the File menu select Print to open the Print dialog box. 

11 When the Main panel displays, select Long Format (Banner) for the Print Preferences for the long 
print. 
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12 Display the Finishing (Page Setup for OS 8/9) panel and select Enlarged/Reduced Printing and 
Fit Roll Paper Width (Fit Roll Width Size for OS 8/9) for the long print. 

13 Confirm the content of the preview, then click the Print button.
The print job starts.

Note
To achieve the best print results, you should confirm the appearance of the original in the Print Preview before printing. 
For more details about how to display the Preview, please refer to “Confirming the Print Image (Print Preview)” in 
“Before You Begin”. (→ P.3-64)
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Printing without Top and Bottom Margins (Conserve Paper)
The white space in the top and bottom margins can be eliminated for printing to save paper. The printer does not feed the 
white space in the margins to save paper. This function can be used only when Roll Paper is selected as the media source. 

Note
You use this method during borderless printing as shown in the illustration below.

Important
This function cannot be used when Banner is selected as the media source.
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1 From the File menu of the software application select Print to display the Print dialog box.

2 Select the Finishing panel.
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3 Select No Spaces at Top or Bottom. 

4 Confirm the content of the preview, then click the Print button.
The print job starts.

Note
To achieve the best print results, you should confirm the appearance of the original in the Print Preview before printing. 
For more details about how to display the Preview, please refer to “Confirming the Print Image (Print Preview)” in 
“Before You Begin”. (→ P.3-64)
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Custom Print Quality
Customizing Print Quality
When you need to frequently perform combined settings for print quality and print speed, you can select Custom Set-
tings under Print Quality and then perform the print quality and resolution settings in the Custom Settings dialog box 
according to the requirements of your requirements.

1 From the File menu of the software application select Print to display the Print dialog box.

2 Confirm that the Main panel is displayed. 



3- 104

Printing from Macintosh
トップ

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

TOP

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

3 From the Print Quality list, select Custom Settings. 
A Set button appears in the lower right corner of the Print Quality group.

4 Click the Set button in the Print Quality group to open the Custom Settings dialog box. 
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5 From the Print Quality list, select the quality settings. 

Note
The print quality settings that you can select for the custom settings are described below.

Important
The items of that are available for selection the print Quality may differ depending on which print media are used. Here 
is a list of the media where Highest under Print Quality is available. 
Heavyweight Glossy Photo Paper, Heavyweight SemiGlos Photo, SemiGlos Photo Paper, Glossy Photo Paper
If one of the types of media below is selected, Draft cannot be selected under Print Quality.
Premium Matte Paper, Glossy Photo Paper, SemiGlos Photo, Heavyweight Glossy Photo Paper, Heavyweight SemiG-
los Photo, Synthetic Paper, Adhesive Synthetic Paper, Backlit Film, Flame-Resistant Cloth, Japanese Paper Washi, 
CAD Translucent Matte Film

Print Quality Content

Highest Prioritizes attaining the highest image quality for printing.

High Prioritizes attaining high image quality for printing.

Standard Attains a stable image at an average printing speed.

Draft Prioritizes high printing speed but you should check layout and other aspects of the 
image after printing.
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6 Confirm the resolution. 

Important
The resolution is set automatically depending on which print quality item is selected as shown below. If you need to 
change the resolution you can perform so with the setting under Print Quality.

7 Click the OK button to close the Custom Settings dialog box.

Note
In OS 8/9 if you select Enhance Text With Photos in the Custom Settings dialog box then when you have text mixed 
with photos or graphic data, the resolution of the text will be raised (this function is not available for OS X). 
Only the Halftones and Error Diffusion custom settings can be set. Error diffusion arranges non-standard pixels and 
displays them as gradations (halftones). This setting is ideal for photographs or graphic images that require printing 
with fine gradations. 

Print Quality Resolution Content

Highest, High Fine
(600 dpi)

Print speed is slower due to the higher resolution setting. Achieves the best printing 
results, but printing time is longer and a large amount of computer memory is 
required.

Standard, Draft Quick
(300 dpi)

Print speed is faster due to the lower resolution setting. Printing time is shorter and 
not as much computer memory is required.
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Fine Adjusting Color for Printing
Adjusting Color
Basically the color settings of the software application have priority, but if the results of a print job are not what you want 
you can also adjust color in the printer driver. 
You can also take color photos captured with a scanner or a digital camera, or any other color image, and print them in 
monochrome. 
Now we will describe the color adjustments. 

1 From the File menu of the software application select Print to display the Print dialog box.

2 Confirm that the Main panel is displayed. 
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3 On the Main panel select Color Mode then Color. 

Note
Color Mode presents these following items for selection. 

Color Mode Content

Color Prints in color.
Monochrome 
(Photo):

Provides stable monochrome photo printing with minimal tone change and enables detailed 
adjustment of gray scale gradations and color tones.

Monochrome Prints in monochrome.

Solid Color Prints with only a limited number of colors. Use this setting when you need fine lines with light 
colors in a sharp image.

Black Only All colors other than white are printed black.
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Important
Monochrome (Photo) can be selected for Color Mode only if one of the following types of paper is selected:
Glossy Photo Paper/Semi-Glossy Photo Paper/Heavyweight Glossy Photo Paper/Heavyweight SemiGlos Photo 
Paper/Fine Art Photo/Fine Art Heavyweight Photo/Fine Art Textured/Japanese Paper Washi

4 Press the Set button.

Note
Manual Color Settings are enabled when Color, Monochrome (Photo), or Monochrome is selected for Color 
Mode.
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5 The Color Settings dialog box opens.

6 Confirm that the Color Adjustment panel is displayed, then click the Object Adjustment button. 

The Object Adjustment dialog box opens. 

Note
This function is not provided for OS X, Step 6 to Step 8 are not required.
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7 Select the item that you want to adjust: Images, Graphics, or Text.

Note
Note that for this printer driver all the items (Images, Graphics, Text) are selected as the default settings.

8 Click the OK button to close the Object Adjustment dialog box. 

9 Drag the slide bar to the left or right for the item that you want to adjust. You can also enter the value 
directly or use the arrows of the spinbox to raise or lower the value. 
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Note
The Color Adjustment panel presents the following items for selection. 

Important
As you change each item on the panel, the image of the Preview on the left changes to reflect the adjustment. The 
Original shows the appearance of the initial settings, and the Preview reflects the current settings. 

10 Click the OK button to close the Color Settings dialog box. 

Color Adjustment Content

Cyan

You can calibrate the hues for Cyan, Magenta, Yellow.Magenta

Yellow

Brightness Adjusts brightness from the darkest to brightest colors so none are lost in the brightness of the 
printed image.

Contrast Adjusts the relative contrast from brightest to darkest colors.

Saturation Adjusts the vividness of colors from dull to extremely vivid.
Gray Tone 
Adjustment Adjusts grayscale from cool colors (blue tones) to warm colors (red tones).
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Color Matching 
When you print an image captured with a scanner or a digital camera, sometimes the appearance of the printout does not 
match what you see on the screen. 
This is caused by differences between the display color and the printed color. In the Color Settings dialog box you can 
use the items on the Matching panel, that is, select an ICC (International Color Consortium) color profile, or select a 
matching mode or input profile, or printer profile settings, to have the hues of the colors on the screen more closely 
resemble the colors in the printout. 

1 From the File menu of the software application select Print to display the Print dialog box.

2 Confirm that the Main panel is displayed. 



3- 114

Printing from Macintosh
トップ

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

TOP

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

3 On the Main panel select Color Mode then Color. 

Note
Color Mode presents these following items for selection. 

Color Mode Content

Color Prints in color.
Monochrome 
(Photo):

Provides stable monochrome photo printing with minimal tone change and enables detailed 
adjustment of gray scale gradations and color tones.

Monochrome Prints in monochrome.

Solid Color Prints with only a limited number of colors. Use this setting when you need fine lines with light 
colors in a sharp image.

Black Only All colors other than white are printed black.
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Important
Monochrome (Photo) can be selected for Color Mode only if one of the following types of paper is selected:
Glossy Photo Paper/Semi-Glossy Photo Paper/Heavyweight Glossy Photo Paper/Heavyweight SemiGlos Photo 
Paper/Fine Art Photo/Fine Art Heavyweight Photo/Fine Art Textured/Japanese Paper Washi

4 Press the Set button.

Note
Manual Color Settings are enabled when Color, Monochrome (Photo), or Monochrome is selected for Color 
Mode.
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5 The Color Settings dialog box opens.

6 Select the Matching panel. 
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7 From the Mode list, select the matching mode. 

Note
Here is a list of the available matching modes.

Matching Mode Content

Driver Correction Calibrates color using the original color profile of the printer driver.

ICC Correction Calibrates the color in the printer driver using the standards of ICC color profiles. When this 
mode is selected, this specifies the entry profile and printer profile.

ColorSync Select for correction the color management system provided with the Mac OS. When this 
mode is selected, this specifies the printer profile.

No Correction
Does not execute color matching. The color matching is performed in the software application 
or performed by an independent color profile; select when you want the color matching of the 
printer driver to be ignored.
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Important
The mode you select for the Mode affects what items are available for selection.
If you select the Driver Correction, only the Matching Method is available for selection.
For OS 8/9, If you select ICC Correction you can adjust Images, Graphics and Text for the Matching Method. Also, 
if you select Use Common Input Profile for All Objects, then the Images, Graphics, and Text all apply to one profile 
(this function is not available for OS X). 

8 When ICC Correction is selected for the Mode, at Images under Input Profile Settings select a 
profile from the Input Profile list. 

Note
When Use Common Input Profile for All Objects is selected, the same input profile is selected automatically for both 
Graphics and Text.
If you want to perform different settings for Graphics and Text, then you must cancel the selection of Use Common 
Input Profile for All Objects.
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9 Click the input profile Matching Method list and select a matching method.

Note
Matching Method presents the following items for selection.

Matching Method Content

Auto

Makes the best matching selections for the Image, Graphics, and 
Text items.
*Not provided for OS X.
*This item can selected only when Driver Correction or ColorSync 
is selected.

Perceptual Achieves the best results with priority on color perceptual.

Saturation Achieves the best results with priority on color saturation.

Colorimetric Faithfully reproduces the input data. Performs white color 
calibration, so there is no color when white data is output.

Absolute Colorimetric Faithfully reproduces the input data. No white point correction is 
done.
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10 From the Printer Profile Settings list, select a printer profile.

Important
A print profile can be selected only when ICC Correction or ColorSync is selected under the Mode. 

11 Click the OK button to close the Color Settings dialog box. 
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Custom Sizes (User Print Settings) 
Creating Custom Sizes
In the software application you can define original media 
sizes and save them. Once a custom size has been 
defined, it will be listed along with the standard sizes and 
be available for selection. 

1 Select Page Setup from the File menu.

Note
The setup method is different for some software 
applications. 

2 The Page Setup dialog box opens. 
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3 Set the Format for (OS 8/9 does not have 
this setting). 

4 Select Custom Paper Size (Media Design 
for OS 8/9). 
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5 Click the New button to define the user 
defined name, the media size and margins 
(for OS 8/9 click, define the user defined 
name, media size and other settings, then 
click the Add button).

Note
When you select the desired size and name from the 
Media Size list on the left, the Width (Wid. for OS 8/9) 
and Length (Hght for OS 8/9) are entered 
automatically.
For OS 8/9, If Borderless Printing is selected, the 
selection for Wid. changes automatically to a roll width 
list that supports borderless printing. Select a Wid. 
setting for the width of the desired roll, then enter a 
number for the Hght that you want. (This function is 
not provided for OS X.)

6 Click the Save button. (Not required for OS 
8/9)

7 Click the OK button to close the dialog box. 

Note
If you are using OS 8/9 you are allowed to store up to a 
maximum of 5 custom settings.
The settings in the Custom Paper Size panel (Media 
Design for OS 8/9) box remain in effect even after the 
software application is closed.
To delete a registered custom size, select the name of 
the custom size to delete, then click the Delete button. 
To edit a registered custom size, select the name of 
the custom size, then input the Width and Height 
settings again. (this editing and correction cannot be 
performed for OS 8/9)
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Selecting a Media Display Series
In Display Series on the Media Design panel, you can 
select a display series that will display for the Page Size 
on the Page Attribute panel and for Media Size in the 
Print dialog box.

Note
This function is not provided for OS X. 

To display a paper size series for selection for Media 
Size in the Print dialog box, or for Page Size on the 
Page Attribute panel, you must select Display Series 
with a check mark on the Media Design panel. Also, if 
you want to cancel a size series selected for display, just 
click check box to remove the check mark for the Dis-
play Series selection.
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When the Printout Quality Is Not Clean
How to Set the Media Type
You can use the printer operation panel to perform suitable settings for the ink drying time of each media and other fea-
tures. These settings can also adjusted with the items in the Media Detailed Settings dialog box in the printer driver. If 
the printouts are not clear, you may be able to correct the problem by adjusting the settings in this dialog box. 
For more details about the Media Detailed Settings dialog box, please refer to the online Help. 
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Software Provided for Macintosh
The following software applications are provided for use 
with Macintosh. 
The function of each software application is described 
below. 

Basic Software for Printing
imagePROGRAF Printer Driver 2005

This is a software application that required for the 
printer to print. This must be installed on every 
computer that will use the printer. The printer driver not 
only allows the printer to print, the driver also provides 
many other important functions such as enlargement/
reduction, borderless printing, color adjustment, 
multiple copy printing, and others. 
The printer driver is stored on the provided User 
Software CD-ROM for Mac OS 8.6/9.x and Mac OS X. 

Displaying the Printer Status
GARO Printmonitor

This is the utility software that displays details about 
printer errors on the Macintosh. This utility is installed 
together with the printer driver. 

Using the Printer on a Network
Remote UI

This software is used to set up the network 
information, display the status of the printer, delete 
print jobs, and display the print job history. This 
software is stored in the printer ROM, and settings are 
performed from the computer with a Web browser 
over the network using a specified printer IP address. 
(→ Chapter 5 “Using the Printer in a Network 
Environment”)
If you use a Remote UI, you must set the IP address in 
the printer.

Printing Beautiful Digital Camera Images 
(for the Professional)
imagePROGRAF Print Plug-In for Photoshop

imagePROGRAF Print Plug-In for Photoshop 
(hereafter "Print Plug-In) makes it possible to 
reproduce and print the vivid RGB color of Adobe 
created in PhotoShop. This software is intended for 
professionals and high-end users who want to obtain 
the best finished color hues.
After installation of Print Plug-In, you can view a 
Preview within PhotoShop that allows you to confirm 
how faithful the colors are reproduced and then adjust 
them. Because you can process RGB 16-bit data just 
as it is with PhotoShop, you can print without losing 
the high color gradations of the originals. Also, you 
can save the used settings so when you want to print 
with the same settings you only have to open and read 
that information to print again. 
(→ Print Plug-In for Photoshop Guide)
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Select the Media Type
Media Configuration Tool

Media Configuration Tool is the software used to 
register information about print media (paper, film, 
etc.) that can be used with the printer as it becomes 
available. The functions of this software are provided 
for users who have an in-depth knowledge of printers 
and print media. 
You an use this software to upload and download 
media information to and from the printer about media 
names, thickness, printhead height, suction fan 
strength, default margins, and other information. A 
function is also provided that allows the user to 
acquire the most recent information about media for 
printing when using the printer connected to a 
network. 
This is installed together with the printer driver.
(→ Media Configuration Tool Guide)

Important
If you are using the Remote UI with Mac OS 8.6/9.x, 
open TCP/IP on the Control Panel and make sure 
that Built-in Ethernet is selected for the Connect via.
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Replacing Ink Tanks
When the supply of ink in an ink tank runs low, a message 
appears on the operation panel display or on the printer 
driver screen to tell you that it is time to replace the ink tank. 
You can change any one of the ink tanks among the seven 
when it runs out of ink: Yellow (Y), Magenta (M), Photo 
Magenta (PM), Cyan (C), Photo Cyan (PC), Photo Black 
(BK), and Matte Black (MBK). 

How to Confirm Ink Levels
You can confirm the ink level at any time by checking the 
printer operation panel display. You should always check 
the ink levels in the ink tanks and replace any ink tank that 
is low before starting a long print job or any other job that 
will consume a large amount of ink.

Online Status Display

The ink levels are displayed in the bottom line of the dis-
play from left to right in the following order: Black (K), 
Photo Cyan (PC), Cyan (C), Photo Magenta (PM), 
Magenta (M), Yellow (Y).

Yellow Ink
Magenta Ink
Photo Magenta Ink
Cyan Ink
Photo Cyan Ink
Photo Black Ink
Matte Black Ink

BCI-1451Y
BCI-1431M
BCI-1431PM
BCI-1431C
BCI-1431PC
BCI-1431BK
BCI-1451MBK

Online
Bk



4- 3

Replacing Ink Tanks
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Information Button Display 

You can check the ink level at any time (during a print job 
or while an error is displayed) by pressing the Informa-
tion button. The ink levels are displayed from left to right 
in the following order: Black (K), Photo Cyan (PC), Cyan 
(C), Photo Magenta (PM), Magenta (M), Yellow (Y).

How to Read the Ink Level Display
The height of a small graphic  indicates the ink level in 
each tank.

When to Replace an Ink Tank
You should have extra ink tanks on hand ready for 
replacement when either of the conditions below occurs.

Important
An ink tank cannot be replaced during printing 
because the right cover is locked.
The printed image may become uneven if the printer is 
stopped during a print job to replace an ink tank.
Never open the right cover or operate the release lever 
while the Initializing message is displayed. This could 
damage the printer.

When the Check Ink Level Message is 
Displayed
The Check Ink Level message displays when the ink 
level in a tank becomes low. Printing may continue. The 
message display tells you that an ink tank is about to run 
out of ink. Check the amount of ink remaining in the 
tanks in the Status Monitor (Windows), Printmonitor 
(Macintosh) or on the printer operation panel, and make 
sure that you have replacement ink tanks for the colors 
that are running low.

Note
When the level of ink in a tank runs low, the printer 
may not have sufficient ink to complete Cleaning B or 
another maintenance operation that consumes a large 
amount of ink. In such a case, perform print head 
cleaning after replacing the ink tank.

Ink
Information Power

Cleaning

100%
(100~90%)

80%
(90~70%)

60%
(70~50%)

40%
(50~30%)

20%
(30~6.9%)

0%
(6.9~0%)
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When the Rep. Ink Tank (Replace Ink 
Tank) Message Is Displayed
When the ink in a tank runs out, the Rep. Ink Tank mes-
sage displays and the printer stops printing. Replace the 
ink tank as soon as this message appears. When you 
open the right cover, you will see the amount of ink 
remaining for each color along with its notation (Y= Yel-
low, M= Magenta, PM= Photo Magenta, C= Cyan, PC= 
Photo Cyan, Bk= Photo Black/Matte Black). A flashing 
color display means the ink tank of that color should be 
replaced.

Note
If more than one color has disappeared, replace the 
ink tanks of the missing colors to recover printing.

Ink Tank Handling Precautions
Obey the following precautions when you handle ink tanks.

Caution
Always store ink tanks in a safe location where they 
are out of the reach of small children. If a child licks or 
ingests ink accidentally, seek medical assistance 
immediately.

Important
Before installing an ink tank, slowly rotate it from side 
to side about 7 or 8 times before breaking its seal. If 
you do not shake the tank the ink will precipitate, 
causing a deterioration in the print quality.
After breaking the seal on an ink tank, avoid dropping 
or shaking it. Spilled ink can stain the work area.
The ink supply ports of empty ink tanks may be 
covered with ink. Always handle ink tanks carefully. 
The ink could spill on your clothing and make stains 
that cannot be removed.
An ink tank should be used up within six months after 
its seal has been broken or after it has been removed 
from its package. After this time period has elapsed for 
the ink tank, this could cause the quality of printing to 
deteriorate.
Never leave an ink tank removed from the printer for a 
long period (over one month). The ink could clog and 
lead to poor print quality.
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Replacing an Ink Tank
Follow the procedure below to replace an ink tank. You can 
follow this same procedure to replace any ink tank.

Caution
Always confirm that the replacement ink tank is the 
same type as the tank that is installed in the printer. If 
you mistakenly exchange a Photo Black ink tank and a 
Matte Black ink tank, this could damage the printer. To 
change the type of black ink tank, you must execute 
ChangeBkInkType on the printer operation panel and 
then exchange the black ink tanks. (→ P.4-47)

1 Look at the printer display and make sure 
that the printer is not operating.
You can replace an ink tank while the display shows 
any of the following: Online, Offline, Check Ink 
Level, or Rep. Ink Tank.

2 Open the right cover.

The ink level is shown in the display; a flashing color 
means that the ink tank of that color must be 
replaced.

Important
The right cover cannot be opened while the printer is 
initializing immediately after the printer is switched on, 
during printhead cleaning, or during a print job. Please 
wait until processing is completed.

Error!                E02818
Rep. Ink Tank

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Offline
Please Wait...

Ink

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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3 Press the ink tank lever of the color to 
replace, then open the ink tank cover.

4 Hold the empty ink tank by the grips on the 
left and right side of the ink tank, then 
remove it.

Place each ink tank in a vinyl or plastic bag and seal it.

Important
If ink remains in a removed ink tank, store the ink tank 
with the ink supply port (a) pointing up. Ink leaked from 
ink tanks will stain the work area.

5 Slowly rotate a new ink tank still in its 
package 7 or 8 times, then remove it from its 
package.

Important
Always confirm that the replacement ink tank is the 
same type as the tank that is installed in the printer. If 
you mistake a Photo Black Ink tank for a Matte Black 
Ink tank, this will cause poor print quality. To change 
the type of black ink tank, you must execute 
ChangeBkInkType on the printer operation panel and 
then exchange the black ink tanks. (→ P.4-47)
Always hold an ink tank by its left and right grips (b) 
while you are handling it.

Never touch the ink supply port (a) or the electrical 
terminal (c). This could damage the ink tank, cause 
poor print quality, or stain the work area.

a

b

a
c
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6 With the ink supply port facing down and the 
label facing front as shown, insert the ink 
tank into its holder.

7 Close the ink tank cover until you hear it 
catch.

Important
The ink tanks are shaped so the cover will not close If 
you set the wrong ink tank in a holder. If the ink tank 
cover does not close, confirm that the color labels on 
the holder match the color of the ink tank and the 
direction of the ink tank.

8 To replace an ink tank of any other color, 
repeat Step 3 to Step 7.

9 When you finish replacing ink tanks, close 
the right cover.

The printer returns to the Online or Offline mode. 
Printing restarts if the Rep. Ink Tank message 
displayed during a print job.

Important
If an ink tank has not been installed, then in the printer 
display you will see a Exxxx error code in the top line 
and the No X Ink Tank message in the bottom line. Go 
to Step 2 to correct this problem and make sure that all 
the color ink tanks are installed.
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Cautions About Using Refilled Ink Tanks for This Printer
Ink tanks specified for use with the printer provide an ink 
level detection function where the printer can detect when 
ink runs out during printing to prevent damage to the 
printhead.
If you use a refilled ink tank, the ink level detection function 
will no longer function correctly, and the printer will halt 
when ink runs out. Before you can use tanks like this, you 
must switch off the ink level detection function.
If you print with the ink level detection switched off, this 
could damage the printer (especially the printhead) or 
cause other problems. Canon, Inc. can assume no 
responsibility for damages caused by using ink tanks not 
designed for use with the printer. 

Caution
Once the ink level detection function is switched off, 
the ink level detection function cannot be recovered for 
the ink tanks in the printer. To recover the ink level 
display, the ink tanks must be replaced with new ink 
tanks designed for use with the printer. 
If the same ink tank is repeatedly removed and 
reinserted, this could damage the connection points 
between the ink tank and the printer, leading to ink 
leakage which could damage the printer.

Switching the Ink Level Detection Func-
tion Off

1 Press the Online button to display MAIN 
MENU.

2 Press the [�] or [�] button to select 
System Setup then press [�].

3 Press [�] or [�] to select Stop Ink Check, 
then press [�].

4 Press [�] or [�] to select Bk Ink Tank etc., 
then press the OK button.

Note
To cancel the procedure of the ink level detection 
function off at any time, just press the Online button.

5 When Stop Function? appears press [�] 
or [�] to select Yes, then press OK button. 
An equals sign (=) appears as a prefix to the setting 
and the ink remains detection function of the 
selected ink tank is switched off. 
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Executing a Print Job
After switching off the ink level detection function, every 
time you execute a print job from the computer the Ink 
level? message appears on the printer operation panel 
display and the printer goes offline. To start the print job, 
just press the Online button on the printer operation panel.
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Cleaning the Printer
Clean the printer periodically to maintain high print quality 
and to avoid problems.
Obey the following precautions when you clean the printer.

Caution
When you clean the printer, always switch the printer 
off and unplug its power cord from the power supply. If 
the printer is accidentally switched on while you are 
cleaning it, moving parts inside the printer could cause 
personal injury if you are touching them.
Never use a flammable liquid like thinner, benzene, 
alcohol, etc. to clean the printer. If such combustible 
materials come into contact with electrical component 
inside the printer, this could cause a fire or electrical 
shock.

Cleaning the Exterior Covers
During normal use the printer surfaces require cleaning at 
least once a month.

1 Hold down the Power button for more than 1 
sec. to display Shut Down.. then switch the 
printer off.

2 Disconnect the power cord at the power supply.

3 Dampen a clean cloth, wring it out 
completely, then use it to clean dirt and 
paper dust from the printer exterior surfaces, 
feed slot (a), and power cord plug, then wipe 
the cleaned surfaces with a dry cloth.

4 Insert the plug of the power cord into the power 
source.

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

a
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Cleaning Inside the Upper Cover
To maintain optimum use of the printer, you should clean 
the interior surfaces of the upper cover when you see the 
print surfaces or back sides of printouts fouled with ink, 
after printing one complete roll, or at least once a month. 
Also, you should clean the printer after replacing media, 
especially after printing on small size media, after a 
borderless printing job or after printing on the paper that 
contains many paper dust.

Important
Immediately after borderless printing or printing on 
small size paper, be sure to open the top cover and 
clean around the platen. You should also diligently 
clean the platen area at other times as well. If the 
platen area is dirty, this could cause ink stains on the 
back sides of printed sheets.

1 Hold down the Power button for more than 1 
sec. to display Shut Down.. then switch the 
printer off.

2 Disconnect the power cord at the power supply.

3 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.Shut Down..

Please Wait..
Data

Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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4 If paper dust has collected in the suction 
ports (a) on the platen and the borderless 
print ink groove (b), use the provided 
cleaning brush to remove the dust and dirt 
from the ports and groove.

Note
Wash the cleaner brush with water if it is dirty.

5 Use a damp cloth (well wrung out) to clean 
the upper cover handles, upper cover rollers 
(c), the area around the platen (d), the paper 
pressure plate (e), the exit guide (f), the 
borderless print ink groove (b), and the 
auxiliary output guide (g). 

Important
Never polish the areas under the upper cover with a 
dry cloth during cleaning. This could create static 
electricity that attracts dust and dirt that could lower 
print quality.

a

b

c

g

d

b

e f
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6 While raising the flexible wire (h) with one 
hand, wipe away the dirt on the flexible wire 
guide (i). 

7 Raise the upper cover stopper to release the 
lock then close the upper cover. 

8 Insert the plug of the power cord into the 
power source.

i

h
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Cleaning the Paper Restraint
To maintain the proper use of the printer, use a piece of 
plain paper to clean the back surface of the paper pressure 
plate when you see the print surface or back surface of 
media fouled with ink, especially before switching from a 
small roll size to a larger size, or once a month.
Before starting this procedure, prepare some plain paper 
(or any media other than film).

Important
The paper you use for cleaning should be plain paper 
that does not easily produce cutting dust. If you use 
film or any type of media that produces cutting dust 
that could hang up, this could lower the print quality.

1 Hold down the Power button for more than 1 
sec. to display Shut Down.. and switch the 
printer off.

2 Disconnect the power cord at the power 
supply. 

3 Push the release lever back to open it, fold a 
sheet of plain paper (a) 2 or 3 times, insert it 
from the back of the printer so it is under the 
paper restraint (b), then use the paper to 
clean the under side of the plate.
Be sure to wipe clean the entire length of the paper 
restraint. When you are finished, pull the release 
lever to the front to close it.

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

a

b
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4 Insert the plug of the power cord into the 
power source. 
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Replacing the Maintenance Cartridge
The maintenance cartridge vacuums excess ink that 
accumulates as a result of borderless printing, printhead 
cleaning, and ink mist produced by other operations. When 
you see the message prompt that tells you to replace the 
maintenance cartridge, replace the cartridge. 

Maintenance Cartridge MC-01

Checking Spacing Remaining in the 
Maintenance Cartridge
You can confirm the amount of space remaining in the 
maintenance cartridge at any time by checking the printer 
operation panel display. You should always check the 
amount of space remaining in the maintenance cartridge 
before Heading Cleaning B, moving the printer, or any other 
operation that could use up space in the maintenance 
cartridge, and then replace the cartridge in advance.

Information Button Display

You can check on how much space remains in the mainte-
nance cartridge at any time (during a print job or error dis-
play) by pressing the Information button. The icon at the 
right end of the bottom line shows you the amount of space 
that remains in the maintenance cartridge.

Reading the Maintenance Cartridge Display
The height of the bar tells you how much more ink the 
maintenance cartridge vacuum and store.

Ink
Information Power

Cleaning

~700ml
(7dot)

~600ml
(6dot)

~500ml
(5dot)

~400ml
(4dot)

~300ml
(3dot)

~200ml
(2dot)

200ml~0ml
(1dot)
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When to Replace the Maintenance Car-
tridge
When the maintenance cartridge becomes full of ink, the 
printer driver screen or the printer operation panel will 
display a message to tell you that it is time to replace the 
maintenance cartridge.

When You See the MTCart Full Soon 
Message
When you see this message, this means that the mainte-
nance cartridge is nearly full. You can continue to oper-
ate the printer. When the MTCart Full Soon message 
appears, this means that the maintenance cartridge is 
about to be full. Obtain a new maintenance cartridge.

Note
While this message is displayed, you cannot replace 
an black ink tank or move the printer. First, you must 
replace the maintenance cartridge.

When You See the Replace MT-Cart. 
Message
This message means that the maintenance cartridge is 
full, and the print job will stop when the Replace MT-
Cart. message appears. Replace the ink tank as soon as 
this message appears.

Note
While this message is displayed, you cannot replace 
the black ink tank, replace the printhead, or move the 
printer. First, you must replace the maintenance 
cartridge.

Online
MTCart Full Soon

ERROR      E02818
Replace MT-Cart.
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Maintenance Cartridge Handling Pre-
cautions
Follow the guidelines below when you handle the 
maintenance cartridge.

Important
Never remove a maintenance cartridge until you are 
ready to replace it.
To avoid ink spills with a maintenance cartridge that is 
full of ink, never drop it and always lay it flat (never at 
an angle). Spilled ink can stain the work area. 
Ink adheres to the top of a used maintenance 
cartridge. Handle maintenance cartridges carefully. 
The ink could spill on your clothing and make stains 
that cannot be removed.
Once a maintenance cartridge has been installed in 
one printer, it cannot be installed in another printer.

Maintenance Cartridge Replacement 
Procedure
Follow the procedure below to replace a maintenance 
cartridge.

Replacing the maintenance cartridge (→ P.4-18)
Replacing the Shaft Cleaner (→ P.4-21)

Replacing the Maintenance Cartridge

1 Look at the printer display and make sure 
that the printer is not operating.

2 Open the maintenance cartridge cover.

ERROR!            E02818
Replace MT-Cart.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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3 Pull out the tabs (a) of the used maintenance 
cartridge and remove it horizontally with the 
handles (b) on both sides. 

Caution
Always store a used maintenance cartridge in a safe 
location out of the reach of children. If a child licks or 
ingests ink accidentally, seek medical assistance 
immediately.

Important
An full maintenance cartridge is heavy. Grip the 
cartridge tightly by the left and right handles (b) and 
hold it level when removing or storing it. If you drop a 
maintenance cartridge or lay it down at an angle, this 
could cause ink to leak and stain the work area.

4 While holding the used maintenance 
cartridge level, slip it into the protective vinyl 
bag that held the new cartridge, press down 
on the bag to expel excess air, then close the 
zipper completely.

Important
In accordance with its active and on-going policy to 
protect the environment, Canon collects used 
maintenance cartridges. Follow the instructions 
provided with the new maintenance cartridge that 
describe how to process the used cartridge.

5 Check the top and bottom of the bag holding 
the used maintenance cartridge, place it in 
the packing box, then store it flat in a safe 
location.

a

b

b
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Important
Be sure to store the removed maintenance cartridge in 
a packing box and store it on a flat surface. An ink leak 
can stain the work area.
Before you place the vinyl bag into the packing box, 
make sure that the zipper is closed completely.

6 Place the new maintenance cartridge into the 
maintenance cartridge cover and make sure 
that it is inserted completely.

Important
Never touch the terminal (c). Touching the terminal on 
the back of the maintenance cartridge could damage 
it.

7 Close the maintenance cartridge cover.

8 Press the Information button.

The initialization of the new maintenance cartridge 
finishes after about 5 seconds, then the printer 
enters the Online or Offline mode.

Important
Never attempt to remove or re-attach the maintenance 
cartridge within 5 seconds after it enters the online 
mode. The maintenance cartridge could be damaged.

Note
The maintenance cartridge can also be replaced with 
the printer switched off. In this case, never attempt to 
remove or re-attach the maintenance cartridge for at 
least 5 seconds after you switch the printer on again.

c�

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Replacing the Shaft Cleaner

1 Press the Online button to display Offline.

2 Hold down the [�] button for more than 1 
second.

The carriage moves to the center and Open Upper 
Cover message appears on the display. 

3 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.

4 Grip the lever of the shaft cleaner and pull it 
toward you. 

5 Remove the cap of a new shaft cleaner 
provided with the maintenance cartridge. 

Note
Remove the cap from a new shaft cleaner and attach it 
to the used shaft cleaner, place the used shaft cleaner 
in its box, place it in the original box with the used 
maintenance cartridge, and dispose of them together.

Data
Information Power

Offline
Menu

Message
Offline
              Feed Paper

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Data
Information Power

Offline
Menu

Message
MAIN MENU
Chng Head Hght

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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6 Install the new shaft cleaner into the 
carriage. 
Push in the shaft cleaner until you hear it catch.

7 Raise the upper cover stopper to release the 
lock then close the upper cover.

The carriage returns to the home position and the 
printer enters the Online mode.
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Replacing the Printhead
Replace the printhead if two consecutive Head Cleaning B 
executions do not restore acceptable print quality, if 
ERROR E02813 is displayed, or if a customer service 
center instructs you to replace the printhead. You can easily 
stain your hands during printhead replacement, so wear the 
plastic gloves provided in the box with the new printhead.

Printhead BC-1350

Note
When the ink supply runs low in an ink tank, procure a 
new ink tank for replacement as soon as possible.

Printhead Handling Precautions
Always follow these precautions when handling a 
printhead.

Caution
Always store a printhead in a safe location where it is 
out of the reach of small children. If a child licks or 
ingests ink accidentally, seek medical assistance 
immediately.

Never touch a printhead immediately after printing has 
stopped. A printhead becomes extremely hot during 
printing and can cause minor burns.

Important
Try to avoid dropping or shaking a printhead. Spilled 
ink can stain the work area.
The ink supply port of a removed printhead may be 
covered with ink. Always handle a printhead carefully. 
The ink could spill on your clothing and make stains 
that cannot be removed.
Never break the seal on a printhead package until 
immediately before you install the printhead. Always 
handle a printhead carefully after breaking its seal. If a 
printhead is stored with its seal broken this can cause 
the nozzles to dry and lead to poor print quality.
If you need to store a printhead temporarily, set it with 
its nozzles (a) and electrical contact points (b) pointing 
down. Damage to the nozzles or electrical contacts 
can lead to poor print quality.

Never attempt to disassemble or alter a printhead. 
This could damage the printer.
Never touch the nozzles (a) or the electrical contacts 
(b) on the printhead. This could cause poor paper 
feed.

a

b
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How to Replace the Printhead
To replace the printhead, execute Replace P.head on the 
Maintenance menu then follow the messages on the 
printer operation panel display to perform the procedure. 
Before you adjust the position of the printhead after 
replacing it, make sure a roll or cut sheets A3 (L) size or 
wider is loaded in the printer. 

Remove printed and other media from the platen.
Clean the paper pressure plate. (→ P.4-14)
Execute Replace P.head
After ink has drained from the printhead, remove it.
Install the new printhead.

Important
Always follow the prescribed procedure to replace a 
printhead. If you fail to follow the prescribed 
procedure, this could cause the printhead to leak ink 
that will stain the printer and the work area. 

1 If the printer power is off, press the Power 
button to switch the printer on. 

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Maintenance, 
then press [�].

4 Select Replace P.head then press [�].

5 Press [�] or [�] to select Yes, then press 
OK button. 

Printhead replacement processing starts when you 
see Please Wait.. displayed. The processing 
requires about 3 minutes to complete. 

When preparation is finished, Open UpperCover is 
displayed.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Maintenance ↓

Maintenance
Replace P.head ↓

Replace P.head
  Yes

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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6 Open the upper cover.

Rep. P.head OK is displayed on the printer 
operation panel. 

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.
Before you start the procedure, wring out a damp cloth 
and clean the carriage cover, printhead cover, and 
printhead lock lever if they are dirty. 

7 If the printhead adjustment lever is in either 
the high or low position, return it to the center 
(normal) position, then raise the carriage 
cover completely.

8 Raise the carriage cover so it is completely 
open.
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9 Pull the printhead lock lever completely 
forward to open it.

10 Raise the printhead lock cover completely to 
open it.

11 Remove the old printhead.

Caution
If you are going to replace the printhead immediately 
after printing, wait a few minutes before performing the 
replacement. The metal components of the printhead 
may be hot immediately after printing, and touching 
these parts could cause a minor burn. 

Important
Never touch the carriage terminal. This could damage 
the printer.
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12 While holding the new printhead by the grips 
(c), remove it from its package; remove the 
orange protective cap 1 (d), then on both 
sides of protective cap 2 (e), while pressing 
in both grips (f) as shown, pull down to 
remove the cap. 

Important
The inside surface protective cap 2 (e) is covered with 
ink to protect the nozzles. Do not touch this area of the 
cap or drop it. Performing so could cause problems. 
When handling the printhead, always hold it by the 
grips (c) on the left and right sides.
Never touch the nozzles (a) or the electrical contacts 
(b). This could damage the printhead, cause poor print 
quality, or stain the work area. 

Never try to re-attach the protective caps or packing 
material removed from the printhead.

13 With the nozzles pointing down and the 
electrical contacts facing the printer, insert 
the new printhead into the carriage.
Handle the printhead carefully so its nozzles do not 
touch the carriage, then press down to ensure that it 
is installed completely.

14 Pull the printhead lever toward you and down 
to lock the printhead in place.

c

d

e

f

f

a

b
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15 Push the printhead lever toward the back of 
the printer and down, then press down until 
you hear it click and lock. 

16 Lower the carriage cover and press down 
until you hear it click and lock.

17 Raise the upper cover stopper to release the 
lock then close the upper cover.

As soon as you close the upper cover of the printer, 
Please Wait.. is displayed in the bottom line of the 
display and processing begins. The processing 
requires about 10 minutes to complete. 

As soon as processing is finished, Advanced Adj. is 
displayed and the printhead is adjusted 
automatically. (→ P.4-40)

Important
The printhead adjustment does not execute if the Auto 
Print feature on the Main menu is set to Off. After 
replacing the printhead, perform Advanced Adj. under 
Auto Head Adj. on the printer operation panel to 
adjust the printhead automatically. (→ P.4-40)
The printhead adjustment cannot be performed if the 
loaded roll paper or cut sheets are not at least A3 (L) 
size or larger. Printhead adjustment continues as soon 
as the media is set. 
Never attempt to remove an ink tank when the ink 
tanks are filling during the installation procedure and 
immediately after replacing the printhead, or during the 
printer cleaning operation.
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Replacing the Cutter Blade
Follow the procedure below to change the position of a 
blade that no longer cuts cleanly. The cutting position can 
be changed twice for one blade. Once the cutting position 
adjustment dial is set to 3, replace the blade with a new 
one. 

Cutter Blade CT-02

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to display System Setup 
then press [�].

4 Press [�] or [�] to select Change Cutter, 
then press [�].

5 Press [�] or [�] to select Yes, then press 
OK button.

Carriage Moving appears in the bottom line of the 
display, and Open Upper Cover appears after the 
carriage moves to the center of the platen.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
System Setup ↓

System Setup
Change Cutter ↓

Change Cutter
  Yes
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6 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.
If the cutter blade or the carriage is dirty, before you 
perform the procedure to adjust the operation of the 
cutter blade, wring out a damp, clean cloth and use it 
to clean the cutter blade and the carriage.

7 Grasp the cutter blade (a) by the grips then 
remove it from the carriage. 

Important
After removing the cutter blade, never touch the 
cutting edge (b). This could cause personal injury. 

8 Rotate the cutter position adjustment dial 1 
notch in the direction shown.
If the dial is already at notch 3 replace the cutter 
blade with a new one.

Note
The position adjustment dial has 3 positions that can 
be adjusted; the blade can be used at three steps (1, 
2, 3). The blade cannot be used with the dial returned 
to a position.
Once you have set the cutter blade dial to position 3, 
procure a new cutter blade for future replacement.

a

b
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9 Install the cutter blade back into the carriage. 

Note
To remove the protective cap from a new cutter blade, 
turn the cap in the direction of the arrow. Also, you 
must attach the removed cap to the used cutter blade 
and discard the used blade in accordance with local 
laws and regulations.

10 Raise the upper cover stopper to release the 
lock then close the upper cover.

Please Wait.. appears in the bottom line of the 
display, the carriage moves, then the Reset Cut 
Count message displays. 

11 Once you have set the cutter position dial to 
2 or 3 and pressed the Stop button and 
replaced the cutter blade, press the OK 
button.

The printer returns to the Online or Offline mode.

Reset Cut Count
Press/OK Stop
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Transporting the Printer
Before you transport the printer, follow the procedure below 
to prepare the printer for shipping so its internal 
mechanisms are protected. To pack the printer for 
transport, refer to the Quick Start Guide and follow the 
installation procedure in reverse order.
(→ Quick Start Guide)

Important
Before you move the printer always perform this 
procedure by executing the Move Printer menu and 
following the instructions on the display. The printer 
could be damaged if you attempt to move it after 
disconnecting the power cord before switching off the 
printer. If you accidentally disconnect the power cord 
before switching the printer off, reattach the power 
cord, reinstall the ink tanks, then perform the 
procedure again from Step 1. (→ Quick Start Guide)
You cannot execute Move Printer once the MTCart 
Full Soon or Replace MT-Cart appears. You can 
execute Move Printer after the maintenance cartridge 
has been replaced.
Never tilt the printer while you are moving it. This could 
spill ink inside the printer and foul the work area.
If you cannot avoid tilting or standing the printer on end 
in order to move, please contact the dealer where you 
purchased the printer or the nearest service center.

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Maintenance, 
then press [�]. 

4 Press [�] or [�] to select Move Printer 
then press [�].

MAIN MENU
Maintenance ↓

Maintenance
Move Printer ↓

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press [�] or [�] to select Yes, then press 
OK button.

Open RightCover is displayed.

6 Open the right cover.

Remove Ink Tank is displayed on the operation 
panel.

7 Open the ink tank covers and remove all of 
the ink tanks.

Place each ink tank in a vinyl or plastic bag and seal 
it.

Note
Store the removed tanks with the ink supply ports up 
(a). Ink leaked from ink tanks will stain the work area.

Move Printer
  Yes

a
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8 Close and lock all the ink tank covers and 
close the right cover.

Please Wait.. appears followed by Ink Draining 
while the ink is sucked from inside the tubes. This 
processing requires about 4 minutes to complete. 

The printer switches off automatically once 
processing is completed. 

9 Disconnect the power cord and the interface 
cable. 

10 Remove the roll holder.

11 Lower the lever of the holder stopper, 
remove the stopper, remove the roll from the 
roll holder, then store the roll holder and the 
holder stopper.

12 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
This could damage the printer.
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13 Clamp the belt with the belt stopper then use 
the hex wrench to fasten the belt stopper. 

Note
Attach the belt stopper that was removed at installation 
and stored.

14 Raise the upper cover stopper to release the 
lock then close the upper cover.

15 Tape each printer cover in the reverse order 
of tape removal during setup.

16 If you are using the optional stand, follow the 
installation procedure in reverse to remove it.

17 Remove the printer in reverse order of setup 
procedure.

18 If you are using the stand, follow the 
installation procedure in reverse to 
disassemble it.

19 Reattach the tapes and shipping materials to 
the roll holder and printer, then pack them in 
the original shipping box.

This completes preparing the printer for moving.

Important
Follow the procedures in the Quick Start Guide to re-
install the printer at the new location after moving the 
printer.
If you execute Move Printer and then unplug the 
power cord from the power source before switching 
the printer off, this could damage the printer. Connect 
the power cord, install the ink tanks, and perform the 
procedure again from Step 1.(→ Quick Start Guide)
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Checking the Condition of the Printer
When you see that the printouts are faded and uneven, or 
streaked with white lines, print a nozzle check pattern to 
determine whether the nozzles are blocked. Before you 
print a nozzle check pattern, make sure roller paper or cut 
sheets A3 (L) size or wider are loaded in the printer. 

Note
If you are using cut sheets, make sure at least one 
sheet of unused A3 paper (not the blank sides of used 
paper) or larger are set.

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Test Print then 
press [�].

4 Press [�] or [�] to select Nozzle Check, 
then press OK button.

The nozzle check pattern prints. The printer returns 
to the online mode and displays Online in the 
display as soon as printing completes. 

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Test Print ↓

Test Print
Nozzle Check

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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If there are no breaks in the horizontal lines of each 
color, the nozzle check pattern is normal.
•Sample: Printhead Operation Normal

•Sample: Printhead Operation Not Normal

If any of the lines are broken, perform the following 
procedure:

1. Execute printhead cleaning. (→ P.4-38)
2. Print the nozzle check pattern again.
3. If the nozzle check patterns are still broken 

after repeating this procedure several times, 
call the dealer where you purchased the 
printer or call the nearest service center.
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Cleaning the Printhead
If the nozzles become blocked, cleaning the printhead may 
recover optimum printer operation.

Note
When you set Nozzle Check, the printer performs a 
nozzle check and recovery automatically for every 
page specified for printing. Before shipping a printer, 
the setting is set for 10 Pages. 

Types of Printhead Cleaning
There are two methods for printhead cleaning.

Head Cleaning A:
Execute when printing appears uneven, or when the 
printhead is dirty. This cleaning method consumes the 
least amount of ink. Head Cleaning A requires about 1 
minute.

Head Cleaning B:
Perform this cleaning if no ink is coming out of the print-
head or if Head Cleaning A did not correct the problem. 
Head Cleaning B requires about 3 minutes. 

Printhead Cleaning Procedures
Follow this procedure to clean the printhead. The procedure 
is almost the same for each cleaning method.
If one execution of Head Cleaning A does not correct the 
problem, perform Head Cleaning B. If Head Cleaning B 
does not correct the problem, repeat Head Cleaning B two 
or three times. If the printer operation does not recover after 
performing Head Cleaning B, the printhead may be at the 
end of its service life. Call for service or contact the dealer 
where you purchased the printer. (→ P.4-23)

Note
You can execute Head Cleaning A by holding down 
the Information button for more than three seconds. 

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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2 Press the Online button to display MAIN 
MENU.

3 Select Head Cleaning then press [�].

4 Press [�] or [�] to select the printhead 
cleaning method then press OK button.

Printhead cleaning starts. When printhead cleaning 
is finished, the printer returns Online. 

5 Print the nozzle check pattern to determine if 
printing has been recovered. (→ P.4-36)

MAIN MENU
Head Cleaning ↓

Head Cleaning
Head Cleaning A

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Aligning the Printhead

If printed vertical lines are bent, or if the colors are faded 
and uneven, perform the printhead position adjustment. 
The printer will adjust the position of the printhead 
automatically as it reads the pattern used to adjust the 
position of the printhead. Before you adjust the position of 
the printhead, make sure a roll or cut sheets A3 (L) size or 
wider are loaded in the printer.
Use the following procedure to adjust the position of the 
printhead.

Note
When you adjust the printhead, you should use the 
media of the type (other than film) that you use most 
frequently. 
If you are using cut sheets, make sure at least one 
sheet of unused A3 paper (not the blank sides of used 
paper) or larger are set.

Aligning Printhead Procedure

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Adjust Printer, 
then press [�]. 

4 Press [�] or [�] to select Auto Head Adj., 
then press [�].

MAIN MENU
Adjust Printer ↓

Adjust Printer
 Auto Head Adj. ↓

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press [�] or [�] to select Advanced Adj. or 
Standard Adj., then press [�].
Advanced Adj. adjusts the gaps between the even 
and odd numbered nozzles, the color boundaries, 
and print direction boundaries. 

Standard Adj. adjusts only the print direction 
boundaries. 

6 Press [�] or [�] to select Yes, then press 
OK button.  

As the printhead adjustment pattern prints, the 
printer reads the pattern and automatically adjusts 
the settings for position of the printhead.

After the printhead adjustment is finished, Online 
appears in the printer operation display. 

Auto Head Adj.
Advanced Adj. ↓

Advanced Adj.
  Yes
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Adjusting Amount of Media Feed

Perform the procedure below to perform Adjust Band to 
adjust the amount of line feed if you see white lines or dark 
color lines in your printed images. As the band adjustment 
pattern prints, the printer reads the results of the print and 
automatically adjusts the settings of the amount of line feed for 
the media currently loaded in the printer. Before you perform 
the band adjustment, make sure a roll or cut sheet A3 (L) size 
or wider is loaded in the printer.

Important
Before you adjust line feed, you must use the 
operation panel to select media type for the paper 
loaded for printing. If the value of the media type 
selection does not match the paper loaded for printing, 
you will not achieve good print results and the quality 
of the printing will be poor.
Select Feed Priority > Band Joint in order to perform 
Adjust Band.

Note
If you are using cut sheets, make sure at least one 
sheet of unused A3 paper (not the blank sides of used 
paper) or larger are set.

There is no automatic adjustment for highly 
transparent film. Execute Fine Tuning to perform the 
adjustment with manual entry. (→ P.4-43)

Media Feed Adjustment Procedure

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Adjust Printer, 
then press [�]. 

MAIN MENU
Adjust Printer ↓

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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4 Press [�] or [�] to select Adjust Band, 
then press [�].

5 Press [�] or [�] to select Standard Adj., 
then press [�].

6 Press [�] or [�] to select Yes, then press 
OK button. 

As the band adjustment pattern prints, the printer 
reads the results of the print and automatically 
adjusts the settings of the amount of line feed for the 
media currently loaded in the printer.

After the amount of line feed has been adjusted, the 
printer returns to the Online mode. 

Adjusting Line Feed Manually
The line feed can be fine adjusted manually to increase or 
decrease the amount of feed. Follow the procedure below 
to perform this adjustment manually.

1 Press the Online button to display MAIN 
MENU.

2 Press [�] or [�] to select Adjust Printer, 
then press [�]. 

3 Press [�] or [�] to select Adjust Band, 
then press [�].

4 Press [�] or [�] to select Fine Tuning, 
then press [�].

Displays the values of the current settings.

Adjust Printer
Adjust Band ↓

Adjust Band
Standard Adj. ↓

Auto Adjustment
  Yes

MAIN MENU
Adjust Printer ↓

Adjust Printer
Adjust Band ↓

Adjust Band
Fine Tuning ↓

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press the [�] or [�] button to select the 
desired setting value then press the OK 
button.
If you want to widen the gap between the bands, 
enter a number from 1 to 3.

If you want to narrow the gap between the bands, 
enter a number from -1 to -3.

The selected setting is prefixed with an equals sign 
(=) to denote the current setting.

6 Press the Online button.

The Online lamp lights and the printer is ready to 
print. 

Note
The value for the amount of feed adjustment can be 
performed during printing. However, if you change the 
amount of feed during printing, the print result may be 
distorted by about 3 cm immediately after the change.
Adjust in the plus (+) direction if white stripes are 
visible in the output image, or adjust in the minus (−) 
direction if dense color stripes are visible.

Fine Tuning
=0

Online
Bk

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Reducing the Amount of Cutting Dust
When using a media like backlight film that easily creates 
cutting dust you can perform the setting to reduce the 
amount of cutter waste that can cause a deterioration in the 
quality of printing or damage the printhead. The cutter dust 
reduction function can be set for each media type.
(→ P.1-21)
If you set the cutter dust reduction function, black lines will 
print at the leading edge and trailing edge of the printed 
sheets.

Important
Do not use this function for plain paper, thin paper, or 
any other media that buckles easily. This type of media 
may not cut properly and cause paper jams.
Borderless printing cannot be performed with the 
cutter dust reduction feature is set. In order to perform 
borderless printing, you must switch the cutter dust 
reduction function off.

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Med.Detail Set., 
then press [�]. 

4 Press [�] or [�] to select the name of the 
media type then press [�]. 

The cutter 
dust reduction 
lines that will 
be printed.

The position 
that will be cut

MAIN MENU
Med. Detail Set. ↓

Med.Detail Set.
Backlit Film ↓

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press [�] or [�] to display 
CutDustReduct. then press [�].

6 Press [�] or [�] to select a value for the 
setting then press OK button.
To switch the cutter dust reduction function on for the 
selected media type, select On or to release the 
function for the media type select Off.

The selection is prefixed with an equals sign (=) to 
denote that the cut waste reduction function is 
selected.

Backlit Film
CutDustReduct. ↓

CutDustReduct.
  On
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Changing the Black Ink Type
This printer employs two types of black ink, either Photo 
Black Ink or Matte Black Ink, to best match the media type 
and the requirements of the print job. For more details 
about the types of black ink, please refer to Chapter 2 “The 
Suitable Black Ink for Media”. (→ P.2-2)

Photo Black Ink Tank BCI-1431BK

Matte Black Ink Tank BCI-145IMBK

Follow this procedure to switch the type of black ink. 

�Remove printed and other media from the platen.

�On the operation panel perform ChangeBkInkType. 

�After the processing to drain the ink is finished, remove 
the black ink tank. 

� Install the black ink that you want to use.

�Confirm the installed ink tank. 

�Aligning the Printhead

Important
When you execute ChangeBkInkType, the printer 
consumes about 45 ml of black ink and about 15 ml of 
the colored inks in total. Before you change the ink 
tanks, confirm that there is sufficient ink in the tank. It 
is recommended that you use a new ink tank 
whenever possible. (→ P.4-2)
The Photo Black and Matte Black ink tanks cannot be 
installed at the same time.
You cannot execute ChangeBkInkType once the 
MTCart Full Soon or Replace MT-Cart appears. You 
can execute ChangeBkInkType after the 
maintenance cartridge has been replaced.
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Black Ink Tank Exchange Procedure

1 If the printer power is off, press the Power 
button to switch the printer on.

Within a short time, Online or Offline is displayed.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select 
ChangeBkInkType, then press [�].

4 Press [�] or [�] to select Yes, then press 
OK button. 

The black ink drains while the Please Wait... 
message is displayed. The draining requires about 1 
minute to complete. 

As soon as processing is completed, the Open 
RightCover message is displayed.

5 Open the right cover.

6 Press down on the lever of the black ink tank 
and open the ink tank cover.

MAIN MENU
ChangeBkInkType ↓

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

ChangeBkInkType
  Yes
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7 Hold the black ink tank by the grips and 
remove it.

Place each ink tank in a vinyl or plastic bag and seal 
it.

Important
If ink remains in a removed ink tank, store the ink tank 
with the ink supply port (a) pointing up. Ink leaked from 
ink tanks will stain the work area.

8 With the black ink tank that you are going to 
use still in is bag, slowly rotate it 7 or 8 times 
then remove from the bag.

Important
Always hold an ink tank by its left and right grips (b) 
while you are handling it.

Never touch the ink supply port (a) or the terminal (c). 
This could damage the ink tank, cause poor print 
quality, or stain the work area.

a

b

a
c
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9 With the ink supply port facing down and the 
label facing front as shown, insert the black 
ink tank into its holder.

Important
The ink tanks are shaped so the cover will not close if 
you set the wrong ink tank in a holder. If the ink tank 
cover does not close, confirm that the color label on 
the holder matches the color of the ink tank, and make 
sure that ink tank is facing the proper direction.

10 Close the ink tank cover until you hear it 
catch.

11 Close the right cover.

The name of the ink tank type you just set is 
displayed. 

12 Confirm that the ink type is correct then 
press OK button.
If the ink type display is incorrect press Stop, open 
the right cover, and replace the black ink tank.

For a matte black ink tank:

For a photo black ink tank:

The operation panel displays Ink Filling.. while the 
ink fills. Ink filling requires about 15 minutes.

When the procedure is finished, the printer returns 
Online.

13 Align the printhead.
(→ P.4-40)

ChangeBkInkType
MBk Ink Tank OK?

ChangeBkInkType
Bk Ink Tank OK?
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Before Using the Printer
This section describes some points that you should know 
about checking the compatibility of network environments 
or the network that you are using before you use the 
optional network interface expansion board. For more 
details about the network settings, we recommend that you 
consult your network administrator.

Required System Environment
This section describes the system environments that are 
supported by the network interface of the printer. The lists 
below describe the system environments required to 
support the network in use.

Using a TCP/IP Network for Printing
Compatible Operating Systems:

•Windows Server 2003
•Windows XP
•Windows 2000
•Windows NT 4.0
•Windows Me, Windows 98
•Mac OS 8.6 or later
•Mac OS X v10.1 or later
•Solaris Version 9
•Red Hat Linux 9

Compatible Computer
• IBM PC or IBM compatible PC
•A Macintosh Series computer equipped with a 
Power PC processor

•Sun Microsystems SPARC platform computer

Note
If you are using Windows NT 4.0, install Service Pack 
6 or later.
If you are using Mac OS X Ver. 10.2.5 or later, you can 
use the Mac OS Zeroconf function to connect. (Also, if 
you are using Mac OS 8.6, 9.x with the Canon 
imagePROGRAF printer driver for Macintosh installed, 
you can also use the Zeroconf function to connect the 
printer.)

Using an AppleTalk Network for Printing
Compatible Computer

•A Macintosh Series computer equipped with a 
Power PC processor.

Compatible Operating Systems
•Mac OS 8.6 or later
•Mac OS X v10.1 or later

Compatible AppleTalk
•EtherTalk Phase 2

Required Memory
•24 MB or more for Mac OS 8.6, 32 MB or more for 
Mac OS 9.x

•128 MB or more is required for Mac OS X.

Note
This printer is not compatible with a Macintosh 
LocalTalk Network.
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Using a NetWare Network for Printing
Compatible Server

•Novell NetWare Version 4.2/5.1/6.0
Compatible Clients

•Windows XP Professional
•Windows 2000 Server
•Windows 2000 Professional
•Windows NT Server 4.0
•Windows NT Workstation 4.0
•Windows Me, Windows 98

Compatible Computer
• IBM PC or IBM compatible PC

Note
NetWare Version 6.0 iPrint is not supported.

The Network Environment
Use the diagrams as reference to determine the type of 
network where the printer is connected, and then follow the 
required procedure.

Windows Network Examples
If you are using Windows network, you can use TCP/IP 
as the protocol. (→ P.5-5)

Note
When you perform the settings for a TCP/IP network on a 
Windows computer, each computer can send print jobs 
directly to the printer connected to the network and have 
them print. Also, if a print server is set up for Windows 
Server 2003, Windows XP, Windows 2000, or Windows 
NT, each printer can send print jobs to the print server, the 
print server can manage these jobs, and then send them 
directly to the printer on the network. This greatly 
increases the efficiency of job execution. For more details 
about print server settings, please refer to “Setting the 
Printer for Sharing”. (→ P.5-18)
The NetBIOS protocol cannot be used with this printer.

Windows 98

Windows 2000 Server

Windows Me Windows XP

TCP/IP

W6400
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Macintosh Network Examples
For a Macintosh computer, the AppleTalk (EtherTalk) or 
TCP/IP, or Zeroconf (Mac OS X Ver. 10.2.5 or later) pro-
tocol is used. (→ P.5-20)

NetWare Network Examples
The NetWare protocol is used for printing in the network 
environment shown in the illustration below. The Net-
Ware client software must be installed on every Server 
and Client computer. (→ P.5-33)

Note
The TCP/IP and AppleTalk protocols can be used 
together even in a NetWare server network 
environment, In such a case, be sure to set which 
protocol to use.Macintosh

AppleTalk, TCP/IP

Macintosh

W6400

W6400

Windows 98 Windows Me Windows 2000

NetWare 

NetWare    Server
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TCP/IP Network Settings (Windows, Macintosh, UNIX)
This chapter describes the setting methods and procedures 
for connecting the printer to a TCP/IP network.

Procedures Required for a TCP/IP Net-
work
Here is a summary of the procedures required to set the 
printer for use on a TCP/IP network.
The following procedure should be performed by the 
network system administrator.

Connecting the LAN Cable

1 Use a LAN cable to connect the printer LAN 
port to the HUB port. 

1 Installing the network interface board → Quick Start 
Guide

First, install the optional network interface board

2 Connecting the LAN Cable → P.5-5

Connect the LAN port to the HUB with the LAN cable.

3 Setting the Printer IP Address → P.5-7

Set an IP address that will allow the printer to 
communicate with the computer that you want to use. 
Use either of the utilities below to perform this setting.

• GARO Device Setup Utility (Canon software 
application provided with the printer.)

• ARP/PING Command
• Printer operation panel

4 Install the Printer Driver → Quick Start 
Guide

Install the Canon imagePROGRAF printer driver for 
either Windows or Macintosh (OS X). Follow the 
procedure on the Quick Start Guide to install the 
printer driver. There is no printer driver for UNIX.

5 Performing the TCP/IP Protocol 
Settings → P.5-15

Performing the TCP/IP protocol settings according to 
you needs as required. You can use the Web Browser 
to perform these settings from your computer.

a
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2 Use a LAN cable to connect the computer 
LAN port to the HUB port.

Note
When this printer is connected to and used on a 
network, switch the printer on then check the LINK 
lamp (a) to confirm that it lights and remains on. This 
lamp lights green with a 100-Base-TX connection and 
lights yellow for a 10-BaseT connection.

If the LINK lamp does not light, check the following 
points:
• Is the HUB switched on?

If the HUB is switched off, switch it on.
• Is the LAN cable connected correctly?

Confirm that the LAN cable connectors are clicked 
and locked in place correctly.

• Is the LAN cable defective?
Connect another LAN cable and visually check the 
lamp again.

• Is the communication method correct for the HUB?
If the communication method (mode and speed) set 
for the printer and the HUB with auto recognition do 
not match, follow the procedure below to perform the 
connection settings manually. 
1. Press the Online button to display MAIN MENU. 
2. Press [�] or [�] to select Interface Setup then 

press [�]. 
3. Press [�] or [�] to select Ethernet Driver then 

press [�]. 
4. Press [�] or [�] to select Auto Detect then 

press [�].

5. Press [�] or [�] to select Off, then press OK 
button. 

6. Press [�] or [�] to select Comm. Mode then 
press [�]. 

7. Press [�] or [�] to select Half Duplex or Full 
Duplex then press OK button. 

8. Press [�] or [�] to select Ethernet Type then 
press [�]. 

9. Press [�] or [�] to select 10 Base-T or 100 
Base-TX then press OK button. 

10.Press [�] or [�] to select Spanning Tree then 
press [�].

11.Press [�] or [�] to select Not Use or Use then 
press OK button. 

12.Press [�] twice to display Store Setting then 
press [�]. 

13.Press the OK button.



5- 7

TCP/IP Network Settings (Windows, Macintosh, UNIX)
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Setting the Printer IP Address
Before setting the printer protocol, you must set the IP 
address to enable communication between the printer and 
the computer. Use either of the utilities below to perform 
this setting. Use whichever is easiest to perform the 
settings.

GARO Device Setup Utility (→ P.5-7)
Use this software utility to perform the computer settings 
if you are using a Windows computer. Perform the sub-
nets mask and default gateway settings with the Remote 
UI.

ARP/PING Command (→ P.5-10)
Use this command to perform the printer IP address set-
ting on the command prompt screen. Performing the 
subnets mask and default gateway settings with the 
Remote UI.

Printer Operation Panel (→ P.5-12)
To connect a Macintosh via an AppleTalk connection, 
perform the settings on the printer operation panel. 
However, you can print without performing the printer 
network settings if you use the Zeroconf function (IP 
Print (Auto)) with Max OS X Ver. 10.2.5 or later to con-
nect the printer.

Important
Before setting the IP address, confirm that the printer 
is switched on and connected to the network.

Setting the frame type with GARO Device 
Setup Utility
If you are using Windows, use the GARO Device Setup 
Utility, the software utility provided with the printer, to 
perform the printer network settings.

Installing GARO Device Setup Utility

Important
If you are using Windows Server 2003, Windows XP, 
Windows 2000, or Windows NT 4.0, you must log in as 
a member of the Administrators group.

1 Mount the provided User Software CD-ROM 
in the computer CD-ROM drive.
Setup Menu window appears. 

Note
If the AutoPlay function is switched off, double-click the 
My Computer icon on the desktop, click the CD-ROM 
drive icon, and then from the File menu select 
AutoPlay.



5- 8

TCP/IP Network Settings (Windows, Macintosh, UNIX)
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

2 Click the Install Individual Software button.

3 Click the Install button of the GARO Device 
Setup Utility. 

4 Follow the instructions on the screen.
This completes the installation of the GARO Device 
Setup Utility.

Setting Network Information

1 On the desktop, click the Start button, point 
to Programs, then select GARO Device 
Setup Utility > GARO Device Setup Utility.

2 Select the name of the printer you want to 
set from the list of printer names, then select 
Protocol Settings from the Printer menu.
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3 Enter the IP Address, Subnet Mask, and 
Gateway Address assigned to the printer 
and click the Set button.
If the IP address is set automatically, select 
Automatic for the Setting IP Address, then click 
the check boxes for DHCP, BOOTP, or RARP for the 
features you want to use. To specify a fixed IP 
address, select Manual for the Setting IP Address. 

The printer is shipped from the factory with 
AppleTalk and NetWare disabled for use. When 
printing via AppleTalk, select Phase2 for AppleTalk 
Phase. 

When printing with NetWare, select the frame type in 
use for NetWare Frame Type.

4 Click the OK button when the confirmation 
message is displayed.

5 When you are finished performing the 
settings, select Exit from the Printer menu.
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Setting with the ARP/PING Command
To perform the setting with the ARP/PING command, 
you need the MAC address of the printer. The MAC 
address can be found printed on the status print or on 
the seal attached to the expansion board, or on the 
Information menu displayed on the printer operation 
panel.

Checking the Printer MAC Address
Perform the procedure below to print a Status Print so 
you can check the MAC address. Before printing, set a 
roll of media larger than A3. 

Note
The MAC address can be found printed on the nozzle 
check pattern or the printhead adjustment pattern, or 
on the printer operation panel: MAIN MENU > 
Information > MAC Address.

1 If the printer power is off, press the Power 
button to switch the printer on.

After a few moments, Online appears in the display. 

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Test Print then 
press [�].

4 Press [�] or [�] to select Status Print, 
then press OK button.

The information about the printer settings is printed. 
After the nozzle check pattern has printed Online is 
displayed in the operation panel and the printer is 
ready to print.Data

Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

MAIN MENU
Test Print ↓

Test Print
Status Print

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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The MAC Address is printed in the Status Print at the 
location indicated in the sample below.

Setting the IP Address

1 If you are using a Windows computer, start 
from the MS-DOS prompt or the command 
prompt.
If you are using UNIX or Linux, open the Console 
screen.

2 Execute the following commands to add 
static entries to the arp table.
arp -s <IP Address> <MAC Address>

IP Address:

Specify the IP address assigned to the printer. Enter 
the 4-digit numbers (decimal number 0 to 255) using 
periods (.) as delimiters. Confirm the allocated 
address with the network system administrator.

MAC Address:

Specify the fixed MAC address of the printer. 2 digits 
for each column, using hyphens as delimiters.

Entry Sample:

arp -s XXX.XXX.XXX.XXX 00-00-85-XX-XX-XX
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3 Execute the following commands to set the 
IP address for the printer.
ping <IP Address> -l 479
IP address:

Specify the same IP address used in Step 2.

Entry Sample:

ping XXX.XXX.XXX.XXX -l 479
(For Windows) 

ping –s 479 XXX.XXX.XXX.XXX
(For Red Hat Linux) 

ping –s XXX.XXX.XXX.XXX 479
(For Solarius)

Note
The “l” of the “-l” entry is an alphabetic lower case “l” 
(el).
The subnet mask and gateway address are set to 
“0.0.0.0”. 
After completing the above settings, use the Remote 
UI or the printer operation panel to perform the subnet 
mask and gateway address settings for your network. 
(→ P.5-12, P.5-15)

This completes the preparation for printer protocol set-
tings.

Setting with the Printer Operation Panel
The network information can be set up on the printer 
operation panel. Enter the settings for the IP address, 
subnet mask, and default gateway.

1 Press the Online button to display MAIN 
MENU.

2 Press [�] or [�] to select Interface Setup 
then press [�]. 

3 Press [�] or [�] to select TCP/IP, then 
press [�].

4 Press [�] or [�] to select IP Setting, then 
press [�].

MAIN MENU
Set Interface ↓

Interface Set
TCP/IP ↓

TCP/IP
IP Setting ↓

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 Press [�] or [�] to select IP Address, then 
press [�]. 

6 Press [�] or [�] to change the number 
setting of the IP address, then press the OK 
button.

7 To enter the IP address allocated for the 
printer, press [�] or [�] to change the 
number, then press [�] or the OK button.
The selected digit increments by 1 every time you 
press [�]. However, at 255 the number rolls up to 0.

The selected digit decrements by 1 every time you 
press [�]. However, at 0 the number rolls up to 255.

Note
If you press and hold the [�] or [�] button, the value 
increases or decreases in steps of 10

8 Repeat Steps 6 to 7 to enter the IP address 
assigned to the printer.

Enter the subnet mask.

9 Press [�] once then press [�] or [�] to 
select Subnet Mask then press [�]. 

10 Press [�] or [�] to change the number 
setting of the subnet mask, then press OK 
button.

11 Press [�] or [�] to set the number of the 
subnet mask in use on the network, then 
press OK button.
The selected digit increments by 1 every time you 
press [�]. However, at 255 the number rolls up to 0.

The selected digit decrements by 1 every time you 
press [�]. However, at 0 the number rolls up to 255.

12 Repeat Steps 10 to 11 to enter the subnet 
mask that the network is using.

Enter the default gateway.

IP Setting
IP Address ↓

IP Address
=0.0.0.0

IP Address
=XXX.0.0.0

IP Address
=XXX.XXX.XXX.XXX

IP Setting
Subnet Mask ↓

Subnet Mask
=0.0.0.0

Subnet Mask
=XXX.0.0.0

Subnet Mask
=255.255.255.0
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13 Press [�] once then press [�] or [�] to 
select Default G/W then press [�]. 

14 Press [�] or [�] to change the number 
setting of the default subnet mask, then 
press OK button.

15 To enter the default gateway IP address, 
press [�] or [�] to select the number to 
change, then press OK button.
The selected digit increments by 1 every time you 
press [�]. However, at 255 the number rolls up to 0.

The selected digit decrements by 1 every time you 
press [�]. However, at 0 the number rolls up to 255.

16 Repeat Steps 14 to 15 to enter the default 
gateway IP address. 
Now you are ready to register the IP address, subnet 
mask, and default gateway setting.

17 Press the [�] button 3 times. 

Store Setting is displayed. 

18 Press the OK button.
If you want to cancel the setting, press Stop button 
for at least 1 second.

The printer restarts after Storing appears on the 
display.

When you are finished with the settings, the printer 
returns Online.

If an error occurs, check the settings then set them 
again.

Important
If you need to change the IP address, subnet mask, or 
default gateway, you must perform Step 18 to register 
the setting. If the setting is not registered, the entered 
value will not be enabled.

IP Setting
Default G/W ↓

Default G/W
=0.0.0.0

Default G/W
=XXX.0.0.0

Default G/W
=XXX.XXX.XXX.XXX

Store Setting
OK? 
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Performing the TCP/IP Protocol Set-
tings
Remote UI, the software application built into the network 
interface of this printer, allows you to use a Web browser on 
your computer to monitor the status of the printer and 
perform the network information settings for the printer. 

Setting up with a Web Browser (Remote UI)
The procedure below describes how to use Remote UI to 
perform the network information settings.

Important
For the Web Browser, use Netscape Navigator/
Communicator 6.0 or later, or use Internet Explorer 
5.01 or later. The Safari web browser for the Macintosh 
is not compatible. 
The connection cannot be set up through a proxy 
server. If the network environment employs a proxy 
server, in the Web Browser proxy server settings add 
the IP address of the printer to the Exceptions 
(addresses not used by the proxy). (The settings may 
differ depending on the environment.) 
In the Web Browser perform the settings so JavaScript 
and cookies can be used. 
If more than one remote UI is being used, then the 
most recent settings remain enabled. Starting and 
using only one Remote UI at a time is recommended. 
Starting and using only one Remote UI at a time is 
recommended. 

Note
When the Remote UI is running with the printer name, 
make sure that the DNS settings for the DNS 
environment and board have been set up correctly.

1 Start the Web Browser, enter the following 
URL for the Location or the Address, then 
press the Enter key.
http://<Printer IP Address or name>/
Entry Sample : http://XXX.XXX.XXX.XXX/
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2 Click and select Administrator Mode then 
click the Logon button. 
English is set as the default display language for the 
Remote UI mode. Select Administrator Mode, then 
click the Logon button.

The Remote UI starts.

Note
If a password has been set for the printer, enter the 
password and then click the Logon button. If no 
password has been set, then no password entry is 
required.

3 Select Network in the Device Manager 
menu on the left.

The Network page appears.

4 Click the Edit... button to the right of TCP/IP 
protocol.

The Edit TCP/IP Protocol Settings page opens.
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5 Perform the settings for each item.

If the IP address is to be acquired automatically, 
click on the check box for the method to be used: 
Use DHCP, Use BOOTP, or Use RARP. Remove all 
three of the checkmarks if you specify the IP 
address.

Note
With DHCP, BOOTP, or RARP used to set the IP 
address setting when the printer starts up, or when it is 
reset, a query determines whether DHCP, BOOTP, or 
RARP can be used, then the first setting method that 
can be recognized and used to assign the IP address. 
If the check box for Use DHCP, Use BOOTP, or Use 
RARP is clicked off, the check is not performed with 
that function.
If any of the items cannot be used, then the setting for 
IP Address is assigned as the IP address.
The check to determine whether DHCP, BOOTP, or 
RARP can be used requires about 1 or 2 minutes to 
execute. Clicking off the check boxes for a method that 
cannot be used is recommended. 
When DHCP, BOOTP, or RARP is used to assign the 
IP address, the server in the network that uses this 
protocol must be running.
If you are using a DNS server, click the Enable DNS 
Dynamic Update check box on, and then enter the 
Primary DNS Server Address, Secondary DNS 
Server Address, DNS Host Name, and DNS Domain 
Name.
Enter the text or hyphen (-) for the name of the host in 
the DNS Host Name box (Limit: 63 characters). 
However, you cannot enter a number or hyphen at the 
beginning of the name or enter a hyphen at the end of 
the name.
Enter characters, hyphens, or periods for the DNS 
Domain Name (Limit: 64 characters). However, you 
cannot enter a number, hyphen, or period at the 
beginning of the name or enter a hyphen or period at 
the end of the name.
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6 Click the OK button.

7 When you return to Network under Device 
Manager, press the Reset button.

The printer network interface restarts and enables 
the settings.

Setting the Printer for Sharing
Performing the print server settings in the following procedure 
for a network set up with Windows Server 2003, Windows XP, 
Windows 2000, or Windows NT 4.0, greatly improves the 
efficiency of managing the network printer. After you set up the 
print server, print jobs are managed by the print server. Also, if 
you install alternate drivers for the print server beforehand, 
each computer can install the printer driver via the network.

Important
The printer share settings should be performed by the 
network system administrator. These settings cannot 
be done on a Windows 98 server. 

1 Open the Sharing sheet of the Printer 
Properties dialog box.
�Click the Start button then select Settings > 

Printers.

�Click the icon of the printer to use, then from the 
File menu select Sharing.
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2 Perform the settings for printer sharing.
�Select Shared as then enter the desired name 

of the printer for sharing.

�Click the Additional Drivers... button (click the 
Alternate Drivers button in Windows NT 4.0) 
and select the printer driver to install.

�Press the OK button. A screen appears so you 
can select the location of the printer driver files 
when you install additional (alternative) drivers, 
so mount the User Software CD-ROM provided 
for this printer in the CD-ROM drive and select 
the folder.

Important
If you are using Windows NT 4.0 you will need Service 
Pack 6 or later for Windows NT installed on the 
computer in order to use the alternate drivers function.

This completes the settings for printer sharing.

To install the printer driver on other computers, when you 
select Network Printer on the Printer Wizard screen for the 
selection of the destination for the printer connection, be 
sure to select the printer set up for sharing by the print 
server.

Note
If the printer is shared where IIS is installed on 
Windows Server 2003, Windows XP, or Windows 
2000, install DSE (Device Status Extension) stored 
on the provided User Software CD-ROM so you can 
use the Web Browser on the client computer to 
manage information displays and print jobs. For more 
details about how to install DSE, refer to the 
Readme.txt in the DSE file located in the DSE folder 
on the User Software CD-ROM.
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Macintosh Network Settings
This section describes how to connect to a network using 
AppleTalk, IP Print, Canon IP (GARO) and Zeroconf and 
how to perform the settings so the printer can be used.

Procedures Required for a Macintosh 
Network
Here is a summary of the procedures required to set the 
printer for use on a Macintosh network.
The following procedure should be performed by the 
network system administrator.

Note
Here we will describe as an example connection to a 
Macintosh computer with its built-in, standard Ethernet 
port. If you are installing a expansion network interface 
board or a wireless LAN, be sure to select the name of 
that port.
If you are using Mac OS 8.6/9x, you can use the 
printer on an IP Print network. IP Print uses the TCP/
IP protocol. If the TCP/IP settings are enabled with IP 
Print (Auto) then the printer can be used by simply 
connecting it to the LAN. If the printer is connected 
with an IP Printer, first register the IP Address 
(Chooser > Registering IP Address) then select the 
IP Printer and the printer name.

1 Installing the network interface board → Quick Start 
Guide

First, install the optional network interface board.

2 Connecting the LAN Cable → P.5-5

Connect the LAN port to the HUB with the LAN cable.

3 Setting a Macintosh → P.5-21

• Confirm the network settings for the Macintosh.

4 Setting AppleTalk Protocol → P.5-25

Enable the AppleTalk protocol to connect the printer 
via AppleTalk. Set the IP address on the printer 
operation panel then use the Web browser to set the 
protocol for the printer name and zone settings and IP 
Print or Canon IP (GARO) connection.

• Web Browser (Remote UI)
• Printer operation panel

5 Install the Printer Driver → P.5-31

Follow the procedure in the Quick Start Guide to 
install Canon imagePROGRAF printer driver on the 
Macintosh.
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If you are using Mac OS Ver. 10.1 or later, you can use 
the printer on a Canon IP (GARO) network. Canon IP 
(GARO) uses the TCP/IP protocol. The printer can be 
used as soon as the TCP/IP settings are enabled 
between the Macintosh computer and the printer and 
the printer IP address has been defined. 
If you are using Mac OS X Ver. 10.2.5 or later, you can 
use the Zeroconf function to connect. Zeroconf uses 
the TCP/IP protocol. As soon the TCP/IP settings are 
enabled for the Macintosh computer, the printer can be 
used by simply connecting it to the LAN. Zeroconf (the 
abbreviation for Zero Configuration) is network 
technology that requires neither an IP address nor a 
DNS service name.

Setting a Macintosh
Setting the AppleTalk Network Functions
For Mac OS 8.6/9.x
Use Chooser and the AppleTalk item of Control Panel 
to confirm the Macintosh network settings. 

1 Confirm that AppleTalk can be used.
�From the Apple menu select Chooser.

�Confirm that Active is selected for AppleTalk. 
If Inactive is selected, select Active.
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2 Confirm that Ethernet is selected for the 
AppleTalk connection. 
�Start AppleTalk on Control Panel.

�Select Ethernet.

�Close AppleTalk to save the setting.

This completes the AppleTalk network settings for a 
Macintosh.

Important
Be sure to select the Printer Port if Ethernet is 
connected via LocalTalk.

For Mac OS X
Confirm the AppleTalk settings with Network of System 
Preferences.

1 Open Network under System Preferences.

2 At the Show setting select Built-in Ethernet.

3 Select the AppleTalk sheet and confirm that 
Make AppleTalk Active is selected.
If this item is not checked, select it and then click the 
Apply Now button. 

4 Close Network to save the settings.

This completes the AppleTalk network settings for a 
Macintosh. 
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TCP/IP Network Function Settings
Confirm the operating system TCP/IP function settings 
when using the Remote UI and IP Print connection, 
Canon IP (GARO) connection, or Zeroconf function con-
nection.

For Mac OS 8.6/9.x
Use Chooser and the TCP/IP on the Control Panel con-
firm the TCP/IP network settings.

Important
If a fixed IP address has already been allocated to 
your Macintosh computer, please use that assigned 
setting. No setting is required. For more details about 
network settings, please contact your network system 
administrator.
If the computer is connected to the printer with IP Print 
(Auto), then the computer and the printer must be 
connected to the same network as the router. The 
computer cannot be connected through a router to a 
printer on another network.For more details about 
network settings, please contact your network system 
administrator.
If the DHCP server cannot be recognized when Using 
DHCP Server is selected, then 169.254.xxx.xxx is set 
as the Link Local Address.

1 Confirm that TCP/IP is selected for the 
Ethernet connection.
�Start TCP/IP on Control Panel.

�For the Connect via select Ethernet. 

�Set Using DHCP Server for Configur. 

�Close TCP/IP to save the setting.

This completes the TCP/IP network settings for a Macin-
tosh.
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For Mac OS X
Confirm the TCP/IP settings at Network under System 
Preferences.

Important
If the computer is connected to the printer with 
Zeroconf, then the computer and the printer must be 
connected to the same network as the router. The 
computer cannot be connected with the Zeroconf 
function through the router to a printer on another 
network. For more details about network settings, 
please contact your network system administrator.
If the DHCP server cannot be recognized when Using 
DHCP is selected, then 169.254.xxx.xxx is set as the 
Link Local Address. 

1 Open Network under System Preferences. 

2 At the Show setting select Built-in Ethernet. 

3 Select the TCP/IP panel and confirm the 
enabled IP address, subnet mask, and router 
settings.

4 Close Network to save the settings. 

This completes the TCP/IP network settings for a Macin-
tosh.
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Setting AppleTalk Protocol
The AppleTalk protocol of this printer is set to disable before 
the printer is shipped. Enable the AppleTalk protocol to 
connect the printer via AppleTalk. The printer protocol 
settings can be set with either a Web browser (Remote UI) 
or the printer operation panel. This setting is not required if 
connected with IP Print, Canon IP (GARO), or Zeroconf. 

Remote UI (→ P.5-25)
On a Macintosh computer where the TCP/IP setting is 
completed, you can use a Web browser to perform the 
AppleTalk settings. To perform the settings, first enter the 
IP address with the printer operation panel, then use the 
Web browser to set the protocol. (→ P.5-25)

Printer operation panel (→ P.5-30)
You can perform the AppleTalk settings on the printer 
operation panel.

Important
Before AppleTalk settings, confirm that the printer is 
switched on and connected to the network.

Setting the Protocol with Web Browser 
(Remote UI)

Important
For the Web Browser, use Netscape Navigator/
Communicator 6.0 or later, or use Internet Explorer 
5.01 or later. The Safari web browser for the Macintosh 
is not compatible.
The connection cannot be set up through a proxy 
server. If the network environment employs a proxy 
server, in the Web Browser proxy server settings add 
the IP address of the printer to the Exceptions 
(addresses not used by the proxy). (The settings may 
differ depending on the environment.) 
In the Web Browser perform the settings so JavaScript 
and cookies can be used.
If more than one remote UI is being used, then the 
most recent settings remain enabled. Starting and 
using only one Remote UI at a time is recommended.

Note
When the Remote UI is running with the printer name, 
make sure that the DNS settings for the DNS 
environment and board have been set up correctly.
Follow the procedure below to start Remote UI on a 
system using Mac OS X Ver. 10.2.5 or later and the 
Zeroconf function to connect the printer.

1. Open the Printer Setup Utility (Print Center).
2. Select the name of this printer from the print list 

and click the Set button.
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1 Start the Web Browser, enter the following 
URL for the Location or the Address, then 
press the Enter key.
http://<Printer IP Address or name>/
Entry Sample : http://XXX.XXX.XXX.XXX/

2 Select Administrator Mode then click the 
Logon button.
English is set as the default display language for the 
Remote UI mode. Select Administrator Mode, then 
click the Logon button.

The Remote UI starts.

Note
If a password has been set for the printer, enter the 
password and then click the Logon button. If no 
password has been set, then no password entry is 
required.

3 Select Network in the Device Manager 
menu on the left.

The Network page appears.
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4 To perform the AppleTalk protocol settings, 
click the Edit... button to the right of 
AppleTalk.

The Edit AppleTalk Protocol Settings page is 
displayed.

If connected with the IP Print (Auto) (Mac OS 8.6/
9x) function or Zeroconf Mac OS X function, go to 
the Step 9. 

5 For Phase Type, select Phase 2. 

Note
If Disabled is selected, the printer will not be 
recognized on the AppleTalk network.

6 For Name enter the name of the printer on 
the network.
Enter the printer name displayed in Chooser (Mac 
OS 8.6/9.x) or the name displayed in Setup Utility 
(Print Center) (Mac OS X).

Important
If more than one printer is in the same zone, be sure to 
assign a unique name for each printer.

Note
The initial (default) network interface name is Canon 
NB 15FB (xxxxxx). Where xxxxxx is the 6-digit MAC 
address of the printer. 
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To change Name, enter a 15-character name. 
However, these symbols and characters are not 
permitted: @ * : =

7 When a zone is set on the network, enter the 
name of zone where the printer belongs.
If no zone is set, then leave the asterisk (*) entry as 
it is.

Important
The zone name must be the name of a zone that is 
already entered. If you enter the name of a zone that is 
not yet set, the recognition of the printer by the 
Macintosh will be lost. For more details about zone 
names, please contact your network system 
administrator.

8 Click the OK button.
If you are using AppleTalk only, go to Step 13.

9 If you are using the Zeroconf function for the 
printer connection, click the Edit... button to 
the right of TCP/IP. 

The Edit TCP/IP Protocol Setting page opens.
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10 Click the Use Zeroconf Function check box 
on.

11 Enter the name of the printer on the network 
into the Multicast DNS Service Name box.
Enter the printer name displayed in Chooser (Mac 
OS 8.6/9.x) or the name displayed in Print Setup 
Utility (Print Center) (Mac OS X).

Note
You can change the Multicast DNS Service name with 
up to 63 characters (including hyphens, spaces).

12 Click the OK button.

13 When you return to the Network screen of 
Device Manager, click the Reset button. 

The printer network interface restarts and enables 
the settings.

This completes the protocol settings for the printer.
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Setting with the Printer Operation Panel
You can use the printer operation panel to select Apple-
Talk protocol. 

1 Press the Online button to display MAIN 
MENU.

2 Press [�] or [�] to select Interface Setup 
then press [�]. 

3 Use [�] or [�] to select AppleTalk then 
press [�]. 

4 Press [�] or [�] to select On, then press 
OK button. 

5 Press the [�] button. 

6 Press the OK button.
If you want to cancel the setting, press Stop button 
for at least 1 second.

The printer restarts after Storing appears on the 
display. 

When completed, the printer returns to the Online or 
Offline mode. 

MAIN MENU
Interface Setup ↓

Interface Set
AppleTalk ↓

AppleTalk
On

Interface Setup
AppleTalk ↓

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Store Setting
OK? 
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Install the Printer Driver
After completing the printer protocol settings, install the 
printer driver on every Macintosh that will be used for 
printing and perform the print destination settings.

Installing the Printer Driver
In order for the printer to operate, a printer driver compat-
ible with the printer must be installed. Install the Printer 
Driver (→ Quick Start Guide)

Selecting a Printer
For Mac OS 8.6/9.x
Selecting the printer with the Chooser completes the 
settings. The Destination can select AppleTalk, IP 
Print, or IP Print (Auto). (→ Quick Start Guide)

For Mac OS X
For Mac OS X, open the printer setup utility (Print Cen-
ter), and then add the name of the printer under Add 
Printer. For the Destination select AppleTalk, Canon 
IP (GARO) or Zeroconf. 

1 Make sure that the printer is on.

2 After the Macintosh has restarted, open 
Finder and select Utilities or Applications 
from the Go menu.

3 Open the Utilities folder then open Printer 
Setup Utility (Print Center).

4 If the name of the printer is not in the Printer 
List, click the Add icon.
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5 From the connection destination menu, 
select AppleTalk, Canon IP (GARO), or 
Zeroconf for the network connection, click 
the name of the printer in the displayed list, 
then click the Add button. 

This completes the selection of the printer.
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NetWare Settings (Windows)
The chapter describes the setting methods and procedures 
for connecting the printer to a NetWare network.

Procedures Required for a NetWare 
Network
Here is a summary of the procedures required to set the 
printer for use on a NetWare network.
The following procedure should be performed by the 
network system administrator.

1 Installing the Network Interface 
Board

→ Quick Start 
Guide

First, install the optional network interface board.

2 Connecting the LAN Cable → P.5-5

Connect the LAN port to the HUB with the LAN cable.

3 Setting the Printer Frame Type → P.5-34

Perform the printer frame type setting. Use the 
software below to setup communication between your 
computer and the printer.

• GARO Device Setup Utility (Canon utility pro-
vided with the printer) 

• Printer Operation Panel

4 Setting Up a NetWare Print Service → P.5-37

Perform the NetWare printer service settings. Use 
one of the utilities below to perform the settings on 
the computer.

• NWADMIN or PCONSOLE (Novell software 
application provided with NetWare) 

5 Setting NetWare Protocol → P.5-40

Perform the printer protocol settings. You can use a 
Web Browser from a computer on the network to 
perform the network settings.

• Web Browser (Remote UI)

6 Setting the Computer for NetWare → P.5-44

Perform these settings on every computer to be used 
with the printer.
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Setting the Printer Frame Type
Before setting the printer protocol, you must set the frame 
type to enable communication between the printer and the 
computer. Use the utility below to perform this setting. 

GARO Device Setup Utility (→ P.5-34)

Printer operation panel (→ P.5-35)

Important
In order to use GARO Device Setup Utility, it must be 
installed on your computer. Install GARO Device Setup 
Utility on your computer. (→ P.5-34)
Before setting the printer frame type, confirm that the 
printer is switched on and connected to the network.

Setting the frame type with GARO Device 
Setup Utility
If you are using Windows, use the GARO Device Setup 
Utility, the software utility provided with the printer, to 
perform the printer network settings.

1 On the desktop, click the Start button, point 
to Programs, then select GARO Device 
Setup Utility > GARO Device Setup Utility.

2 Select from the list the name of the printer 
you want to set, then select Protocol 
Settings from the Printer menu.
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3 Select the type of frame you are using for 
NetWare Frame Type, select ETHERNET II 
for TCP/IP Frame Type, enter the assigned 
settings for IP Address, Subnet Mask and 
Gateway Address, then click the Set button. 

Note
The IP address setting is required here to allow the 
printer protocol setting to be performed with the Web 
browser (Remote UI). 

4 Click the OK button when the confirmation 
message is displayed.

5 When you are finished performing the 
settings, select Exit from the Printer menu.

Setting with the Printer Operation Panel
The NetWare network information can be set on the 
printer operation panel. 

1 Press the Online button to display MAIN 
MENU.

2 Press [�] or [�] to select Interface Setup 
then press [�]. 

3 Press [�] or [�] to select NetWare, then 
press [�]. 

MAIN MENU
Interface Setup ↓

Interface Setup
NetWare ↓

MAIN MENU
Head Cleaning

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)



5- 36

NetWare Settings (Windows)
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

4 Press [�] or [�] to select Netware, then 
press [�]. 

5 Press [�] or [�] to select On, then press 
OK button.

After the equals mark (=) appears on the left, the 
display returns to the NetWare menu.

6 Press [�] or [�] to select Frame Type, 
then press [�]. 

7 Press [�] or [�] to select the setting for the 
frame type to use then press OK button. 
The available frame type selections are Auto 
Detect, Ethernet 2, Ethernet 802.2, Ethernet 802.3 
and Ethernet SNAP.

After the equals mark (=) appears on the left, the 
display returns to the NetWare menu.

8 Press [�] or [�] to select Print Service, 
then press [�].

9 Press [�] or [�] to select the print service 
then press [�].
The available selections for Print Service are 
BindaryPserver, RPrinter, NDSPserver, and 
NPrinter.

After the equals mark (=) appears on the left, the 
display returns to the NetWare menu.

10 Press the [�] button twice. 

11 Press the OK button. 
If you want to cancel the setting, press Stop button 
for at least 1 second.

The printer restarts after Storing appears on the 
display.

When completed, the printer returns to the Online or 
Offline mode.

NetWare 
NetWare ↓

NetWare
  On

NetWare
Frame Type ↓

Frame Type
Ethernet 802.3

NetWare
Print Service ↓

Print Service
RPrinter

NetWare
Print Service ↓

Store Setting
OK? 
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Setting Up a NetWare Print Service
A print service for the print server, queue, and so on, must 
be set up before you can use a NetWare network to print. 
Use one of the following software applications to perform 
the print service settings from your computer. Use 
whichever is easiest to perform the settings.

NWADMIN or PCONSOLE (Novell software 
applications provided with NetWare)

Important
If you perform the print service settings with 
NWADMIN, Novell Client (the Novell NetWare client) 
must be installed as the client software application.
The procedure described here is for the NetWare print 
service settings. The procedure may be different in the 
environment that you are using. 

Types of Print Services
Before performing the print service settings, be sure to 
read the description below then select the printer service 
type.

Note
You can use NDPS as the print service with NetWare 
5.1/6.0. When you use NDPS, use the Novell printer 
gateway provided by NetWare as the gateway. The 
setup procedure for NDPS is not described in this 
guide, so for more details refer to the NetWare 
instructions.

NDS (Novell Directory Service) and Bindery
Either NDS or Bindery is supported. Select the mode 
that is best suited for your network environment. 
Queue Server Mode and Remote Printer Mode
Both Queue Server Mode and Remote Printer Mode 
are supported.
Queue Server Mode
When Queue Server Mode is used, all of the print 
server functions are provided so no other hardware for 
the print service is required. The printer and computer 
use the NDS print server in the NDS Queue Mode 
(NDS PServer). The printer and computer use the 
Bindery print server in the Bindery Queue Mode (Bind-
ery PServer).
Also, a NetWare user license is required for each net-
work interface used in the Queue Server Mode.
Remote Printer Mode
If you use the Remote Printer Mode, the NetWare print 
server exercises control. For this reason, the NetWare 
print service is required. Use the NDS print server in 
NDS Remote Printer Mode (NPrinter) to print, and use 
the Bindery print server in the Bindery Print Mode 
(RPrinter) to print.
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Setting Up the Print Server With 
NWADMIN, PCONSOLE
If You Are Using NDS Queue Server Mode or 
Remote Printer Mode

1 Log into NetWare as the System 
Administrator, or as a user with equivalent 
access rights, then start NWADMIN.

2 Execute the Quick Setup.
�Select Print Services Quick Setup from the 

Tools menu. 

�Enter a Print Server Name of your choice. If you 
want to use an existing server, click the button to 
the right of the name to select it from the list.

�For the printer Name enter the desired name.

� If you intend to use Queue Server Mode, select 
Other/Unknown for the Type. If you intend to use 
the Remote Printer Mode, select Parallel for 
Type, click the Communicate button then select 
LPT1 for Port and Manual Load for Connection 
Type.

�For the print queue Name enter the desired name.

�For Volume enter the volume object to create the 
queue (the object that appears as the physical 
volume on the network). Click the button on the 
right to select from the list. 

�Perform any other settings that are required, then 
click the OK button.

Note
You are going to need the name of the print server to 
perform the printer protocol settings so be sure to note 
the printer name.
When you perform the Quick Setup, “0” is assigned to 
the printer as its number. If you intend to use the 
Queue Server Mode, do not change the printer 
number. 

3 Set the password.
�Select the print server created in Step 2, then 

right-click Details.

�Click the Change Password button to open the 
password entry screen, then enter the desired 
password.

�Click the OK button to close the password entry 
screen.

�Click the OK or Cancel button to close the 
Details screen.

4 Follow the procedure below to start the print 
server when you use the Remote Printer 
Mode.
�To use the NetWare file server as the print 

server, on the file server enter LOAD 
PSERVER.NLM then press the Enter key.
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Note
The step to use the NetWare file server as the print 
server, is not required if you intend to use the Queue 
Server Mode.

This completes the NetWare print service settings. Next, 
perform the printer protocol settings. (→ P.5-40)

If You Are Using the Bindery Queue Server 
Mode or Remote Printer Mode

1 Log into NetWare as the Supervisor, then 
start PCONSOLE.

2 Switch to the Bindery Mode.

3 If the print server has not been created, 
perform the following procedure to create the 
print server.
�From Available Options select Quick Setup 

then press the Enter key. 

�Enter the name of the print server to create, the 
name of the new printer, and name of the 
queue.

Note
You are going to need the name of the print server to 
perform the printer protocol settings so be sure to note 
the printer name.

4 Set the printer type.
� If you intend to use Queue Server Mode, select 

Other/Unknown for the Type. If you intend to 
use the Remote Printer Mode, under Printer 
Type select Parallel then set Manual Load for 
the Location.

�Press the ESC key.

�When the confirmation message appears, click 
Yes then press the Enter key.

5 Set the password.
�From Available Options select Print Servers, 

then press the Enter key.

�Select the print server created in Step 2, then 
press the Enter key.

�Select Password, then press the Enter key. 
When the password entry screen opens, enter 
the desired password, then press the Enter 
key.

6 Press ESC several times to display the 
confirmation to close PCONSOLE, then click 
Yes to close PCONSOLE.

This completes the NetWare print service settings. Next, 
perform the printer protocol settings. (→ P.5-40)
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Setting NetWare Protocol
The printer protocol settings can be set with a Web browser 
(Remote UI) from your computer. Set the IP address before 
you perform these settings. (→ P.5-7)

Setting the Protocol with Web Browser 
(Remote UI)

Important
For the Web Browser, use Netscape Navigator/
Communicator 6.0 or later, or use Internet Explorer 5.01 
or later.
The connection cannot be set up through a proxy server. 
If the network environment employs a proxy server, in the 
Web Browser proxy server settings add the IP address of 
the printer to the Exceptions (addresses not used by the 
proxy). (The settings may differ, depending on the 
network environment.)
In the Web Browser perform the settings so JavaScript 
and cookies can be used.
If more than one remote UI is being used, then the most 
recently used settings remain enabled. Starting and using 
only one Remote UI at a time is recommended. 

Note
When the Remote UI is running with the printer name, 
make sure that the DNS settings for the DNS 
environment and board have been set up correctly.
When print history is displayed with RPrinter/NPrinter 
with the Remote UI running, the Document Name and 
User information cannot be acquired. For this reason 
the Document Name is set to Unknown the User is 
set to RPRINTER/NPRINTER (only these settings are 
displayed). 

1 Start the Web Browser, enter the following 
URL for the Location or the Address, then 
press the Enter key.
http://<Printer IP Address or name>/
Entry Sample : http://XXX.XXX.XXX.XXX/

2 Click and select Administrator Mode then 
click the OK button. 
English is set as the default display language for the 
Remote UI mode. Select Administrator Mode, then 
click the Logon button. 

The Remote UI starts.

Note
If a password has been set for the printer, enter the 
password and then click the Logon button. If no 
password has been set, then no password entry is 
required.
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3 Select Network in the Device Manager 
menu on the left. 

The Network page appears.

4 Click the Edit... button to the right of 
NetWare.

The Edit IPX/SPX Protocol Settings page appears.

5 Check the Frame Type box and make sure 
the setting is correct for your NetWare 
network.

6 If you intend to use the burst mode, select 
On for NCP Burst Mode.

Note
The burst mode is used in the queue server mode to 
transfer data rapidly at very high speed during printing.
Normally, leave the setting on.
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7 For Print Application select the service to 
use.

Note
Here we will show only one service selected and 
enabled. More than one service cannot be enabled at 
the same time. 

8 When using the packet signature settings, for 
Packet Signature be sure to select If 
Requested by Server.

9 Perform the following settings as required for 
the selected service.

Bindery PServer Selected: Queue Server Mode 
(Using a Bindery Print Server)

�Enter the file server name into File Server 
Name.

�For Print Server Name, enter the name of the 
print server created in “Setting Up a NetWare 
Print Service” (→ P.5-37).

�For Print Server Password, enter the print 
server password created in “Setting Up a 
NetWare Print Service” (→ P.5-37).

�Set the Polling Interval. Set the time interval 
for the printer to confirm the NetWare print 
queue.

RPrinter Selected: Remote Printer Mode (using a 
Bindery Print Server) 

�For Print Server Name, enter the advertised 
name of the print server created in “Setting Up 
a NetWare Print Service” (→ P.5-37).

�For Printer Number, enter the same printer 
number that you entered in “Setting Up a 
NetWare Print Service” (→ P.5-37).
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NDS PServer Selected: Queue Server Mode 
(Using an NDS Print Server)

�Enter the Tree Name and Context Name for 
the tree and context name of the print server. 
Enter a context name of less than 255 
characters. 

�For Print Server Name, enter the name of the 
print server created in “Setting Up a NetWare 
Print Service” (→ P.5-37).

�For Print Server Password, enter the print 
server password created in “Setting Up a 
NetWare Print Service” (→ P.5-37).

�Set the Polling Interval. Set the time interval 
for the printer to confirm the NetWare print 
queue.

NPrinter Selected: Remote Printer Mode (using an 
NDS Print Server) 

�For Print Server Name, enter the advertised 
name of the print server created in “Setting Up 
a NetWare Print Service” (→ P.5-37). The 
advertised name and common name of the 
printer is set the same.

�For Printer Number, enter the same printer 
number that you entered in “Setting Up a 
NetWare Print Service” (→ P.5-37).

10 Click the OK button.

11 When you return to Network under Device 
Manager, press the Reset button.

The printer network interface restarts and enables 
the settings.

This completes the NetWare protocol settings.
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Setting the Computer for NetWare
Perform these settings for each computer after you have 
selected the NetWare print service and protocol.

Connecting to a NetWare Network
Install NetWare client software on all the computers that 
will be used to print, then log in to the NetWare server or 
tree. For more details about connection methods, refer to 
the NetWare or operating system instructions.

Installing the Printer Driver
The printer driver is required for printing. Install the 
printer driver under the direction of the network system 
administrator.
When you install the printer driver, be sure to select Net-
work Printer and select the print queue that you created 
with the NetWare print service settings.

Setting the Printer Port
Press the Start button then select Settings > Printers > 
Printer icon > File > Properties. Display either the 
Details or Port sheet and specify the print queue you 
created with the NetWare print service settings as the 
setting for the print destination. (→ P.5-37)

Note
This procedure is not required if you set the connection 
destination for the printer during the installation of the 
printer driver.
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Printing with UNIX

Using LPD to Print
This section describes printing with LPD.

1 Log into the root of the work station.

2 Set up the spooling system.
Example Using Solaris 9: 

�Start the Admintool utility. 

�Select Browse > Printers. 

�Select Edit > Add > Access to Printer. 

�Following the format restrictions, enter the 
Printer Name and Print Server name. 

�Press the OK button.

Example Using Red Hat Linux

�Start the Printer Configuration utility on the 
control panel. 

�Select Add > Other UNIX (lpd) queue > OK. 

�For the Printer Name, Remote Host, Remote 
Queue enter the desired print queue name, 
printer IP address or name, and lp. 

� If a filter is to be used, select the filter.

If there is no filter for the printer, you can temporarily 
select any filter, shut down the Printer Configuration 
Utility, and then change the postscript.cfg file in the 
spool directory so it matches your printer. For more 
details, please refer to the Ghostscript descriptions.

Note
The Admintool Utility is provided with the operating 
system. For more details about how to use this utility, 
please refer to the operating system instructions.
The setting procedure above is an example. The 
procedure may be different in the environment that you 
are using. 
This completes the printing settings.
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Using FTP to Print

1 Start at the MS-DOS prompt or command 
line.
If you are using UNIX, open the Console screen.

2 Execute the following commands.
ftp <Printer IP Address>

3 Enter any user name.
Just press the Enter key without entering a 
password. 

You can perform the procedure below. 

•To print a file: 

put <filename to print>

Note
Print the file in binary mode.
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Initializing the Settings
Follow the procedure below to use the Web browser 
(Remote UI) to restore all the network settings to the default 
values set before shipping the printer from the factory.

Note
In addition to using the Web browser to restore the 
initial settings, you can also use GARO Device Setup 
Utility or the printer operation panel to restore the 
network default settings.

1 Start the Web Browser, enter the following 
URL for the Location or the Address, then 
press the Enter key.
http://<Printer IP Address or name>/
Entry Sample : http://XXX.XXX.XXX.XXX/

2 Click and select Administrator Mode then 
click the Logon button. 
English is set as the default display language for the 
Remote UI mode. Select Administrator Mode, then 
click the Logon button. 

The Remote UI starts.

Note
If a password has been set for the printer, enter the 
password and then click the OK button. If no password 
has been set, then no password entry is required.

3 From the Device Manager menu on the left, 
select Network.

4 Click the Reset to Default settings button.

5 Confirm the message then click the OK 
button.
All the network information is restored to the factory 
default settings.

Note
When you initialize all the network settings, the printer 
IP address is also restored to its factory default 
(0.0.0.0) so the Remote UI screen cannot be displayed 
in the browser again. Use the GARO Device Setup 
Utility or the printer operation panel when you need to 
perform the network settings again.
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List of Network Settings
If you are using a Web Browser (Remote UI), you can 
change the settings of the network interface. The settings 
that can be changed are listed in the tables below.

General Settings

TCP/IP Settings

Item Content Initial 
Value

Device Name Device name
(Range: 0 to 32 chars.) Blank

Location Device location 
(Range: 0 to 32 chars.) Blank

Administrator Device Administrator Name
(Range: 0 to 32 chars.) Blank

Phone
Telephone number of 
Administrator for the device
 (Range: 0 to 32 chars.)

Blank

Comment 
(E-mail)

Comments of the Device 
Administrator
(Range: 0 to 32 chars.)

Blank

Administrator 
Password

Device password
(Range: 0 to 15 chars.) Blank

Item Content Initial 
Value

Use DHCP
The setting in the IP address 
that determines whether 
DHCP is used

OFF

Use BOOTP
The setting in the IP address 
that determines whether 
BOOTP is used

OFF

Use RARP
The setting in the IP address 
that determines whether 
RARP is used

OFF

RAW Mode Bi-
direction

Determines whether bi-
directional communication is 
used for RAW mode. 

OFF

DNS Dynamic 
Update 

Determines whether DNS 
Server Registration Update 
is Automatic.

OFF

Use Zeroconf 
function

Determines whether 
Zeroconf function is used. ON

IP Address The IP address of the printer 0.0.0.0

Subnet mask The subnet mask of the 
printer. 0.0.0.0

Gateway 
Address

The gateway address of the 
printer. 0.0.0.0

Primary DNS 
Server Address

IP Address of primary DNS 
server 0.0.0.0
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AppleTalk Settings

NetWare Settings

Secondary DNS 
Server Address

Secondary DNS Server IP 
Address. 0.0.0.0

DNS Host Name Printer Host Name 
(Range: 1 to 63 chars.)

NB-15FB 
xxxxxxxxx

xxx
DNS Domain 
Name

Printer Domain Name
(Range: 0 to 64 chars.) Blank

Multicast DNS 
Service Name

Printer Multicast DNS 
Service Name
(Range: 1 to 63 chars.)

Canon 
W6400P

G (xxxxxx)

Item Content Initial 
Value

Phase Type
The name of the phase type 
in use (determines whether 
AppleTalk is used.)

Disabled

Name

The names of the printers 
displayed in the Chooser and 
Printer Center lists 
(Name length: 1 to 31 chars.)

Canon 
NB-15FB 
(xxxxxx)

Zone The name of the printer zone 
(Name length: 1 to 31 chars.) *

Item Content Initial 
Value

Item Content Initial Value

Frame Type The frame type used by 
NetWare. Disabled

NCP Burst Mode

Determines whether the NCP 
burst mode is used. 
(Normally, leave this setting 
on.)

ON

Print Application
The print service to use. 
(Only one print service can 
be selected and enabled.)

NDS 
PServer

Packet 
Signature

Determines whether the 
packet sign is used 
(normally leave set to If 
Requested by Server)

If Requested 
by Server

Bindery PServer

File Server 
Name

Name of the NetWare file 
server of the NetWare print 
server. 
(Range: 0 to 47 chars.)

Blank

Print Server 
Name

The name of the NetWare 
print server in use. 
(Range: 0 to 47 chars.)

Blank

Printer Server 
Password

The password required by 
the print server setting. 
(0 to 20 chars.)

Blank

Polling Interval
The time interval between job 
confirmations. 
(Range: 1 to 15 sec.)

5
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RPrinter

Print Server 
Name

The name of the NetWare 
print server in use. 
(Range: 0 to 47 chars.)

Blank

Printer Number

The number used for the 
printer connection to the 
NetWare print server.
(Range: 0 to 15)

0

NDS PServer

Tree Name
The name of the NDS tree of 
the NetWare print server.
(Range: 0 to 32 chars.)

Blank

Context Name
The name of the context of 
the NetWare Print server.
(Range: 0 to 255 chars.)

Blank

Print Server 
Name

The name of the NetWare 
print server in use. 
(Range: 0 to 64 chars.)

Blank

Printer Server 
Password

The password required by 
the print server setting. 
(0 to 20 chars.)

Blank

Polling Interval
The time interval between job 
confirmations. 
(Range: 1 to 255 sec.)

5

NPrinter

Print Server 
Name

The name of the NetWare 
print server in use. 
(Range: 0 to 64 chars.)

Blank

Printer Number

The number used for the 
printer connection to the 
NetWare print server.
(Range: 0 to 254)

0

Item Content Initial Value
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Software Applications that can be used for Network Settings
Use the following listed software to perform the network settings.

Type of Setting GARO Device 
Setup Utility

Web Browser
(Remote UI)

ARP/PING
command

Printer 
operation 
panel

Setting IP Addresses
(→ P.5-7)

Set TCP/IP protocol
(→ P.5-15)

*1 *1

Setting AppleTalk protocol
(→ P.5-25)

*2 *2

Setting the NetWare printer 
service
(→ P.5-37)
Setting the NetWare protocol
(→ P.5-40)

*3 *3

*1. Only these settings are allowed: IP address, subnet mask, default gateway, DHCP,
BOOTP, RAPP, frame type, phase settings.

*2. Only phase settings are possible.
*3. Only frame type are possible.
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Responding to Error Messages
When the printer requires attention, messages are displayed on the operation panel and in the GARO Status Monitor 
(Windows) or GARO Printmonitor (Macintosh).

• Operation Panel

Follow the procedures on the following pages to confirm
and solve problems indicated by the messages.

• GARO Status Monitor (Windows)

Read the displayed message and perform the appropri-
ate procedure. 

Note
The printer status cannot be displayed with a USB connection to Mac OS X. 
If the GARO Status Monitor is not installed on Windows, look at the message on the printer operation panel.

Data
Information Power

Offline
Menu

Message
Error!                 E02010
Media Skewed

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Operation Panel Message List

Media Messages Ink Messages Other Messages

Load Roll Media Check Ink Level Close xxx Cover (xxx name of the 
cover)

Remove Roll Media Rep. Ink Tank Reset Lever
End of Roll No Bk/PC/C/PM/M/Y Ink Tank Check Head Hght L/M/H → L/M/H
RllMed.Shortage 
Replace RllMed. Check Bk/PC/C/PM/M/Y Ink Tank Turn Power Off!!

Load Cut Sheet Not Enough Ink No Printhead
Remove Cut Sheet Ink level? Printhead Error!
Eject Cut Sheet Remove Ink Tank Check Printhead
Incorrect Media Chk Bk Ink Type Scale Read Error
Med.SizeNoMatch MTCart Full Soon Mist Full Soon
No Borderless Replace MT-Cart Mist Count Error
Illegal Med Pos No MT-Cartridge Adj. Failed
NoBordlessData Check MT-Cart. Incorrect Value
Size undetected ERROR nnnnnn (n = Numbers)
Media Skewed
Media Too Large
Media Too Small
Media Jam
Cut Failed
Drying..
Feed Limit..
Cut by Stop key
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Media Messages

Load Roll Media

Problem1: The printer is waiting for you to load the roll 
media.

Solution1: Follow the procedure below set the Media Type 
and Media Size settings the same as those for 
the roll media. (→ P.2-26)
1. Load a roll with media that is the same type 

and size as the printer settings.
2. Select the media type.
3. Select length if the media remaining detection 

feature for roll media is on.
4. Press the OK button.

Solution2: Hold down the Stop/Eject button for at least 1 
second to stop printing. 

Remove Roll Media

Problem1: The printer is waiting for you to remove the 
ejected roll media.

Solution1: Perform the procedure below to remove the roll. 
1. Open the upper cover.
2. Push the release lever to the rear and 

remove the roll.
3. Pull the release lever toward you to close it.
4. Raise the upper cover stopper to release the 

lock then close the upper cover. 
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End of Roll

Problem1: The roll media has run out.

Solution1: Perform the procedure below to load the same 
size and type of roll media in use. (→ P.2-26)
1. Load the size and type of roll in use. 
2. Select the media type. 
3. Select length if the media remaining detection 

feature for roll media is on.
4. Press the OK button.

RllMed.Shortage
Replace RllMed.

Problem1: The length of the media required for the received 
print job is longer than the amount of media 
remaining on the roll.

Solution1: Follow the procedure below to load a new roll in 
the printer. (→ P.2-26)
1. Load a new roll of the size and type to be 

used.
2. Select the Media Type.
3. If the roll remaining media function is on, 

select the length of the media.
4. Press the OK button.

Solution2: Hold down the Stop/Eject button for more than 1 
second to stop printing.
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Load Cut Sheet

Problem1: The printer is waiting for a cut sheet to be 
loaded.

Solution1: Follow the procedure below to set the media 
type and media size settings the same as those 
for the cut sheet. (→ P.2-35)
1. Load a cut sheet that is the same type and 

size as the printer settings. 
2. Select the media type. 
3. Press the OK button.

Solution2: Hold down the Stop/Eject button for at least 1 
second to stop printing. 

Remove Cut Sheet

Problem1: The printer waits for you to remove the ejected 
sheet.

Solution1: Perform the procedure below to remove the cut 
sheet. (→ P.2-39)
1. Open the upper cover.
2. Push the release lever to the rear and 

remove the cut sheet. 
3. Pull the release lever to close it. 
4. Raise the upper cover stopper to release the 

lock then close the upper cover. 
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Eject Cut Sheet

Problem1: The printer received print data for the roll media 
while a cut sheet was loaded.

Solution1: Perform the procedure below to remove the cut 
sheet. (→ P.2-39)
1. Open the upper cover.
2. Push the release lever to the rear and 

remove the cut sheet. 
3. Pull the release lever to close it. 
4. Raise the upper cover stopper to release the 

lock then close the upper cover. 
5. Load the roll.

Solution2: Hold down the [�] / [�] button for at least 1 
second to stop printing.

Incorrect Media

Problem1: The media type specified for printing does not 
match the setting for the setting for the media in 
the feed source. 

Solution1: Perform the procedure below to correct the 
media type setting on the printer. 
1. Confirm the type of media loaded for the print 

job.
2. Enter the confirmed media type on the printer 

operation panel. (→ P.2-32)

Solution2: Perform the procedure below to correct the 
Media Type setting on the printer.
1. Hold down the Stop/Eject button for at least 

1 second to stop printing. 
2. Use the printer driver to select the media type 

so the value matches the loaded media type, 
then re-start the print job. 

Med.SizeNoMatch

Problem1: A roll of a width that cannot be used with 
borderless printing is loaded in the printer.

Solution1: Load a roll media of a width that can be used 
with borderless printing. (→ P.2-26)

[Media Type]

Printer driver

The specified 
media type 

when loaded
Glossy

Photo Paper
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No Borderless

Problem1: The data received cannot be used for borderless 
printing.

Solution1: Follow the procedure below to correct the Media 
Type setting on the printer.
1. Hold down the Stop/Eject button for 1 sec-

ond or longer to stop printing.
2. Use the printer driver to confirm size of the 

print data and enlargement/reduction set-
tings, then perform printing.

Problem2: The skew detection function is off.

Solution1: For the selected print media, select Standard or 
Loose for Set Skew Check Lv., then load the 
media.

Illegal Med Pos

Problem1: The position of the loaded media is incorrect.

Solution1: Load 10", 14", 16", JIS B2, or ARCH24 roll 
paper.

Solution2: Re-set the roll paper correctly on the roll holder. 
(→ P.2-26)

Problem2: The width of the media in the data received for 
printing cannot be used with borderless printing.

Solution1: Follow the procedure below to correct the setting 
so the printer can print on a media that can be 
used for borderless printing.
1. Hold down the Stop/Eject button for at least 

1 second to stop printing. 
2. In the printer driver change the setting for 

Roll Paper Width to a size that can be used 
with borderless printing, then print again.

NoBordlessData

Problem1: The data received cannot be used for borderless 
printing.

Solution1: Press the Online button to continue borderless 
printing.

Solution2: Do the procedure below to correct the selection 
for the media type.
1. Hold down the Stop/Eject button for at least 

1 second to stop printing. 
2. Use the printer driver to confirm size of the 

print data and enlargement/reduction set-
tings, then perform the print.

Size undetected

Problem1: The media has shifted out of the correct load 
position, or the media is curled.

Solution1: Set the media correctly. (→ P.2-26, P.2-35)

Problem2: The printer interior is dusty or dirty.

Solution1: Open the upper cover and clean inside the 
printer. (→ P.4-11)
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Media Skewed

Problem1: The loaded media is skewed.

Solution1: Perform the procedure below if roll media is in 
use. (→ P.2-26)
1. Open the upper cover.
2. Press the release lever to the rear to open. 
3. Align the right edge of the roll media with the 

line aligned with the right edge of the roll, 
then pull the release lever to the front to 
close. 

4. Raise the upper cover stopper to release the 
lock then close the upper cover. 

5. Select the media type and press the OK but-
ton. 

Solution2: Perform the procedure below if you are using cut 
sheets. (→ P.2-35)
1. Open the upper cover.
2. Press the release lever to the rear to open.
3. Align the right edge of the cut sheet with the 

right side, align the leading edge of the sheet 
inside the printer, then pull the release lever 
toward you to close.

4. Raise the upper cover stopper to release the 
lock then close the upper cover. 

Media Too Large

Problem1: The loaded media is larger than any media size 
allowed for loading in the printer.

Solution1: Set the correct size media then try again.
(→ P.2-26, P.2-35)

Media Too Small

Problem1: The loaded media is smaller than any media size 
allowed for loading in the printer.

Solution1: Set the correct size media then try again.
(→ P.2-26, P.2-35)

Problem2: Media size smaller than the required size was 
set for printing the print pattern or the nozzle 
check pattern.

Solution1: Load A3 size media or larger for printing.

Media Jam

Problem1: Media has jammed in the printer.

Solution1: Perform the procedure below to remove the 
jammed sheet. (→ P.6-35)
1. Switch the printer off.
2. Remove the jammed sheet.
3. Switch the printer on.

Error!                E02E01
Turn Power Off!!
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Cut Failed

Problem1: Leading edge of the roll media not detected after 
cutting.

Solution1: Perform the procedure below to remove the 
jammed sheet. (→ P.2-33)
1. Open the upper cover.
2. Use a cutter to cut the sheet manually and 

remove the sheet. 
3. Re-load the roll. 
4. Raise the upper cover stopper to release the 

lock then close the upper cover. 

Drying..

Problem1: The printer is waiting for the ink to dry on the 
printout.

Solution1: Wait until the printed sheet ejects automatically.

Feed Limit..

Problem1: You pressed [�] button on the operation panel 
to feed more media than allowed.

Solution1: Release the [�] button to stop feeding the 
media.

Cut by Stop key

Problem1: The loaded media cannot be cut automatically.

Solution1: The printer stops after the print job ends to 
protect the printing surface. Support the printout 
with your hand to prevent it from falling into the 
output stacker, and then press the Stop/Eject 
button to cut the printout.
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Ink Messages

Check Ink Level

Problem1: Ink in ink tank is running low.

Solution1: Obtain a new ink tank. If a long print job is in 
progress, or if you need to print a job of many 
sheets, you should replace the ink tank with a 
new one. 

Rep. Ink Tank

Problem1: Ink in an ink tank has run out.

Solution1: Open the right cover and install a new ink tank 
for the color that is flashing on the printer 
operation panel. (→ P.4-2)

No Bk/PC/C/PM/M/Y Ink Tank

Problem1: The ink tank of the displayed color is not 
installed.

Solution1: Install correctly the ink tank named in the 
message. (→ P.4-2)

Problem2: A problem has occurred with the ink tank 
indicated on the display. 

Solution1: Replace the ink tank with a new one.
(→ P.4-2)

C PM M YBK PC
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Check Bk/PC/C/PM/M/Y Ink Tank

Problem1: The installed ink tank named in the display by 
the color of its holder cannot be used. 

Solution1: Make sure that the ink tank indicated on the 
display is installed correctly. (→ P.4-2)

Important
If the ink does not eject properly as a result of installing 
the wrong ink tank, or if the images are very poor 
quality, and the Bk tank was mistakenly installed, 
perform the ChangeBkInkType operation (→ P.4-48). 
If you mistakenly installed any other ink cartridge, 
perform the Move Printer operation, and then install 
new ink tanks. (→ P.4-32)

Problem2: A problem has occurred with the ink tank 
indicated on the display. 

Solution1: Replace the ink tank with a new one. 
(→ P.4-2)

Not Enough Ink

Problem1: Ink in the tank is low and there is not enough ink 
for Head Cleaning B, or any other job that 
requires a large amount of ink. 

Solution1: Replace the ink tank where the ink level is low. 
(→ P.4-2)

Ink level?

Problem1: The ink level detection function is set to off.

Solution1: This message is displayed every time a print job 
is executed and the printer goes offline. Press 
the Online button to continue printing. 

Solution2: To retrieve the ink level display, replace with the 
ink tanks specified for use with this printer.
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Remove Ink Tank

Problem1: While the Move Printer message is displayed, 
the right cover is closed without removing the ink 
tanks.

Solution1: Remove the ink tank.

Chk Bk Ink Type

Problem1: The black ink type does not match the loaded 
media.

Solution1: Check the black ink setting in the printer driver 
and make sure that it is correct.

Solution2: In the printer driver check the media selection 
setting to determine whether the selected media 
type is a type that cannot be used with the 
current black ink type. (→ P.2-2)

MTCart Full Soon

Problem1: The maintenance cartridge is almost full.

Solution1: The current print job can continue. Obtain a new 
MT cartridge.

Replace MT-Cart

Problem1: The maintenance cartridge is full.

Solution1: Replace the maintenance cartridge after 
stopping the print job. (→ P.4-16)

No MT-Cartridge

Problem1: A maintenance cartridge is not installed.

Solution1: Install a maintenance cartridge. (→ P.4-16)

Check MT-Cart.

Problem1: The maintenance cartridge installed is either 
used (full) or is a maintenance cartridge that 
cannot be used with this printer.

Solution1: Install a new maintenance cartridge intended for 
use with this printer. (→ P.4-16)
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Other Messages

Close xxx Cover (xxx name of the cover)

Problem1: The named cover is open.

Solution1: Close the cover named in display on the 
operation panel.

Reset Lever

Problem1: Open the release lever.

Solution1: Pull the release lever toward you to close it.

Check Head Hght L/M/H → L/M/H

Problem1: The current height of the printhead (displayed at 
the left end of the bottom display line) is not the 
appropriate height (displayed at the right end of 
the bottom display line) for printing on the type of 
media loaded for the print job. 

Solution1: Confirm the height (H/M/L) named at the right 
end of the bottom display line, then perform 
procedure below to adjust the height of the print 
head. 
1. Press the Online button to set the printer 

offline.
2. Hold down [�] or [�] for more than 1 sec. to 

move the carriage to the center. 
3. Open the upper cover.
4. Set the printhead height adjustment lever to 

the correct position for the media. 
5. Raise the upper cover stopper to release the 

lock then close the upper cover. 
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Turn Power Off!!

Problem1: The tape inside the upper cover or the belt 
stopper has not been removed.

Solution1: Switch the printer off, open the upper cover, 
remove the tape and belt stopper, then press the 
Power button. (→ Quick Start Guide)

Problem2: Media has jammed in the printer.

Solution1: Switch the printer off and remove the jammed 
sheet, reset the media, then switch the printer on 
again. (→ P.6-35)

Problem3: A problem occurred in the printer.

Solution1: Switch the printer off, wait for over 3 seconds, 
then switch the printer on again. 

Solution2: If the message appears again after performing 
the procedure above, read the content of the 
message and write down the first line, switch the 
printer off, then contact a Canon service center.

No Printhead

Problem1: The printhead is not installed.

Solution1: Install the printhead correctly. (→ P.4-24)

Printhead Error!

Problem1: A problem has occurred with the printhead.

Solution1: Switch the printer off, wait for over 3 seconds, 
then switch the printer on again. 

Solution2: If the message appears again after performing 
the procedure above, read the content of the 
message and write down the first line, switch the 
printer off, then contact a Canon service center.

Error!                E02E01
Turn Power Off!!



6- 16

Responding to Error Messages
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Check Printhead

Problem1: A printhead that cannot be used with the printer 
is installed.

Solution1: Install the printhead for this printer. (→ P.4-24)

Problem2: Printhead abnormal.

Solution1: Open the upper cover. If the carriage is out, 
replace the printhead. (→ P.4-23)

Solution2: If the carriage is in, close the upper cover, press 
the Online button, select Replace P.head then 
replace the printhead. (→ P.4-23)

Problem3: If you see this message when the print job starts, 
the condition of the printhead is poor and cannot 
eject ink properly.   

Solution1: Press the Stop/Eject button to stop the print job, 
perform Head Cleaning B, then start the print job 
again. (→ P.4-38)
If this does not solve the problem, replace the 
printhead. (→ P.4-24)

Solution2: Although you can perform the print job if you 
press the Online button, the print quality may 
become poor.  

Problem4: Ink is not filled in the printhead properly.   

Solution1: Remove all ink tanks and reinsert them properly. 
(→ P.4-2) 

Scale Read Error

Problem1: A problem has occurred with the carriage.

Solution1: Open the upper cover and make sure a foreign 
object has not fallen into the printer.

Solution2: Switch the printer off, wait for over 3 seconds, 
then switch the printer on again. 

Solution3: If the message appears again after performing 
the procedure above, read the content of the 
message and write down the first line, switch the 
printer off, then contact a Canon service center.

Mist Full Soon

Problem1: The printer mist processing is full.

Solution1: Printing can continue. While performing a long 
print job or borderless printing, you can pause a 
print job so you can contact a Canon service 
center.

Mist Count Error

Problem1: The printer has reached the limit for ink mist 
processing.

Solution1: Read the message in the display and jot down 
the content of the message, switch the printer 
off, then contact a Canon service center.
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Adj. Failed

Problem1: Printhead nozzles are clogged.

Solution1: Reload the media and then print the nozzle 
check pattern to check the condition of the 
nozzles. (→ P.4-36) If the printhead is not 
operating properly, perform Head Cleaning. 
(→ P.4-38)

Problem2: The high-transparency film for which the 
printhead or amount of line feed cannot be 
adjusted is loaded. (→ P.4-40, P.4-42)

Solution1: When you adjust the printhead (Auto Head 
Adj.), you should use the media of the type 
(other than film) that you use most frequently. 
(→ P.4-40)

Solution2: To adjust the amount of line feed (Adjust Band), 
perform the procedure for “Adjusting Line Feed 
Manually”. (→ P.4-43)

Incorrect Value

Problem1: The IP address, subnet mask setting, or the 
default gateway setting is not correct.

Solution1: Set the correct settings for the IP address, 
subnet mask and default gateway. For more 
details about the values of the printer network 
information settings, contact your system 
administrator. (P.5-5)

ERROR     nnnnnn (n = Numbers)

Problem1: Error in the print data.

Solution1: If the job does not print correctly, check the 
settings then restart the print job.

Solution2: Switch the printer off, wait for over 3 seconds, 
then switch the printer on again. 

Solution3: If the message appears again after performing 
the procedure above, write down the number of 
the error displayed in the first line, switch the 
printer off, then contact a Canon service center.
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When You Cannot Print
Check the following items when the printer does not operate and will not print.

Printing Will Not Start

No error message is displayed

Problem1: The printer has not been selected as the 
destination for the print job output.

Solution1: If you are using Windows, select the name of the 
printer for Printer in the Print dialog box and 
then try to print again. 

Printing Will Not Start Printing Halts During Print Job Cannot Print on Network

No error message is displayed Error Message Displayed Cannot Print from a TCP/IP 
Network

Error Message Displayed Ejected Paper Is Blank Cannot Print on AppleTalk Network

Ink initialization operation starts 
unexpectedly

Cannot print from the NetWare 
network.
The printer is not recognized, even 
with IP Print (Auto) selected with 
Mac OS 8.6.
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Solution2: If you are using Mac OS 8/9, make sure that the 
correct name of the printer is selected with the 
Chooser, then try again.

Solution3: For Mac OS X, select the name of the printer for 
Printer in the Print dialog box and then try to 
print again. 

Problem2: The print queue has halted.

Solution1: Windows:
1. Select the icon for the printer in the Printer 

folder.
2. From the File menu select Pause Printing to 

release this setting. 

Solution2: Mac OS 8/9: 
1. Open GARO Printmonitor.
2. From the File menu select Resume Printing 

to release the print pause. 
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Solution3: Mac OS X:
1. Open the Printer Setup Utility (Print Center).
2. From the Printers menu select Start Jobs to 

release the print pause.

Problem3: With Mac OS 8/9, the printer is shared via USB.

Solution1: Connect the printer directly to the computer to be 
used for printing through its USB or IEEE1394 
port. If you want to share the printer, perform the 
print job from a Windows computer.

Error Message Displayed

Problem1: Media jam has occurred.

Solution1: Remove the jammed sheets. (→ P.6-35)

Problem2: The printer went offline.

Solution1: After correcting the problem in response to the 
error message, press the Online button to set 
the printer online.

Solution2: If the operation panel display reads Offline 
press the Online button to set the printer online.

Problem3: A problem occurred during printing.

Solution1: When an error message appears in the printer 
operation panel or the Windows display, read the 
message in the GARO Status Monitor, or in the 
GARO Printmonitor for Macintosh, then correct 
the problem. (→ P.6-2)

Problem4: No print media loaded.

Solution1: Replenish the print media in the specified media 
supply source.

Error!                E02E01
Turn Power Off!!
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Problem5: The media type in the media source selection is 
not selected.

Solution1: Use the printer operation panel to select the 
correct setting for the media type. (→ P.2-32)

Solution2: If the media type selection is incorrect, cancel 
the print job in the computer side, open the 
printer driver and select the correct setting for 
the print media loaded. (→ P.1-46, P.2-4)

Problem6: No ink.

Solution1: When the ink tank replacement message 
appears, replace the ink tank for the indicated 
color. (→ P.4-2)

Ink initialization operation starts unexpectedly

Problem1: When the printer was switched off previously, 
this force cancelled a cleaning operation.

Solution1: Wait for the ink initialization operation to finish. 
Ink filling may require up to 10 minutes to 
complete. 

Printing Halts During Print Job

Error Message Displayed

Problem1: An error message is displayed during printing.

Solution1: Read the message displayed in the GARO 
Status Monitor or GARO Printmonitor, and 
correct the problem indicated by the error 
message. (→ P.6-2)

Problem2: Roll media ran out during the print job and the 
tape on the trailing edge of the media sheet is 
preventing the rest of the sheet from feeding.

Solution1: Follow the procedure for removing a media jam. 
Remove the used roll and replace it with a new 
one. (→ P.6-35)
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Ejected Paper Is Blank

Problem1: A blank page is ejected from the previous print 
job.

Solution1: The print job starts after the blank page is 
ejected.

Problem2: The leading edge of the roll media is cut to an 
even length.

Solution1: When the roll was loaded, a plain cut sheet was 
ejected as part of the normal procedure to align 
the roll media correctly. When the preparation is 
finished, the printer is ready to print.

Problem3: Printhead nozzles are blocked.

Solution1: Print a nozzle check pattern to confirm the 
condition of the printhead. If a nozzle is blocked, 
perform the printhead cleaning procedure.
(→ P.4-38)

Problem4: An ink tank has run out of ink.

Solution1: Check the ink tanks and replace any empty ink 
tanks. (→ P.4-2)

Problem5: Printer is damaged.

Solution1: Contact a Canon service center.

Cannot Print on Network

Cannot Print from a TCP/IP Network

Problem1: The LAN port and network cable are not 
connected correctly.

Solution1: Confirm that the connection of the cable that 
connects the printer to the network is secure, 
then press the Power button to cycle the printer 
off and on again. (→ P.5-5)

Problem2: The printer cannot recognize automatically the 
LAN communication method.

Solution1: Use the printer operation panel to select 
Interface Setup > Ethernet Driver then set 
each item for the communication method that is 
being used on the LAN. (→ P.5-5)

Problem3: The TCP/IP network is not set correctly.

Solution1: Confirm that the IP Address is set correctly.
(→ P.5-7)
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Problem4: The settings for the computer used for printing 
are not set correctly.

Solution1: Confirm the following points:
1. Correct printer driver installed? 

The printer driver must be installed on every 
computer that will be printing from Windows. 

2. Is the output destination port set correctly for 
every computer that will be used for printing? 
Select Printers under Control Panel to 
check the output destination.

Problem5: The name of the file you are trying to print is too 
long.

Solution1: Normally, LPR (with Windows NT: Microsoft 
TCP/IP printing) sends the job name based on 
the name of the software application and the 
name of the file. However, if the name of the job 
is more than 255 characters, LPR cannot send 
the job. In such a case, shorten the name of the 
file. 

Cannot Print on AppleTalk Network

Problem1: The LAN port and network cable are not 
connected correctly.

Solution1: Confirm that the connection of the cable that 
connects the printer to the network is secure, 
then press the Power button to cycle the printer 
off and on again. (→ P.5-5)

Problem2: The printer cannot recognize automatically the 
LAN communication method.

Solution1: Use the printer operation panel to select 
Interface Setup > Ethernet Driver then set 
each item for the communication method that is 
being used on the LAN. (→ P.5-5)

Problem3: The AppleTalk protocol has not been enabled for 
the printer.

Solution1: Follow the procedure below to use the Remote 
UI to enable the AppleTalk protocol.
1. Open the Remote UI and log in as an Admin-

istrator.
2. On the Device Manager menu, click Net-

work.
3. Click the Edit button under AppleTalk.
4. Under Phase Type select Phase 2, then 

under Zone select the Zone where the printer 
is located, then click the OK button (if zones 
have not been set for the network, you will 
see an asterisk (*) displayed).

5. Return to the Network page of the Remote 
UI and click the Reset button.
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Problem4: The computer and the printer are not on the 
same network.

Solution1: If the number of routers are exceeded with the 
Zeroconf function, the computer cannot connect 
to the printer if it is on a different network. 
Connect the computer and printer to the same 
network. For more about the network settings, 
please contact the network manager. 

Problem5: The settings for the computer used for printing 
are not set correctly.

Solution1: Mac OS 8.6/9x:
1. Open Chooser from the Apple menu.
2. Under AppleTalk make sure that Active is 

selected.

3. Under AppleTalk in the Control Panels of 
the Apple menu, make sure that the printer is 
selected for connection to the correct port for 
the destination.

4. In Chooser make sure that the GARO Printer 
Driver is installed.

5. In Chooser, select GARO Printer Driver, 
and under Destination select AppleTalk, 
then select again the name of the printer in 
the printer list.
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Solution2: Mac OS X:
1. Open Network for System Preferences.
2. Under Show, select the name of the LAN port 

where the printer is connected.
3. Open the AppleTalk panel and make sure 

that Make AppleTalk Active is checked on.

4. Open Printer Setup Utility (Print Center) 
and make sure that the name of this printer is 
displayed in the printer list. If the name is not 
displayed, click the Add button to add the 
name of the printer.

5. If the name of the printer does not display 
after clicking the Add button, use the pro-
vided User Software CD-ROM to reinstall the 
printer driver for the printer.

Cannot print from the NetWare network.

Problem1: The printer LAN port and cable are not 
connected correctly.

Solution1: Confirm that the connection of the cable that 
connects the printer to the network is secure, 
then press the Power button to cycle the printer 
off and on again. (→ P.5-5)

Problem2: The printer cannot recognize automatically the 
LAN communication method.

Solution1: Use the printer operation panel to select 
Interface Setup > Ethernet Driver then set 
each item for the communication method that is 
being used on the LAN. (→ P.5-5)

Problem3: The NetWare network is not set correctly.

Solution1: Confirm the following points:
1. Make sure that the NetWare file server is run-

ning.
2. Is there enough disk space available on the 

NetWare file server? You may not be able to 
perform large print jobs if there is not enough 
free space available. 

3. Start NWADMIN or PCONSOLE and confirm 
(1) that the print service is set correctly, and 
(2) that the print queue has been enabled for 
use. (→ P.5-38)

4. Make sure that the printer network settings 
are correct. Especially, confirm that a frame 
type is enabled for the Frame Type setting.
(→ P.5-20, P.5-34)
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Problem4: The settings for the computer used for printing 
are not set correctly.

Solution1: Confirm the following points:
1. Correct printer driver installed? Before print-

ing, the printer driver must be installed on 
every computer. (→ P.5-31)

2. Is the output destination port set correctly for 
every computer that will be used for printing? 
Select Printers under Control Panel to 
check the output destination. 

Problem5: A print job data stream cannot be sent from the 
NetWare server to a printer in another subnet.

Solution1: When data is sent from NetWare to the printer, 
the data is sent in the NCP Burst mode, but in 
some network environments data sent to a 
printer on another subnet is lost. If this problem 
occurs, switch off the NCP Burst mode under the 
printer protocol settings and try again. 

Problem6: Parallel is selected for the printer type when 
using the queue server in the queue server 
mode.

Solution1: Select Other/Unknown for the printer type.

The printer is not recognized, even with IP Print 
(Auto) selected with Mac OS 8.6.

Problem1: With OS 8.6 when the router on the network 
cannot be recognized, communication cannot be 
performed with TCP/IP.

Solution1: With Chooser select Destination > Registering 
IP Address and register the printer IP address, 
then with Chooser select Destination > IP Print 
then select the printer name of the registered IP 
address.

Solution2: With Chooser select Destination > AppleTalk 
and select the printer name.

Solution3: Use Mac OS 9.0.4 or later if you want to operate 
the printer with IP Print (Auto).

Solution4: Locate the printer and Macintosh in the same 
subnet, then assign them fixed IP addresses.

Solution5: If there is a DHCP server in the network, locate 
the printer and Macintosh in the same subnet, 
then assign the IP addresses from the DHCP 
server. 
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Unexpected Printing Results
If the results you see in the print job are not what you expect, check the items described below. 

Poor Quality Abnormal Content Other Problems

Printing is faint Broken lines are visible. Ink consumption is exceedingly high.

Ink Smeared Random, bizarre characters are 
printing. The message MTCart Full Soon 

does not go off even after replacing a 
new maintenance cartridge.Edges smeared with ink Length for the media feed method 

is not correct.

Back sides of printed sheets are dirty Printing in Monochrome Media is not cutting straight

Black or white streaks visible Color Tones Uneven Power does not switch on

Horizontal stripes appear in images 
printed on Synthetic Paper. Image color borders printing thick Roll media not inserted in feed slot

When printing on Glossy Photo Paper 
or Semi-Glossy Photo Paper, you may 
see differences between light and 
shaded areas on ripple surfaces of the 
media.

Image edges are faint.

The overall printout appears 
reddish or bluish.
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Poor Quality

Printing is faint

Problem1: Printing on the incorrect side of the media.

Solution1: Check the front and back side of the media. If 
you print on the other side of the media, you will 
not achieve the correct results in printing. 

Problem2: Black ink appears scratchy if black ink type is 
switched frequently.

Solution1: Perform Head Cleaning B. (→ P.4-38)

Problem3: Printhead nozzles are blocked.

Solution1: Print a nozzle check pattern to confirm the 
condition of the printhead. If a print head nozzle 
is blocked, perform the printhead cleaning 
procedure. (→ P.4-36, P.4-38)

Solution2: If only the yellow colors appear smeared, you 
may be able to correct this by selecting on the 
operation panel Med. Detail Set.> Correct 
Smear > On. (→ P.1-21)

Problem4: A printout is in the output stacker. 

Solution1: The capacity of the output stacker is limited to 
one printout. Start the next print job only after 
you have removed the previous printout from the 
output stacker. 

Problem5: The ink port needle is stuck and the ink has 
clogged.

Solution1: Leave the printer with the ink tanks installed for 
more than 24 hours and then execute Head 
Cleaning B. (→ P.4-38)

Problem6: A piece of jammed sheet remains under the 
upper cover.

Solution1: Follow the procedure below to remove paper 
scraps from under the upper cover. 
1. Press the Online button to display Offline. 
2. Press and hold [�] for at least 1 sec. to 

move the carriage to the center. 
3. Open the upper cover.
4. Remove all the paper scraps under the upper 

cover. 

Problem7: The ink was not dry enough for cutting during 
borderless printing. 

Solution1: Select Med. Detail Set. on the operation panel, 
then select a longer setting for the Drying Time.

Problem8: You have used the wrong type of black ink tank.

Solution1: Obtain a new black ink tank then perform the Ink 
Change procedure. (→ P.4-48)
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Ink Smeared

Problem1: The selected media type does not match the 
media loaded in the media supply source.

Solution1: Load the paper feed source named in the 
message. If the paper is not the same as that 
specified for the job, pause the print job 
temporarily, load the correct paper, then print 
again. (→ P.2-26, P.2-35)

Problem2: The printhead height adjustment lever was 
moved from the middle to the down position.

Solution1: Set the printhead height adjustment lever to the 
center position for normal printing. (→ P.2-40)

Problem3: You are printing on thick paper or paper that 
buckles easily.

Solution1: Make sure that the printhead height adjustment 
lever is set at the up position. (→ P.2-40)

Problem4: The output assist guides are not pulled out.

Solution1: Pull out on both sides of the output assist guides. 
(→ P.2-31, P.2-39)

Problem5: The media is wrinkled because it is set 
improperly. 

Solution1: Release the release lever, and then once again 
align the media.

Edges smeared with ink

Problem1: The platen has become dirty after a borderless 
print job or printing a small media size.

Solution1: Open the upper cover and clean the platen.
(→ P.4-11)

Problem2: The selected Media Type is not correct for the 
media loaded in the media supply source.

Solution1: Load the paper feed source named in the 
message. If the paper is not the same as that 
specified for the job, pause the print job 
temporarily, load the correct paper, then print 
again. (→ P.2-26, P.2-35)

Problem3: The media is wrinkled or curled.

Solution1: Remove the creasing or curling then set the 
media again.

Problem4: A line is printed at the cutting position when the 
cutting dust reduction function is set. 

Solution1: If the cutting dust reduction function is not 
needed, use the operation panel to switch off this 
feature for the print media in use. 
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Back sides of printed sheets are dirty

Problem1: A print job using large size media was executed 
after a print job on small size media.

Solution1: Clean the part of the platen under the upper 
cover. (→ P.4-11)

Problem2: The platen was not cleaned after a borderless 
print job.

Solution1: Clean the part of the platen under the upper 
cover. (→ P.4-11)

Problem3: Performed the print job with the media width 
detection function switched off. 

Solution1: Clean the part of the platen under the upper 
cover. (→ P.4-11)

Black or white streaks visible

Problem1: Printhead is out of alignment.

Solution1: Use the operation panel to adjust the amount of 
feed for the print media in use. (→ P.4-42)

Problem2: Printing is not proceeding smoothly due to an 
interruption in the flow of data from the computer.

Solution1: Close other applications that are open and 
cancel other jobs that are executing.

Problem3: The Feed Priority item is set for Print Length.

Solution1: For the Feed Priority item, select Band Joint 
the adjust the amount of feed. (→ P.4-42)

Horizontal stripes appear in images printed on 
Synthetic Paper.

Problem1: Standard is selected for Print Quality.

Solution1: In the printer driver, select High or Highest for 
Print Quality.

When printing on Glossy Photo Paper or Semi-
Glossy Photo Paper, you may see differences 
between light and shaded areas on ripple surfaces 
of the media.

Problem1: You may not be able to achieve a sufficient 
image in some print patterns with the printhead 
in the middle (standard) position.

Solution1: Lower the printhead height adjustment lever to 
the low position. However, never print on media 
that wrinkles easily such as Coated Paper or 
Plain Paper with the printhead height adjustment 
lever in the low position. This could damage the 
printer.
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Abnormal Content

Broken lines are visible.

Problem1: The printhead has not been aligned correctly.

Solution1: Use the printer operation panel to align the 
printhead. (→ P.4-40)

Problem2: After switching the black ink type, the position of 
the printhead occasionally slips.

Solution1: Align the printhead.

Random, bizarre characters are printing.

Problem1: Data from the print job data stream has been 
lost.

Solution1: Switch the printer and computer off, then switch 
them on again and start the print job again.

Problem2: Another printer driver was selected for the print 
job.

Solution1: Select the correct printer driver for the printer 
and try again. (→ P.1-32)

Problem3: The fonts of the printed data are deranged.

Solution1: Make sure that the software application you are 
using has the correct type of fonts and that they 
have been installed correctly.
(→ Software Application Instructions)

Length for the media feed method is not correct.

Problem1: Band Joint is selected.

Solution1: If you want to match size the media feed 
direction correctly, select Print Length for the 
Feed Priority item, then enter the setting for the 
Adjust Length. The amount of media feed can 
be adjusted in 0.02% increments. 

Printing in Monochrome

Problem1: The printer driver's Color Mode is set to 
Monochrome (Photo), Monochrome, or Black 
Only.

Solution1: Select Color for the Color Mode in the printer 
driver and try again.
(→ Printer Driver Online Help)

Problem2: Color ink tank nozzle is clogged.

Solution1: Print a nozzle check pattern to confirm the 
condition of the printhead. If a print head nozzle 
is blocked, perform the printhead cleaning 
procedure. (→ P.4-36, P.4-38)
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Color Tones Uneven

Problem1: The color adjustment for the printer driver has 
not been performed.

Solution1: Use the printer driver to adjust the colors with the 
settings on the Color Settings of the Color 
Mode dialog box. 
(→ Printer Driver Online Help)

Problem2: The computer and monitor have not been 
adjusted correctly for color.

Solution1: Perform monitor color correction.
(→ Monitor Instruction)

Solution2: The color management setting in the software 
application is not set correctly.
(→ Software Application Instructions)

Problem3: Color ink tank nozzle is clogged.

Solution1: Print a nozzle check pattern to confirm the 
condition of the printhead. If a print head nozzle 
is blocked, perform the printhead cleaning 
procedure. (→ P.4-36, P.4-38)

Problem4: A color ink tank is inserted in the wrong slot.

Solution1: On the printer operation panel, execute Move 
Printer, remove the ink tank from the printer, 
then insert the correct color ink tank.
(→ P.4-32, Quick Start Guide)

Solution2: After performing the above procedure, execute 
Nozzle Check. If each color is not printing 
correctly, on the printer operation panel execute 
Head Cleaning B (→ P.4-36, P.4-38)

Problem5: Yellow ink is smearing. 

Solution1: On the operation panel select Med. Detail Set. > 
Correct Smear > On. (→ P.1-21)

Image color borders printing thick

Problem1: Ink is clogged in a nozzle.

Solution1: On the Layout sheet of the printer driver, under 
Special Settings set SSC Adjustment to Level 
1, then execute the print job again. If printing at 
Level 1 does not solve the problem, select Level 
2 and perform the print again. However, please 
remember that using this feature can cause 
changes in the color hues over the entire image 
so you should check the hues as you are 
printing.

Image edges are faint.

Problem1: The setting of the vacuum fan is too strong.

Solution1: Select a weaker setting for the vacuum fan. 
However, this solution does not apply to printing 
of a high-precision image.
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The overall printout appears reddish or bluish.

Problem1: Color balance is not correct.

Solution1: Follow the procedure below to select Adjust 
Printer > Color Adj. and then restore all the 
color settings to their factory default settings.
1. Press the Online button to display MAIN 

MENU.
2. Press [�] or [�] to select Adjust Printer 

then press [�].
3. Press [�] or [�] to select Color Adj. then 

press [�].
4. Press [�] or [�] to select Return Defaults 

then press [�].
5. Press [�] or [�] to select Yes, then press 

OK.

Solution2: If the procedure above does not correct the color 
balance, select Adjust Printer > Color Adj. and 
then change the settings for each color.
1. Press the Online button to display MAIN 

MENU.
2. Press [�] or [�] to select Adjust Printer 

then press [�].
3. Press [�] or [�] to select Color Adj. then 

press [�].
4. Press [�] or [�] to select the ink color to 

correct then press [�].

5. Press [�] or [�] to lighten or darken the 
selected color by selecting 1 or 3 then press 
the OK button.

6. To adjust the other colors, repeat Step 4 and 
5.

Note
If you need to adjust dark colors, adjust the Y, M, C, K 
inks.
If you need to adjust bright colors, adjust the PM, PC 
inks.
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Other Problems

Ink consumption is exceedingly high.

Problem1: There are many sheets with large areas of color.

Solution1: Printing photographs or other images that 
require a lot of color fill consumes large amounts 
of ink. This is not unusual.

Problem2: Executing Head Cleaning B very often.

Solution1: Head Cleaning B consumes a large amount of 
ink (this is not unusual). It is not recommended 
to execute Head Cleaning B unless after the 
printer has been moved, after the printer has 
been stored and not used for a long period, or 
having problems with the printhead.

Problem3: The printer consumes ink for the initial ink tank 
filling.

Solution1: The first time the printer used after it is set up or 
moved to a new location, the ink level display 
may drop to as low as 80% as a result of filling 
the printhead and ink tanks with ink (this is not 
abnormal).

The message MTCart Full Soon does not go off 
even after replacing a new maintenance cartridge.

Problem1: The printer has not yet recognized the new 
maintenance cartridge.

Solution1: Replace the maintenance cartridge and press 
the Information button. 

Solution2: After replacing a new maintenance cartridge the 
message disappears upon executing a print or 
cleaning operation.

Media is not cutting straight

Problem1: The media is wrinkled at the cutting position. 

Solution1: Flatten the media at the cutting position. 

Power does not switch on

Problem1: The power cord was unplugged with the printer 
power on.

Solution1: Wait three minutes with the power cord 
unplugged, then plug in the power cord again 
and switch the printer on.

Roll media not inserted in feed slot

Problem1: The roll media is curled.

Solution1: Insert either the left or right corner of the media 
at a skewed angle into the feed slot, then 
straighten the edge of the media so it is parallel 
with the back of the printer.
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Handling Jams
The printer stops and a Media Jam or Turn Power Off!! 
message appears on the printer display as soon as a jam 
occurs. When a jam occurs, use the following procedure to 
check the jam points and remove the jammed media. 

Operation Panel

GARO StatusMonitor (Windows)

Removing a Roll Media Jam
Follow the procedure below to remove a roll media jam.

1 Hold down the Power button for more than 1 
sec. to extinguish the Online lamp and switch 
the printer off. 

2 Open the upper cover.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.

Data
Information Power

Offline
Menu

Message
Error!                 E02E01
Turn Power Off!!

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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3 Move the carriage manually when it is out of 
its normal park position.
Move it to the right or left edge of the carriage rail 
before attempting to remove the media. 

4 Push the release lever toward the rear to 
open. 

5 Hold the left and right corners of the jammed 
media and pull the sheet forward, then above 
the cutting groove (a), cut at the edge of the 
printed area or where the media is wrinkled.
Use a pair of scissors if the media is difficult to cut 
with a cutter.

6 While gently pulling out the center of the 
leading edge of the roll media, align the right 
edge of the media so it is parallel to guideline 
(b), then pull the release lever to the front to 
close it. 

a

b
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Important
Do not pull strongly on the roll media when you align it 
with the guideline. The roll media may not feed out 
straight in some cases. 
If you pull too much of the roll media out, more of the 
leading sheet than is needed will be cut.

7 Move the carriage manually when it is out of 
its normally parked position.
Push the carriage to the right until it stops.

Important
Be sure to push the carriage to the right. If you push it 
to the left, the printer will display a carriage error after 
the printer is switched on.

8 Raise the upper cover stopper to release the 
lock then close the upper cover. 

9 If the printer is off, press the Power button to 
switch the printer on.

The media starts to feed, and the printer is ready to 
use after feeding is finished.

Note
If you need to correct the alignment of the leading 
edge, press the Online button to display Offline, press 
the [�] button to feed the media, then select Force 
Cutting on MAIN MENU to cut the leading edge.
(→ P.7-3)
After switching roll media and specifying a new media 
type, please set the media type on the printer 
operation panel. (→ P.2-32)

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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Removing a Cut Sheet Jam
Follow the procedure below to remove a cut sheet jam that 
occurs during printing.

1 Hold down the Power button for more than 1 
sec. to extinguish the Online lamp and switch 
the printer off. 

2 Open the upper cover and if the carriage is 
out move it to either the right or the left side.

Important
Do not touch any areas other than those indicated. 
Your hands could get dirty or this could damage the 
printer.

3 Push the release lever toward the rear to 
open. 

4 If the sheet is visible, pull the jammed sheet 
forward gently.

Shut Down..
Please Wait..

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)
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5 If the sheet is not visible, remove the jammed 
sheet from the back of the printer.

Visually inspect the interior to make sure that no 
pieces of the sheet remain in the printer.

6 If the carriage is on the left side, push it 
manually to the right side.
Push the carriage all the way to the right until it 
stops.

Important
Be sure to push the carriage to the right. If you push it 
to the left, the printer may display a carriage error after 
the printer is switched on.

7 If the printer is off, press the Power button to 
switch the printer on.

8 With the print side of the new sheet facing 
up, holding the sheet square between the 
paper restraints, making sure that the stack 
is aligned with the guideline (a) on the right 
and aligned with the guideline (b) at the 
back.

Data
Information Power

Offline
Menu

Message

Online

Cleaning
(3 sec.)

Stop/Eject
(1 sec.)

b a
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9 Pull the release lever forward to close, raise 
the upper cover stopper and release the 
lock, then close the upper cover. 

Cut sheet preparation begins. When preparation is 
finished, the printer is ready to print.



6- 41

Updating the Firmware
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Updating the Firmware
By updating the firmware for this printer, you can add on 
new functions and improvements for existing functions.

Obtaining the Firmware Update
Contact a Canon service center, or the dealer where you 
purchased the printer, for details about how to obtain the 
most recent version of the firmware update. 

Confirming the Firmware Version
Perform the procedure below to confirm the current version 
of the printer firmware before performing a firmware update. 
If the version of the firmware in use is older than the 
downloaded version, perform the firmware update. 

Note
If the version number of the printer is the same as or 
newer than the firmware update in hand, then you do 
not need to update the firmware.

1 If the printer power is off, press the Power 
button to switch the printer on.
After a few seconds Online is displayed in the 
operation panel and the Online lamp lights.

2 Press the Online button to display MAIN 
MENU.

3 Press [�] or [�] to select Information then 
press [�].

4 Press [�] or [�] to select S/C:  xx.xx.xx.

MAIN MENU
Information ↓

Version
S/C:    xx.xx.xx
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Reinstalling the USB or IEEE1394 Driver
If you try to install the USB or IEEE1394 driver with the USB 
or IEEE1394 cable already connected to the printer, the 
driver may not be installed correctly.
In such a case, follow the procedure below to install the 
printer driver after reinstalling the USB or IEEE1394 driver.

1 Right click the My Computer icon then 
select Properties.

2 On the Hardware sheet, click Device 
Manager. Next, in the Device Manager 
window click the Unknown devices icon 
then click the Properties button.

3 Click the Device Manager in the Driver 
sheet, the Update Device Driver Wizard 
opens, follow the instructions on the screen 
to complete the installation.

4 When the Wizard prompts you to select how 
to search for the driver source files, select 
only CD-ROM drive. Set the User Software 
CD-ROM in the CD-ROM drive then follow 
the instructions on the screen to install the 
interface driver.

5 Next, when the Add New Hardware Wizard 
opens, follow the instructions on the screen.

6 Select only Specify a location then click the 
Browse button.

7 Select the printer driver folder.
Windows Me/Windows 98

�Open the CD-ROM Drive, open the appropriate 
language folder > Drivers > WinMe_9X > 
Driver, then click the OK button.

Windows server 2003/Windows XP/Windows 
2000

�Open the CD-ROM, open the appropriate 
language folder, then Drivers > WinXP_2K > 
Driver > OK.

8 Confirm that the correct folder has been 
selected for Specify a location then install 
the driver.
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Uninstalling Software Applications
Follow the procedure below to delete the printer driver and 
software utility installed on the computer. 

Important
If you uninstall the software from Windows Server 
2003, Windows XP, Windows 2000, or Windows NT 
4.0, you must log in as a member of the Administrators 
group before the uninstallation.

Deleting the Printer Driver
Follow the procedure below to delete the printer driver for 
this printer.

Windows

Important
If you uninstall the software from Windows Server 
2003, Windows XP, Windows 2000, or Windows NT 
4.0, you must log in as a member of the Administrators 
group before the uninstallation.

1 Click the Start button then select Programs 
> Canon Printer Uninstaller > 
imagePROGRAF GARO Printer Driver 
Uninstaller.
The Delete Printer screen appears.

2 Click the printer in the list you wish to delete, 
then click the Delete button.
A confirmation message appears.

3 Click the Yes button.

4 Confirm that the printer has been deleted 
from the list, then click the Exit button on the 
Delete Printer screen.

Macintosh

1 Mount the provided User Software CD-ROM 
in the CD-ROM drive.

2 Open the appropriate OS folder on the User 
Software CD-ROM.
For OS 8.6 or OS 9.x, in the OS89 folder, open 
GARO Installer for 8/9.

For OS X, in the OSX folder, open GARO Installer 
for X.

3 In the upper left menu select Uninstall then 
click the Uninstall button.

4 Follow the messages on the screen to delete 
the GARO Printer Driver.
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Deleting the GARO Status Monitor
Follow this procedure to delete the GARO Status Monitor 
installed on Windows.

1 On the desktop click the Start button, point 
to Programs, click GARO Status Monitor, 
then select Uninstaller (GARO Device 
Setup Utility).

2 When the selection screen appears, select 
then click the Next button.
GARO Status Monitor is deleted.

3 Follow the instructions on the screen to 
delete the GARO Status Monitor. 

Deleting the GARO Device Setup Utility
Follow this procedure to delete the GARO Device Setup 
Utility installed on Windows.

1 Click the Start button then select Programs 
> GARO Device Setup Utility > Uninstaller 
(GARO Device Setup Utility).

2 When the selection screen appears, select 
Delete then click the Next button. 

3 Obey the instructions on the screen to delete 
the GARO Device Setup Utility.
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Operating the Function Menus
This chapter introduces the commonly used functions of the printer function menus with task oriented procedures and 
message examples. The necessary procedures and various messages shown on the printer display appear in the diagrams.

MAIN MENU

System Setup

Change Cutter

Online

Offline

Online

Yes No

Reset Cut Count

Resetting

Online

Online

OK

OK

OK

Opening the Upper Cover and Replacing the Cutter

Closing the Upper Cover

Open UpperCover

Online

Stop/Eject

a
b

c

d
a

e

f

g

h

Press the Online button once. Also, pressing 
the Online button when using the menus 
cancels the setting before the OK button is 
pressed and returns the printer to the online 
mode (or offline standby mode for loading 
media).

Press [�] or [�] repeatedly to display the 
items available for selection.

Press [�] once to go to the next level of the 
menu. Press [�] to return to the previous 
level of the menu.

Press OK once to select the currently 
displayed value for a setting, or to execute the 
selected item.

Press Stop/Eject once to cancel execution.

Denotes a value for a setting.

Denotes a message on the display that 
appears as the result of an operation.

Denotes any other action that should be 
performed but not on the printer operation 
panel.

Online

Stop/Eject
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Cutter Functions
The following cutter operations are provided in the printer function menus.

When You Need to Cut Media
Execute Force Cutting on the operation panel when you 
need to use the printer cutter to cut the media cleanly. 

Replacing the Cutter
Execute Change Cutter on the operation panel when you 
need to replace the cutter. Reset the count for the number 
of sheets cut after the cutter has been replaced.

Online

Online

Online

Online

MAIN MENU

Force Cutting

Online

Offline

Yes No
OK OK

Cutting..

MAIN MENU

System Setup

Change Cutter

Online

Offline

Online

Yes No

Reset Cut Count

Resetting

Online

Online

OK

OK

OK

Opening the Upper Cover and Replacing the Cutter

Closing the Upper Cover

Open UpperCover

Online

Stop/Eject
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Media Functions
The following media settings are provided in the printer function menus.

Changing the Media Type Settings
You can change the settings for each media type to match 
the print results and finish that you want.

Note
Press the OK button to return to the previous level.
Press the Online button to display Online.

MAIN MENU

Med.Detail Set.

 (Media Type)

Online

Offline Plain Paper, CAD Plain Paper, Plain Paper (High 
Quality), Recycled Coated Paper, Coated Paper, 
Heavyweight Coated Paper, Premium Matte Paper, 
Extra Heavyweight Coated Paper, Glossy Photo 
Paper, Semi-Glossy Photo Paper, Heavyweight 
Glossy Photo Paper, Heavyweight SemiGlos Photo 
Paper, Synthetic Paper, Adhesive Synthetic Paper, 
Backlit Film, Flame-Resistant Cloth, Proofing Paper, 
Newsprint for Proofing 1 to 3, Fine Art Photo, 
Fine Art Heavyweight Photo, Fine Art Textured, 
Canvas Semi-Glossy, Japanese Paper Washi, 
Colored Coated Paper, CAD Tracing Paper, CAD 
Translucent Matte Film, Special 1 to 5

Continued Next Page

Drying_Time

 [Setting Values]
Off, 30sec., 1min., 
3min., 5min., 10min., 
30min., 60min.

Scan Wait Time

 [Setting Values]
Off, 1min., 3min., 
5min., 7min., 
9min.

NearEnd RllMrgn

 [Setting Values] 20mm,5mm

Far End RllMrgn

 [Setting Values] 10mm,5mm

Online

Online

OK

OK

OK

OK

Online

Online
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Printing to the Bottom Margin of the 
Original
When printing on standard sizes, the images may 
occasionally be cut of at the top, bottom, left, or right 
margins, but if Keep Media Size is switched on then this 
ensures that the image will not be cut off at the top or 
bottom margins. However, the length of the finished image 
will be sized by the top and bottom margins. 

Start Here

CutDustReduct.

 [Setting Values] Off, On

Correct Smear

 [Setting Values] Off, On

Skew Check Lv.

 [Setting Values]
OK

Standard, 
Loose,Off

Width Detection

 [Setting Values] On, Off, 
Media Size?

Return Defaults

 [Setting Values] No, Yes
Online

Media Thickness

 [Setting Values]

VacuumStrngth

Standard Cutter

 [Setting Values]

 [Setting Values]

Thick, Stand-
ard, Thin

Weak, Standard, 
Strong, Strongest

Disable, 
Enable

Cut Speed

 [Setting Values] Standard, Fast

OK

OK

OK

OK

OK

OK

OK

OK

OK

Online

MAIN MENU

System Setup

Keep Media Size

Online

Offline

Online

Off On
* Printing Without Cutting Off 

the Top, Bottom Margins
* Printing on Standard 

Media Sizes

Online

Online

Online

OK
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Ink Functions
The following ink operations are provided in the printer function menus. 

Replacing an Ink Tank During a Print Job
Execute Rep. Ink Tank on the operation panel when you need to replace an ink tank during a print job. 

* Printing restarts immediately as soon as the upper cover is closed after replacement.

MAIN MENU

Rep. Ink Tank

Printing

Pause

Printing

Yes No

Open RightCover

Open the upper cover and replace the cutter.

Close the right cover.

Online

Online

Online

OK OK



7- 7

Ink Functions
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Changing the Black Ink Type
This printer can use two types of black ink: Photo Black (Bk) and Matte Black (MBk). Execute Change BkInk Type to switch 
between the types of black ink and drain the black ink, and then install the new black ink tank.

MAIN MENU

Change BkInk Type

Online

Offline

Online

Yes No

Open Right Cover

Rep. BkInk Tank

Please Wait..

Open RightCover

Online

Online

Online

OK OK

Continued Next Page

Online

Remove the black ink tank and install 
the type of black ink tank to use. 

MBk Ink Tank OK? Bk Ink Tank OK?

Ink Filling..

Online

Online

OK OK

Close the right cover.

Align the printhead (P.7-9)

Please Wait..

Start Here

Black ink type changed

For Matte Black Ink For Photo Black Ink

Black ink type not changed
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Print Quality Functions
You can use the printer function menus to confirm the print quality settings and change the settings to recover poor printing 
results. 

Determining if the Printhead is Blocked
You can print a Nozzle Check to check the condition of the 
printheads. 

When the Printhead Nozzles Are 
Clogged
If the Nozzle Check reveals that the printheads are blocked, 
you can execute Head Cleaning to clear the blockage and 
recover operation of the printer. Head Cleaning A is for 
normal, everyday printhead cleaning and Head Cleaning B 
is used for scrupulous head cleaning. Head Cleaning B 
consumes a large amount of ink, so please always use 
Head Cleaning A unless Head Cleaning B is absolutely 
required. 

MAIN MENU

Test Print

Online

Offline

Online

Nozzle Check

Printing

Online

Online

Online

OK

MAIN MENU

Head Cleaning

Online

Offline

Online

Head Cleaning A Head Cleaning B

Cleaning..

Online

Online

OK
Online
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Correcting Image Offset
If vertical lines are bent, or when colors are faded and 
uneven, perform Auto Head Adj. to correct the position of 
the printhead. The printer reads the results of a printhead 
adjustment pattern as it prints and corrects the position of 
the printhead automatically.

Correcting Horizontal Banding in 
Images
Perform Adjust Band to adjust the amount of line feed and 
correct undesirable horizontal banding in printouts. The 
printer reads the results of a line feed adjustment pattern as 
it prints and corrects the amount of line feed automatically.

To adjust the amount of feed, select Feed Priority > Band 
Joint > then perform Adjust Band.

MAIN MENU

Adjust Printer

Auto Head Adj.

Online

Offline

Advanced Adj. Standard Adj.

Online

Yes No

Printing

* Adjusting Print Direction

Online

Online

OK OK

Online

* Adjusting Gaps Between 
Odd/Even Nozzles, Print-
ing Direction, Color Gaps

MAIN MENU

Adjust Printer

Adjust Band

Online

Offline

Standard Adj. Advanced Adj.

Online

Yes No

Printing

Online

Online

OK OK

Feed Priority

Band Joint
OK

Online

* Standard Feed Adjustment * High-Precision Feed Adjustment



7- 10

Print Quality Functions
TOP

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index

Contents

Chapter 2
Using a Variety of 
Media

Chapter 1
Basic Procedures

Printing to an Accurate Length
Perform Feed Priority> PrintLength to set the priority in 
the print job for the length when the length of the printout is 
very important to you. However, performing this setting may 
cause horizontal banding to appear in the prints. To set the 
priority for the quality of the print, perform the Band Joint 
setting.

Online

MAIN MENU

Adjust Printer

Feed Priority

Online

Offline

Online

Print Length Band Joint
* Prints on the selected 
  media size

* Gives quality priority in printing

Online

Online

OK
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Printer Information Functions
You can use the printer function menus to print information about print jobs and printer settings so you can check them.

Checking the Print Job History
Perform Print Job Log to print information about print jobs 
so you can confirm how much ink was used for the jobs and 
other important information. 

Checking the Printer Settings Informa-
tion
Perform Status Print to print basic information about the 
printer and the settings of each function so you can check 
them. 

Online

MAIN MENU

Test Print

Online

Offline

Online

Print Job Log

Printing

Online

Online

OK

Online

MAIN MENU

Test Print

Online

Offline

Online

Status Print

Printing

Online

Online

OK
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Checking the Media Type Settings 
Information
Perform Media Details to print the settings for each media 
type so you can check them. 

Checking the Printer Functions Menu
Perform Menu Map so you can have a handy reference 
that shows you the items, levels, and sublevels of the 
printer function menus.

Online

MAIN MENU

Test Print

Online

Offline

Online

Media Details

Printing

Online

Online

OK
Online

MAIN MENU

Test Print

Online

Offline

Online

Menu Map

Printing

Online

Online

OK
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Regulations for this product
FCC Regulations

Canon Large Format Printer, Model K90049

IEEE1394 Expansion Board EB-04, Model K90050

Network Interface Board NB-15FB, Model K90051

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equip-
ment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or modifications
should be made, you could be required to stop operation of the equipment.

Canon U.S.A. Inc.

One Canon Plaza, Lake Success, NY 11042, U.S.A.

Tel No. 516-328-5600
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Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-
causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numérique de Classe B prescites dans
la norme sur le matériel brouiller: “Appareils Numériques”, NMB-003 édictée par l’Industrie et Sciences Canada.

International ENERGY STAR® Program
As an ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY STAR® guidelines
for energy efficiency. The international ENERGY STAR® Office Equipment Program is a global program that
promotes energy saving through the use of computers and other office equipment. The program backs the de-
velopment and dissemination of products with functions that effectively reduce energy consumption. It is an
open system in which businesses can participate voluntarily. The targeted products are office equipment such
as computers, monitors, printers, facsimiles, and copiers. Their standards and logos are uniform among par-
ticipating nations.

Trademarks
Canon, the Canon logo, imagePROGRAF, imagePROGRAF logo, NetSpot, Font Gallery, and Font Composer are trade-
marks of Canon Inc.

Microsoft®, Windows®, Windows NT® and MS-DOS® are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Apple, AppleTalk, EtherTalk, LocalTalk, and Macintosh are trademarks of Apple Computer, Inc. in the United States.

NetWare and Novell are registered trademarks of Novell, Inc. in the United States and/or other countries.
NDS, NDPS, NLM and Novell Client are trademarks of Novell, Inc. in the United States.

Other brand and product names may be trademarks or registered trademarks of their respective companies.



I- 9

Regulations for this product
TOP

Contents

Chapter 1
Basic Procedures

Chapter 2
Using a Variety of 
Media

Chapter 3
Printing Methods for 
Different Objectives

Chapter 4
Maintaining the 
Printer

Chapter 5
Using the Printer in a 
Network Environ-
ment

Chapter 6
Troubleshooting

Chapter 7
Operation of the 
Function Menus

Index


	Chapter 1 Basic Procedures
	Printer Part Names
	Printer Main Unit
	Front View
	Back View
	Interface connection point on the back
	Inside the Upper Cover
	Carriage (Inside Upper Cover)
	Inside the Right Front Cover


	Switching the Printer On and Off
	Switching the Printer On
	Switching the Printer Off
	Online and Offline
	When the Printer Is Operating
	How to Switch Modes


	What’s On the Operation Panel?
	Viewing the Display
	Standby
	Print Job Processing
	Function Menu mode
	Current Selection
	Message Display

	Using the Operation Panel Buttons
	Reading Operation Panel Lamps

	Function Menus
	Printer Function Priorities
	Function Menu Flow Summaries
	How to Perform Function Menu Settings
	Making Settings

	Menu Settings Summary Tables
	MAIN MENU
	Sub Menus


	Printer Driver
	Printer Driver Features
	Main Sheet
	Page Setup Sheet
	Layout Sheet
	Maintenance Sheet

	Printing
	Printing From Windows
	Operating the Printer

	Printing from a Macintosh
	Selecting the Printer
	Operating the Printer


	Canceling a Print Job
	Canceling a Print Job from Windows
	Canceling a Print Job from Macintosh
	Canceling a Background Print Job
	Canceling a Foreground Print Job


	Options
	Stand (Provided with the printer in the U.S.A.)
	Network Interface Board
	IEEE1394 Expansion Board
	Roll Holder Sets

	Consumables
	Print Media
	Replaceable Ink Tanks
	Maintenance Cartridge
	Replaceable Printhead
	Cutter Blade

	Specifications
	Basic Environmental Performance

	Chapter 2 Using a Variety of Media
	Media You Can Use
	The Suitable Black Ink for Media
	Black Ink Types and Characteristics
	Black Ink Characteristics

	Paper Type
	Media Type
	Plain paper
	CAD Plain Paper
	Plain Paper (High Quality)
	Recycled Coated Paper
	Coated Paper
	Heavyweight Coated Paper
	Premium Matte Paper
	Extra Heavyweight Coated Paper
	Glossy Photo Paper
	SemiGlos Photo Paper
	Heavyweight Glossy Photo Paper
	Heavyweight SemiGlos Photo Paper
	Synthetic Paper
	Adhesive Synthetic Paper
	Backlit Film
	Flame-Resistant Cloth
	Proofing Paper
	Newsprint for Proofing
	Fine Art Photo
	Fine Art Heavyweight Photo
	Fine Art Textured
	Canvas SemiGlos
	Japanese Paper Washi
	Colored Coated Paper
	CAD Tracing Paper
	CAD Translucent Matte Film

	Media Size
	Roll Media
	Cut Sheet

	Original data the same as the media
	Normal Size:
	Borderless Printing
	Oversize

	Handling Paper and Other Print Media

	Printing with Rolls
	Loading Roll Media
	Selecting the Paper Source
	Loading the Roll Media
	Selecting the Media Type

	Removing a Roll

	Printing with Cut Sheets
	Loading Cut Sheets
	Selecting the Paper Source
	Loading Cut Sheets

	Removing a Cut Sheet

	Adjusting the Height of the Printhead
	Adjusting Printhead Height
	Aligning the Printhead
	Re-adjusting Printhead Height


	Chapter 3 Printing Methods for Different Objectives
	Printing from Windows
	Before You Begin
	Basic Settings to Meet Your Needs (Type of Printing)
	Printer Driver Settings at a Glance (Settings Preview)
	Confirming the Print Image (Print Preview)

	Enlarging and Reducing the Original
	Enlarging or Reducing Printing to Fit the Size of the Media
	Enlarge/Reduce to Fit Roll Paper Width
	Selecting the Magnification Rate for Printing

	Printing Photos and Illustrations without Borders (Borderless Printing)
	Settings Required for Borderless Printing
	Basic Procedure for Borderless Printing
	More About Borderless Printing Methods

	Rotating the Page 90 Degrees for Printing (Conserve Paper)
	Printing Several Pages on One Sheet (Page Layout)
	Printing Posters (Page Layout)
	Using Watermarks
	Vertical and Horizontal Banner Printing (Long Prints)
	Matching the Width of the Roll

	Printing without Top and Bottom Margins (Conserve Paper)
	Custom Print Quality
	Customizing Print Quality

	Fine Adjusting Color for Printing
	Adjusting Color
	Color Matching

	About Media Size Options
	Creating Custom Sizes
	Selecting a Media Display Series

	When the Printout Quality Is Not Clean
	How to Set the Media Type

	Software Provided for Windows
	Basic Software for Printing
	Displaying the Printer Status
	Using the Printer on a Network
	Creating Posters Easily
	Printing Beautiful Photographs
	Printing Beautiful Digital Camera Images (for the Professional)
	Printing Images Created with CAD Systems
	Select the Media Type


	Printing from Macintosh
	Before You Begin
	Basic Settings to Meet Your Needs (Original Type)
	Printer Driver Settings at a Glance (Media Preview)
	Confirming the Print Image (Print Preview)

	Enlarging and Reducing the Original
	Enlarging or Reducing Printing to Fit the Size of the Media
	Enlarge/Reduce to Fit Roll Paper Width
	Selecting the Magnification Rate for Printing

	Printing Photos and Illustrations without Borders (Borderless Printing)
	Settings Required for Borderless Printing
	Borderless Printing

	Rotating the Page 90 Degrees for Printing (Conserve Paper)
	Printing Several Pages on One Sheet (Page Layout)
	Printing Posters (Page Layout)
	Vertical and Horizontal Banner Printing (Long Prints)
	Matching the Width of the Roll

	Printing without Top and Bottom Margins (Conserve Paper)
	Custom Print Quality
	Customizing Print Quality

	Fine Adjusting Color for Printing
	Adjusting Color
	Color Matching

	Custom Sizes (User Print Settings)
	Creating Custom Sizes
	Selecting a Media Display Series

	When the Printout Quality Is Not Clean
	How to Set the Media Type

	Software Provided for Macintosh
	Basic Software for Printing
	Displaying the Printer Status
	Using the Printer on a Network
	Printing Beautiful Digital Camera Images (for the Professional)
	Select the Media Type



	Chapter 4 Maintaining the Printer
	Replacing Ink Tanks
	How to Confirm Ink Levels
	Online Status Display
	Information Button Display
	How to Read the Ink Level Display

	When to Replace an Ink Tank
	When the Check Ink Level Message is Displayed
	When the Rep. Ink Tank (Replace Ink Tank) Message Is Displayed

	Ink Tank Handling Precautions
	Replacing an Ink Tank

	Cautions About Using Refilled Ink Tanks for This Printer
	Switching the Ink Level Detection Function Off
	Executing a Print Job

	Cleaning the Printer
	Cleaning the Exterior Covers
	Cleaning Inside the Upper Cover

	Cleaning the Paper Restraint
	Replacing the Maintenance Cartridge
	Checking Spacing Remaining in the Maintenance Cartridge
	Information Button Display
	Reading the Maintenance Cartridge Display

	When to Replace the Maintenance Cartridge
	When You See the MTCart Full Soon Message
	When You See the Replace MT-Cart. Message

	Maintenance Cartridge Handling Precautions
	Maintenance Cartridge Replacement Procedure
	Replacing the Maintenance Cartridge
	Replacing the Shaft Cleaner


	Replacing the Printhead
	Printhead Handling Precautions
	How to Replace the Printhead

	Replacing the Cutter Blade
	Transporting the Printer
	Checking the Condition of the Printer
	Cleaning the Printhead
	Types of Printhead Cleaning
	Head Cleaning A:
	Head Cleaning B:

	Printhead Cleaning Procedures

	Aligning the Printhead
	Aligning Printhead Procedure

	Adjusting Amount of Media Feed
	Media Feed Adjustment Procedure
	Adjusting Line Feed Manually

	Reducing the Amount of Cutting Dust
	Changing the Black Ink Type
	Black Ink Tank Exchange Procedure


	Chapter 5 Using the Printer in a Network Environment
	Before Using the Printer
	Required System Environment
	Using a TCP/IP Network for Printing
	Using an AppleTalk Network for Printing
	Using a NetWare Network for Printing

	The Network Environment

	TCP/IP Network Settings (Windows, Macintosh, UNIX)
	Procedures Required for a TCP/IP Network
	Connecting the LAN Cable
	Setting the Printer IP Address
	Setting the frame type with GARO Device Setup Utility
	Setting with the ARP/PING Command
	Setting with the Printer Operation Panel

	Performing the TCP/IP Protocol Settings
	Setting up with a Web Browser (Remote UI)

	Setting the Printer for Sharing

	Macintosh Network Settings
	Procedures Required for a Macintosh Network
	Setting a Macintosh
	Setting the AppleTalk Network Functions
	TCP/IP Network Function Settings

	Setting AppleTalk Protocol
	Setting the Protocol with Web Browser (Remote UI)
	Setting with the Printer Operation Panel

	Install the Printer Driver
	Installing the Printer Driver
	Selecting a Printer


	NetWare Settings (Windows)
	Procedures Required for a NetWare Network
	Setting the Printer Frame Type
	Setting the frame type with GARO Device Setup Utility
	Setting with the Printer Operation Panel

	Setting Up a NetWare Print Service
	Types of Print Services
	Setting Up the Print Server With NWADMIN, PCONSOLE

	Setting NetWare Protocol
	Setting the Protocol with Web Browser (Remote UI)

	Setting the Computer for NetWare
	Connecting to a NetWare Network
	Installing the Printer Driver
	Setting the Printer Port


	Printing with UNIX
	Using LPD to Print
	Using FTP to Print

	Initializing the Settings
	List of Network Settings
	General Settings
	TCP/IP Settings
	AppleTalk Settings
	NetWare Settings

	Software Applications that can be used for Network Settings

	Chapter 6 Troubleshooting
	Responding to Error Messages
	Operation Panel Message List
	Media Messages
	Ink Messages
	Other Messages

	When You Cannot Print
	Printing Will Not Start
	Printing Halts During Print Job
	Cannot Print on Network

	Unexpected Printing Results
	Poor Quality
	Abnormal Content
	Other Problems

	Handling Jams
	Removing a Roll Media Jam
	Removing a Cut Sheet Jam

	Updating the Firmware
	Obtaining the Firmware Update
	Confirming the Firmware Version

	Reinstalling the USB or IEEE1394 Driver
	Uninstalling Software Applications
	Deleting the Printer Driver
	Windows
	Macintosh

	Deleting the GARO Status Monitor
	Deleting the GARO Device Setup Utility


	Chapter 7 Operation of the Function Menus
	Operating the Function Menus
	Cutter Functions
	When You Need to Cut Media
	Replacing the Cutter

	Media Functions
	Changing the Media Type Settings
	Printing to the Bottom Margin of the Original

	Ink Functions
	Replacing an Ink Tank During a Print Job
	Changing the Black Ink Type

	Print Quality Functions
	Determining if the Printhead is Blocked
	When the Printhead Nozzles Are Clogged
	Correcting Image Offset
	Correcting Horizontal Banding in Images
	Printing to an Accurate Length

	Printer Information Functions
	Checking the Print Job History
	Checking the Printer Settings Information
	Checking the Media Type Settings Information
	Checking the Printer Functions Menu



	Chk1-1: Off
	Chk1-2: Off
	Chk1-3: Off
	Chk1-4: Off
	Chk1-5: Off
	PrintButton1: 
	Chk1-6: Off
	Chk1-7: Off
	Chk1-8: Off
	Chk1-9: Off
	Chk1-10: Off
	Chk1-11: Off
	Chk2-1: Off
	Chk2-2: Off
	Chk2-3: Off
	Chk2-4: Off
	PrintButton2: 
	PrintButton3: 
	Chk3-2: Off
	Chk3-3: Off
	Chk3-4: Off
	Chk3-5: Off
	Chk3-6: Off
	Chk3-7: Off
	Chk3-8: Off
	Chk3-9: Off
	Chk3-10: Off
	Chk3-11: Off
	Chk3-12: Off
	Chk3-13: Off
	Chk3-14: Off
	Chk3-15: Off
	Chk3-17: Off
	Chk3-18: Off
	Chk3-19: Off
	Chk3-20: Off
	Chk3-21: Off
	Chk3-22: Off
	Chk3-23: Off
	Chk3-24: Off
	Chk3-25: Off
	Chk3-26: Off
	Chk3-27: Off
	Chk3-28: Off
	Chk3-29: Off
	Chk4-1: Off
	Chk4-2: Off
	Chk4-3: Off
	Chk4-4: Off
	Chk4-5: Off
	PrintButton4: 
	Chk4-6: Off
	Chk4-7: Off
	Chk4-8: Off
	Chk4-9: Off
	Chk4-10: Off
	Chk4-11: Off
	Chk4-12: Off
	Chk4-13: Off
	Chk4-14: Off
	Chk5-1: Off
	Chk5-2: Off
	Chk5-3: Off
	Chk5-4: Off
	Chk5-5: Off
	PrintButton5: 
	Chk5-6: Off
	Chk5-7: Off
	Chk5-8: Off
	Chk6-1: Off
	Chk6-2: Off
	Chk6-3: Off
	Chk6-4: Off
	Chk6-5: Off
	PrintButton6: 
	Chk6-6: Off
	Chk6-7: Off
	Chk7-1: Off
	Chk7-2: Off
	Chk7-3: Off
	Chk7-4: Off
	Chk7-5: Off
	PrintButton7: 
	Chk7-6: Off
	to top page: 
	to chap01 page: 
	to chap02 page: 
	to chap03 page: 
	to chap04 page: 
	to chap05 page: 
	to chap06 page: 
	to TOC page: 
	to index page: 
	to chap07 page: 


